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Preface

Structure of this Manual
This manual consists of 4 chapters and 4 appendices.

Chapter 1 “Introduction” introduces the functions and 
architecture of the M4000 Insulation Analyzer, as well 
as important safety considerations for its use.

Chapter 2 “M4000 Software” provides an overview of M4000 
software and its installation.

Chapter 3 “Running M4000 Tests” describes procedures for 
executing specimen tests.

Chapter 4 “M4100 Instrument Troubleshooting” provides initial 
steps in troubleshooting problems and isolating a 
problem to either the M4100 or M4200c.

Appendix A “M4000 Components Lists” describes accessories 
included with the M4000 Insulation Analyzer.

Appendix B “Warranty” provides Doble warranty provisions 
applicable to the M4000.

Appendix C “Error Messages” lists error message numbers and 
descriptions.

Appendix D “Part Numbers” lists the M4000 Insulation Analyzer 
part numbers.
72A-1230   Rev. F i
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Conventions Used in this Manual
The following terms and typographical conventions are used in the manual:

Convention Description

Windows Refers to the Microsoft Windows operating system, 
Version 98 or later.

Click Quickly press and release the left mouse button.

Double-click Quickly press and release the left mouse button twice 
without moving the mouse.

Select Position the cursor on the desired option and click the 
left mouse button once. Or, highlight the desired 
option using the arrow keys and press ENTER. Or, press 
ALT and the underlined letter.

Press Type a single keyboard key. For example, press ENTER.

FN+(appropriate key) Press and hold the FN key, and press (appropriate 
key).

Bold Courier Text Indicates characters to be typed.
ii 72A-1230   Rev. F
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1. Introduction

The M4000 Insulation Analyzer is used to determine the insulation quality of 
high-voltage power apparatus in the field. This portable test set incorporates 
automated Doble Testing with high accuracy and sensitivity, over a wide range 
of values, and with minimal susceptibility to electrostatic interference and 
noise.

Measurement Principles
The M4000 generates a 0-12 kV test signal with an internal sine wave 
generator, a 3 kVA power amplifier and a step-up isolation transformer. The 
M4000 then measures the voltage and current of the specimen and a reference 
impedance by periodically sampling instantaneous values with an A/D 
converter. The M4000 then calculates and reports test results by converting the 
sampled data into vector (magnitude and phase) quantities and applying 
conventional ac circuit theory. All reported results – including power loss, 
power factor and capacitance – are derived from the vector voltage and 
current.

The M4000 rejects interference through the judicious application of shielding, 
line-synchronized reversal, and line frequency modulation (FM). The first two 
techniques are similar to those employed in the earlier Doble M2H product 
line. The FM technique involves running tests at sinusoidal frequencies 5% (or 
even 10%, if necessary) above and below the line frequency and averaging the 
results. The choice is user configurable.

The inevitable interference current component is removed from the sampled 
data set before test results are calculated using synchronous detection. This is 
a mathematical process that separates out a single frequency component in a 
given signal. It is analogous to a bandpass filter centered at the test frequency. 
Synchronous detection is also useful for removing harmonic distortion and 
random noise in the test signal itself.

Safety
The M4000 is designed to drive grounded and ungrounded specimens at lethal 
voltages and high power levels. Conventional ground-fault and current-
limiting schemes cannot be used to protect the operator under these test 
conditions. Therefore, the M4000 implements special safety techniques to 
minimize risk to the equipment operator.
72A-1230   Rev. F 1-1
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Both an operator and safety supervisor must be present when specimens are 
tested. Each person holds a safety switch that directly controls the output of 
the power amplifier through redundant electromechanical relays. In addition, 
the control processor can vote to disable the dc supply to the safety relay coils, 
thereby disabling the amplifier output if certain conditions are not met.

NOTE For greater safety details, see ”Safety Practices – General Rules” 
on page 1-20.

M4000 Components
The M4000 Insulation Analyzer consists of the following components:

• M4100 Instrument
• M4200c Controller or Third-Party Controller
• M4000 Software

The following auxiliary components are optional:

• M4150 or M4151 Field Calibration Reference
• M4300 Transport
• Leakage Reactance Test Software
• External Reference Test Software 
• DTA Software
• M4110 Leakage Reactance Interface
• M4120 External Reference Module
• Doble Standard Turns Ratio Capacitor
• Safety Strobe
• Temperature and Humidity Probe

M4100 Instrument
The M4100 instrument supplies test voltage and test current to insulation 
specimens. The M4100 instrument also contains measuring circuits to 
determine the condition of the insulation under test, as well as direct control 
safety circuits to ensure electrical safety of personnel and test apparatus.

The M4100 instrument has a time base generator that may be synchronized 
either with the power system supplying power to the test instrument, or with 
an internal crystal oscillator. This choice allows the test operator to select one 
of two modes of test operation, Line Sync Reversal or Line Frequency 
Modulation. When Line Sync Reversal Mode is selected, the time base is 
synchronized to the power source and the test will use the standard Doble 
1-2 72A-1230   Rev. F
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polarity reversal technique to reverse the effects of electrostatic interference. 
Selecting the Line Frequency Modulation Mode of operation will synchronize 
the time base generator to the crystal oscillator. Two tests will be run for each 
programmed test sequence. The first test is run at a frequency of 57 Hz and the 
second test is run at 63 Hz. The measured test results of each test are combined 
and averaged to give a 60 Hz equivalent test result. When operating in the 50 
Hz frequency, the same technique will apply. The first test will run at 47 Hz, 
and the second test will run at 53 Hz. This mode of test eliminates electrostatic 
interference from measurement, by avoiding measurement at power line 
frequency. It is also possible to select ± 10% of power line frequency as well.

Safety circuits have been designed into the M4100 instrument to ensure safety 
of personnel. High voltage will not be supplied by the instrument if either of 
the following circuits and conditions are not satisfied:

• The ground safety circuit verifies that the #6 bare copper safety 
ground, which is attached from the instrument to the apparatus earth 
ground, is at the same potential as the power supply ground.

• Two safety switches must be attached to the M4100 instrument front 
panel and in the closed or depressed position prior to testing. One 
switch is held by the M4000 Insulation Analyzer operator and the 
second switch is held by a safety supervisor. The M4100 can be 
configured to require both switches to be opened between test 
sequences for the M4000 Insulation Analyzer to operate. Release of 
one or both switches will terminate the test sequence and high voltage 
potential.

A safety strobe light can be used in conjunction with the instrument and is 
plugged into the front panel of the M4100. Whenever high voltage potential is 
applied from the M4100, the safety strobe light will be energized and flashing. 
Safety strobe connection will be required in order to operate the M4000 
Insulation Analyzer, unless the default system configuration has been 
modified to allow for the absence of a safety strobe. In this case, the strobe 
connector can be removed from the M4100 front panel.
72A-1230   Rev. F 1-3
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 Figure 1.1  Safety Strobe

Two optional items found on the M4100 front panel are the M4151 Field 
Calibration Reference, which will be discussed below, and a Temperature and 
Relative Humidity sensor. The Temperature and Relative Humidity Sensor 
will process temperature and humidity readings at the time of test.

Front Panel

Figure 1.2  M4100 Instrument
1-4 72A-1230   Rev. F
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M4200c Controller

Figure 1.3  M4200c Controller

• The M4200c Controller is the interface between the operator and the 
M4000 Insulation Analyzer. The color display, control, data storage, 
printing and communication functions are all provided by the M4200c 
Controller. This component is covered in detail in a separate manual.

• The M4200c has been specifically designed and built to operate in 
outdoor substations and other environments hostile to electronic test 
equipment. The unit has been hardened to electrostatic discharge 
(ESD) and radio frequency interference (RFI) to reduce or eliminate 
their effects on internal electronic circuits.

• The outer case of the M4200c is made of ABS plastic over an 
aluminum chassis that makes it rugged and suitable for transporting to 
remote sites.

• The display is a six-inch by eight-inch color transflective liquid crystal 
display (LCD) that runs in the VGA mode. The display has high 
contrast in bright sunlight, and has backlight control for low ambient 
light conditions. An LCD heater is installed to allow for use in cold 
weather. An external monitor may be used in place of the LCD screen. 
Access to the external display connector is found behind the access 
door on the left side of the M4200c Controller.
72A-1230   Rev. F 1-5
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• The keyboard is a standard notebook-type keyboard with a flexible 
skin around the keys to prevent dirt and moisture from contaminating 
the internal electronics and causing failure of the keyboard. An 
external keyboard may be used in place of this keyboard. Access to the 
external keyboard connector is to the right of the video connector 
behind the access door on the left hand side of the M4200c Controller.

Figure 1.4  M4200c Controller External Connections

• The M4200c has a pointer device installed below the keyboard on the 
front panel to allow for the use of mouse control of the display cursor. 
A port on the left-hand side of the M4200c allows for the use of an 
external, serial mouse.

• The M4200c has a built-in 200 dot per inch (dpi) graphic printer/
plotter. Paper for the printer/plotter is an uncoated thermal FAX paper 
provided by Doble.

• The M4200c is equipped with an internal FAX/Modem board that may 
be used to transfer data when used with the optional Doble Test 
Assistant (DTA) program.

• The M4200c has a built in ethernet connection.

LAN    Ext. Mouse     Ext. Monitor     Modem     Ext. Keyboard

USB
1-6 72A-1230   Rev. F
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• The M4200c has a built in USB port.
• Data may be stored on an internal hard drive or on a 3 1/2 - inch floppy 

disk via the floppy disk drive located in the front of the controller.

Third-Party Controller
Certain PC’s using a Windows-based operating system available from other 
suppliers can be used as a system controller in lieu of the M4200c controller. 
These alternative machines can be used to control M4000 operations.

M4000 Software
Software provided with the M4200c or available to be loaded onto a Third-
Party Controller includes a program to run the M4000 Insulation Analyzer, 
and if desired, the optional Leakage Reactance Test, External Reference Test, 
and Doble Test Assistant (DTA) programs. For more information, refer to 
Chapter 2.

Optional M4150 And M4151 Field Calibration References
The purpose of the M4150 and M4151 Field Calibration References are to 
provide a means of obtaining System Status, Calibration Verification, and 
Field Recalibration Tests of the M4100 instrument in the field. (For an 
explanation of these tests, refer to ”Running Diagnostics” on page 4-21). The 
Field Calibration Reference is mounted in the front panel of the M4100 
instrument.

Figure 1.5  M4151 Field Calibration Reference
72A-1230   Rev. F 1-7
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Doble Standard Turns Ratio Capacitor
This is an optional small portable capacitor that can be energized at 10 kV for 
performing turns ratio tests at high voltages with the M4000.

Figure 1.6  Doble Turns Ratio Capacitor

External Reference
This is an optional feature allowing the tester to test apparatus at their full 
operating voltage using the M4000, providing a suitable external power source 
and reference are provided by the user.

M4300 Transport
The M4300 Transport is an option for the M4000 Insulation Analyzer that 
provides a means to move and store the M4000 system. It is also a platform for 
the field, from which the M4000 can be easily used and operated. Refer to 
”Storage and Moving Mode” on page 1-10 and ”Testing Mode” on page 1-13. 
If a PC is to be substituted for the Controller, a support panel to be mounted on 
the Controller support frame can be supplied.
1-8 72A-1230   Rev. F
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Figure 1.7  M4300 Transport

Doble Test Assistant (DTA) Software
Optional Doble Test Assistant® (DTA) software provides standardized 
apparatus test procedures and templates, data management, and optional 
expert system software for insulation condition assessment. See Chapters 2 
and 3 for further details.

M4110 Leakage Reactance Interface
This optional interface contains the circuitry necessary to convert the voltage 
and current, measured during a Leakage Reactance test on a transformer, into 
a form that can be measured by the M4100 Instrument. It also contains a 
variac so that the proper test voltage can be obtained. The Leakage Reactance 
test cannot be made without either this Interface or the M4130 Leakage 
Reactance Module, and the accompanying software.
72A-1230   Rev. F 1-9
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When using this interface, the standard M4000 safety switch and safety strobe 
are used. The necessary current and voltage cables are provided for connection 
to the transformer, along with the necessary software, so that this becomes a 
self-contained kit for this test. The user is only limited by the size of the variac 
provided.

Figure 1.8  M4110 Leakage Reactance Interface

Operating with the M4300 Transport
The M4000 Insulation Analyzer is designed to be assembled on the M4300 
Transport for storage, moving, and testing. When the M4000 is used with the 
M4300 Transport, it can be set up in the following modes:

• Storage and Moving Mode
• Testing Mode

Storage and Moving Mode
The storage and moving mode will allow the user to transport and store the 
M4000 Insulation Analyzer. The M4300 Transport is designed so that all the 
components of the M4000 fit in a single, packaged unit (Figure 1.9).
1-10 72A-1230   Rev. F
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Figure 1.9  M4000 Insulation Analyzer in Storage Mode

The recommended assembly steps for the Storage and Moving Mode is as 
follows:

1. Remove the M4200c Controller Support frame from the M4300 Transport. 
Lay the M4300 Transport down on its back, on a level surface so that the 
wheels and handle touch the surface.

2. Verify that the cover is installed on the M4100 Instrument front panel. 
Position the M4100 Instrument on the M4300 Transport as shown in the 
above picture.

Oil Test
Cell

High
Voltage
Cable

Controller
Support Frame

Cable Carry
Bag

M4100
Instrument

M4200c
Controller
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3. Position the closed M4200c Controller upside down into the area with the 
projections of the top cover of the M4100 Instrument. Buckle and tighten 
the strap snugly around both the M4100 Instrument and the M4200c 
Controller.

4. Lift the M4300 Transport into the upright position.

5. Place the Documentation Bag and Cable Carry Bag on top of the M4100 
Instrument top cover. Buckle and tighten the strap to secure.

6. Place the Oil Test Cell on the brackets provided between the wheels on the 
rear of the M4300 Transport, and secure it with the strap provided.

7. Place the High Voltage Cable into the brackets provided on the top, rear 
part of the M4300 Transport and secure it with the strap provided.

8. Place the M4200c Controller Support frame into the tubes provided so that 
the end faces forward.

NOTE The M4200c Controller Support frame should not be used for lifting the 
M4300 Transport.

The M4000 Insulation Analyzer is now in Storage and Moving Mode.
1-12 72A-1230   Rev. F
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Testing Mode
When assembled in the Testing Mode, the M4300 Transport serves as the field 
desk for the M4000 Insulation Analyzer. The Testing Mode (Figure 1.10) was 
designed to take advantage of the M4100 instrument's concentrated cluster of 
connections, providing the user with a comprehensible testing setup and a 
user-friendly environment while testing.

Figure 1.10  M4000 in Testing Mode

M4200c Controller

Intercase
Communication
Cable

High
Voltage
Cable

Transporter

Safety
Ground

Diagnostic Test
Adapter Cable

120/240 V
Power Cable

Red Low
Voltage Cable

Safety Strobe

Remote Temperature
Humidity Sensor

Loopback Test
Connectors Blue Low

Voltage Cable

Safety Switch 1&2

Controller Support
Frame

M4151 Calibration
      Reference
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The following instructions describe how to assemble the components of the 
M4000 Insulation Analyzer into the Testing Mode, from the Storage and 
Moving Mode:

WARNING When preparing for a test, do not attach any test leads to the apparatus to 
be tested without first attaching them to the M4100 test set!

1. With the M4300 Transport in the upright position, remove the M4200c 
Controller Support frame, the Cable Carry bag, the Documentation bag, 
the High Voltage Cable, and the Oil Test Cell from the rear of the 
Transport.

2. Carefully lay the M4300 Transport down on its back on a level surface. 
The handle should face the specimen to be tested.

3. Place the M4200c Controller Support frame into the tubes provided on the 
M4300 Transport bottom plate, near the M4100 Instrument rubber feet. 
The top of the frame must extend away or opposite to the handle.

4. Remove the M4200c Controller from the top surface of the M4100 
Instrument. Place the M4200c Controller on the Support frame and lock it 
in place.

5. Remove the top cover from the M4100 Instrument top panel. The M4100 
Instrument is ready for connecting the cables.

6. The M4100 Instrument top panel receptacles are designed to only accept 
the functionally correct cables. Place each cable into the respective 
receptacle. The only interchangeable cables are the Safety Switches.

NOTE Inspect all cables for cracks or other damage before using.

7. Connect the Safety Ground cable to the M4100 Instrument, and to the 
ground of the specimen to be tested. The Safety Ground Cable should be 
the first connection to be made and the last one disconnected from the 
M4100 Instrument.

8. Connect the M4100 Instrument and the M4200c Controller to the Power 
Receptacle Box located at the bottom of the handle of the M4300 
Transport. A separate receptacle box is also provided for cases where the 
M4000 Insulation Analyzer is used away from the M4300 Transport. As 
shipped from Doble, the 120 VAC receptacle in the M4200c Controller is 
located under a yellow tag which states, “NOTICE: READ ENCLOSED 
MICROSOFT SOFTWARE LICENSE BEFORE USING”. The license 
agreement and documentation are in the Documentation bag. Please 
comply with the notice and remove the tag to plug in the cable.

9. Interconnect the M4100 Instrument and the M4200c Controller using the 
gray snap-in cable provided.
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10. Connect the two safety switches to the two receptacles labeled “Safety 
Switches” on the front panel of the M4100 Instrument.

11. Connect, as necessary, the red and blue Low-Voltage leads to the 
corresponding color coded receptacles labeled “LOW VOLTAGE 
LEADS”, on the front panel of the M4100 Instrument. To avoid 
unintended measurements, connect only the low voltage lead(s) to be used 
for the next text.

12. Connect the Safety Strobe to the receptacle labeled “SAFETY STROBE” 
on the front panel of the M4100 Instrument. The strobe has a magnetic 
base that can be placed on a grounded steel structure, where it is visible to 
all personnel around the testing area.

13. Connect the Temperature and Relative Humidity Sensor to the receptacle 
labeled “REMOTE SENSOR” on the front panel of the M4100 
Instrument. This sensor will automatically record the ambient temperature 
and humidity. The sensor has a magnetic base and should be placed on a 
grounded structure, in the shade, to record the most accurate temperature 
and humidity. The M4100 Instrument will operate without this option.

14. Connect the High-Voltage Cable to the receptacle labeled “HIGH 
VOLTAGE” on the front panel of the M4100 Instrument. Ensure that the 
High Voltage Cable is fully inserted and latched into the receptacle.

15. Connect the M4000 Power Receptacle box to a 120 or 240 VAC source. 
This should be the last connection to be made.

16. The M4000 Insulation Analyzer is ready to be connected to the specimen 
to be tested. Connections to the specimen are described in the Doble Test 
Procedures manual.

NOTE When the M4000 Insulation Analyzer is assembled in the Test Mode it should 
not be moved. However if minor repositioning is necessary it should be done 
by lifting the M4300 handle a few inched off the surface.

When Finished Testing
When tests are finished, and before starting the Storage and Moving Mode 
assembly procedure, make sure that all the data have been saved and that the 
application programs that were used have been closed before shutting power 
off to the M4200c Controller.

WARNING When finished testing, do not remove any of the test leads from the test set 
before first removing them from the apparatus just tested!
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NOTE Data will be lost if all software application programs are not closed before 
the M4200c is powered down.

To set the M4000 to the Storage and Moving Mode, reverse the previous setup 
procedure (”Testing Mode” on page 1-13), keeping in mind that the Safety 
Ground cable is the last cable to be disconnected from the M4100 instrument. 
Refer also to ”Storage and Moving Mode” on page 1-10.

M4000 PC Cable
There is a cable with connectors designed to attach your M4100 to a third-
party controller of your choice. This cable is supplied as a way to offer users 
an even higher level of product reliability. With the M4000 PC Cable, the user 
can continue to test even if the M4200c Controller suffers a serious failure, by 
using the cable to connect the M4100 Instrument directly to the user’s own 
PC.

To be prepared to use this cable, you must have the DTA and M4000 diskettes 
available to load onto your computer, and preferably a back-up copy of test 
data files as well.

Third-Party 
Controller 
Requirements

• Pentium Celeron
• 64 megabytes of memory
• Windows 98 or later operating system
• Internet Explorer version 5.0 or better
• One available serial port

See the Doble website (www.Doble.Com) for complete details.

Setting Up the 
Controller

The computer must be loaded with the M4000 (and DTA, if a DTA user) 
software.

The COM port setting must be set in accordance with your computer's 
requirements. This can be done by selecting Configuration from the Tools 
menu and clicking the Instrument tab. The COM port is automatically set to 
the requirements of the M4200c Controller when you install the M4000 
software. If you are using a Serial to USB converter, see ”Instrument 
Configuration” on page 2-18. If you have the wrong COM port setting, you 
will get a communications error message when trying to run a test.

Besides the COM port setting, you must be sure no other program is running 
that wants to access this same COM port. Review programs located in your 
startup folder which start up each time the computer is booted up, and remove 
any that may try to grab the COM port. Or, from the System icon in the 
Control Panel, go to the Hardware tab and select Device Manager. Disable any 
items that require the selected COM port.
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Transport, Storage and Shipping

Transporting and Storing the M4000
The M4100 Instrument, M4200c Controller, and Accessories should be stored 
in a reasonably clean and dry location. If the M4100 Instrument, M4200c 
Controller, and/or the inboard or outboard potheads of the High Voltage Test 
Cable are exposed to excessive dirt and/or moisture, they should be cleaned 
and dried before use. The inboard and outboard potheads of the Cable, and the 
cable pothead guide receptacle on the M4100 Instrument, could track along 
their surfaces if high voltage is applied while they are contaminated with 
surface dirt and/or moisture.

The M4100 and M4200c should be properly secured within the vehicle when 
being transported locally, and mounted in the normal upright position 
(preferably a location, in a van or truck, which is not directly above an axle of 
the vehicle). If a padded shipping container or trunk is not used when 
transporting the Instrument and Transformer locally, then protect against road 
vibration and bumps by having them mounted on shock absorbing material (2" 
to 4" of padding is desirable).

Avoid sharp bends in the High Voltage Test Cable when both using and 
transporting. The cable should be coiled into no smaller than a 12-inch 
diameter coil.
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Shipping Instructions
M4000 Test Set Always ship the M4000 and M4200c in separate 

containers. 

Ship in special packing cases provided by Doble or 
pack in cases with at least 4" of Styrofoam-type 
padding on all sides. The HV cable pothead-guide 
receptacle on the M4100 Instrument should be covered 
to keep out foreign material.

On package, write: FRAGILE – PLEASE DO NOT 
DROP

Accessory Case Pack leads, cables, and accessories in the cable bag 
furnished with the set.

Liquid-Insulation Cell The Cell and Plastic Carrying Case must be thoroughly 
cleaned to prevent accidental contamination of the 
Accessory Case and the environment. If the Accessory 
Case is either not shipped or is too full, then the clean 
Cell and Carrying Case should be shipped in a separate 
padded cardboard box, or better. Padding should be 
installed inside and around the Cell.

On package, write: FRAGILE – PLEASE DO NOT 
DROP

NOTE When shipped by commercial carrier, the M4100, M4200c and 
Accessories should be properly padded and packed as specified above. 
Suitably padded shipping containers for temporary use or purchase are 
available from Doble upon request.

Ship to:

Doble Engineering Company
85 Walnut Street
Watertown, Massachusetts 02472-4037
USA

NOTE Test sets that are transported appreciable distances should be checked 
upon arrival. This includes sets that have been shipped from the Doble 
Engineering Company. The test set and its accessories should be 
examined upon receipt for signs of physical damage. The simplest and 
most effective method for checking overall performance of the M4000 is 
to use the Doble Liquid Insulation Cell as described in ”Checking 
Instrument Accuracy in the Field” on page 4-43. 
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The preceding also applies to test sets that have been stored for prolonged 
periods.

Safety Considerations
Safety cannot be overemphasized when working on or around high voltage 
electrical apparatus. Companies that generate, transmit, distribute, or utilize 
high voltage electricity should, and do, have precise rules for safe practices 
and procedures for personnel whose working responsibilities involve testing 
and maintenance of the various types of high voltage apparatus, and their 
associated lines, cables, and conductors, as well as the associated accessories.

Definitions
Throughout this manual, reference will be made to testing personnel in certain 
general terms which are defined below. These terms apply only to the testing 
function of the individuals and not to their professional status, seniority, or 
positions within their company's structure or personnel hierarchy. These terms 
are:

• Test Set Operator – The person who supervises the test and operates 
the M4000 Insulation Analyzer.

• Operator’s Assistant * – The person who follows the operator's 
instruction in making test connections.

• Safety Observer * – The person who is responsible for observing the 
performance of the test, seeing any safety hazard, and giving warning 
to crew members.

* The operator's assistant, or the safety observer, may be employed to operate 
the extension safety switch and to act as safety supervisor. The operator of the 
safety switch should perform no other work, such as recording test data, while 
the M4000 Insulation Analyzer is energized.

Two safety switches are provided and are required to be operated in order to 
energize the M4000 Insulation Analyzer. The M4000 Insulation Analyzer 
generates high voltage and is capable of causing serious, even lethal, electrical 
shock. The M4000 Insulation Analyzer should not be operated by a crew 
smaller than two people. A larger crew may be desirable under some 
circumstances. Regardless of crew size, one person should be designated as 
the Test Set Operator and one other as Test Supervisor.
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• Test Supervisor – This person is responsible for overseeing 
preparations for the test sequence, overseeing M4000 Insulation 
Analyzer operation, and ensuring that all safety precautions are put 
into practice. Safety practices followed should include company 
policies, applicable government regulations, and any special 
requirements related to use of the M4000 Insulation Analyzer.

Safety Practices – General Rules
1. All tests should be performed with the apparatus under test completely 

de-energized and isolated from its power systems. This means 
disconnecting and grounding all bus from the apparatus under test.

2. The method of testing high voltage apparatus involves energizing the 
apparatus through the M4000 Insulation Analyzer. The act of testing 
apparatus, which is otherwise de-energized and isolated from its system, 
can itself produce dangerous levels of voltage and current. Care must be 
taken to avoid contact with the apparatus being tested, its associated 
bushings and conductors, and with the M4000 Insulation Analyzer cables.

3. The test crew must make a visual check to ensure that the apparatus 
terminals are isolated from the power system. Where the possibility of 
failure of the apparatus under test must be considered a real possibility, 
precautions (such as barriers or entrance restrictions to test area) must be 
taken against harm in the event of violent failure.

4. All rules of your company for safe practice in testing must be strictly 
conformed to, including all practices of tagging and isolating apparatus 
during testing and maintenance work. State, local, and federal regulations, 
e.g. OSHA, may also apply.

NOTE Company rules and government regulations take precedence over Doble 
recommendations.

Clearances
Proper clearance between the test equipment, crew members, and the 
apparatus being tested, must be observed at all times during energization. 
Barriers, safety tapes, and ladder barriers should be erected around the test 
area to prevent unintentional (or intentional) entry into the “live” area. These 
same precautions should be taken to block unwitting entry into the area by 
means of ladders, buckets, or any other extraneous equipment by which entry 
into the area may be gained.
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Grounding
1. The apparatus under test, its tank or housing, and the M4000 Insulation 

Analyzer must be solidly and commonly grounded or earthed. This also 
applies to any mobile equipment being tested.

2. When the M4000 Insulation Analyzer is permanently housed in a vehicle, 
the M4000 Insulation Analyzer ground should be bounded to the vehicle 
chassis, which in turn is grounded.

3. Exposed terminals of apparatus should not normally be allowed to “float”. 
They should be grounded directly or through the low voltage leads of the 
M4000 Insulation Analyzer, unless otherwise specified by Doble 
recommended test plans.

4. There must be two inches of clearance between conductors (such as bus) 
that are not part of the tests.

Personnel Safety
1. A pretest tailgate meeting is recommended. Frequently, other crews will 

be working on non-test related tasks in close proximity to equipment being 
tested. The tailgate meeting should include all personnel who will be 
working in proximity to the area where testing will be performed. In this 
meeting, the tests to be performed, the apparatus and the voltage test levels 
involved, potential hazards involved with the work, and the individual 
assignments should all be reviewed with the crew members. Test 
personnel need to remain aware of the work activity taking place around 
them and alert to the possibility that non-test personnel may enter the test 
area.

2. A consistent and uniform set of signals, both visual and verbal, should be 
agreed upon, and should be followed by all of the crew members during 
testing.

3. While making the various types of connections involved in the different 
tests, it may be necessary for personnel to climb up on the apparatus, but 
no one should remain on the apparatus during the test itself.

4. The HV Test Cable should not be held during energization of the M4000 
Insulation Analyzer. Flashover of the test specimen or the M4000 
Insulation Analyzer can generate transient voltages of sufficient 
magnitude to puncture the insulating jacket of the cable.
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M4000 Connections
1. The procedures described in the “Testing Mode” section of this chapter on 

page 1-13, for connecting and disconnecting the M4000 leads in their 
proper sequence should be observed and acted upon at all times.

WARNING In particular, due to the presence of static charges from nearby energized 
lines, never touch the live end (hook) of the high voltage cable when 
moving leads. Never hold the High Voltage cable during a test.

2. Test personnel should be aware that induced voltages or trapped charges 
may be present on the equipment about to be tested. EHV circuit breakers 
with grading capacitors across the interrupter contacts are especially prone 
to build up a high voltage charge. Voltages high enough to damage the 
M4000 Insulation Analyzer have been known to occur on this type of 
equipment. Provisions should be made for draining these charges by 
applying grounds prior to making your test connections. It is a good 
practice to ground equipment such as capacitors, capacitor voltage 
transformers, and EHV circuit breaker heads as soon as they have been 
isolated for testing, and to temporarily remove the grounds only during the 
short period when tests are actually being performed.

3. Perform only one job at a time on any apparatus. The situation in which 
two crews are doing different tasks with the same apparatus at the same 
time is an open invitation for confusion, trouble and danger to the 
personnel.
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M4000 Operation
1. Both safety switches must be used in order to activate the test setup. One is 

to be controlled by the M4000 operator and the other by a second test crew 
member, designated the safety supervisor. (This person may be either the 
Operator’s Assistant or the Safety Observer.)

2. The Test Set Operator or the Safety Observer must be able to have an 
unobstructed view of the terminals of the equipment under test, any points 
of entry into the immediate test area, and of the workers in the area.

M4000 Safety Features
The M4000 Insulation Analyzer is equipped with a ground-relay scheme, 
which prevents test voltage from being applied until the following preliminary 
conditions have been established:

1. A #6 copper conductor is provided by Doble for the purpose of grounding 
the M4000 Insulation Analyzer. The heavy-duty #6 conductor should be 
connected to the GROUND RECEPTACLE of the M4000 Insulation 
Analyzer at one end and to the station grounding system at the other end. 
This should be the first step in setting up the M4000.

2. After the M4000 Insulation Analyzer is properly grounded, the remaining 
test leads and the HV Test Cable are plugged into their receptacles. Do not 
connect test leads to the apparatus terminals until after the leads are 
connected to the M4000.

3. The power cord should be plugged into a 120V ac or 240V and grounded 
receptacle. This should be the last step in setting up the M4000.

4. Two separate grounds are required to pick up the ground relay and operate 
the M4000: one as described in item 1 above, and the other through the 
third wire of the 120/240 volt supply cord. Care should be taken to ensure 
that there is no direct contact between the two grounds. Short circuiting 
the two grounds together may create a hazardous condition if the ground 
connection is inadvertently interrupted.

5. The HV Test Cable used with the M4000 is a double-shielded cable in 
which the high voltage is exposed only at the outboard pothead tip. The 
HV Test Cable should not be handled while it is energized. If a flashover 
occurs while testing, transient voltages higher than 10 kV can appear on 
the cable and puncture the insulating jacket of the cable, creating a hazard 
to personnel holding the cable. The cable may be suspended or tied off in 
such a way as to avoid handling.
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6. The M4000 includes a safety strobe with a magnetic base that can be 
placed on a grounded steel structure where it is visible to substation 
personnel. The safety strobe is enabled and required to be connected when 
running a test by default. Although this can be defeated in the process of 
instrument configuration, this should be done only if the strobe is not 
working and cannot be used.

7. During operation, an audible beep is heard whenever high voltage is being 
applied. This beeper is enabled by default. Doble recommends the default, 
although the beeper can be turned off as part of instrument configuration.

WARNING The M4000 Insulation Analyzer is heavy. The M4100 Instrument alone 
weighs approximately 100 pounds (45 kg). Doble recommends that at 
least two persons be used to move the M4100 in the field. Special care 
must be taken in lifting the M4100 into or from a vehicle to avoid bodily 
injury.
1-24 72A-1230   Rev. F



M4000 Insulation Analyzer User Guide

Ju
ly

 2
2,

 2
00

5

Safety Precautions
Doble insulation analyzers require operation by at least two persons. The 
M4000 Insulation Analyzer operator has his/her own Operator's Safety 
Switch. A second switch, called the Extension Safety Switch, is provided. The 
cable for the Extension Safety Switch is equal in length to the High Voltage 
Test Cable. Both switches are of the spring-release type for quick action. With 
either switch off, all voltage to the High Voltage Test Cable is removed. The 
person responsible for attaching the High Voltage Test Cable to the specimen 
should operate the Extension Safety Switch, and should be positioned so as to 
be able to observe all terminals and points of access to the apparatus under 
test. If this is not possible, then the out-of-sight terminals should be roped off 
with CAUTION labels appropriately placed, and a person posted in the 
vicinity to ensure safety.

Each time the test equipment is set up, and prior to making the first test, both 
safety switch operators should cooperatively verify the correct operations of 
both switches.

It is recommended that the Extension Safety Switch be the last switch closed. 
The Extension Safety Switch must remain open until all personnel are safely 
in the clear. Personnel should not be allowed to remain on the apparatus 
while tests are in progress. If unauthorized personnel should enter the area, 
or if some other undesirable situation should develop, the Extension Safety 
Switch operator should release the switch immediately, and then notify the 
M4000 Insulation Analyzer operator.

The two safety switches are intended to be used as a “dead man” type switch. 
Both safety switches should be used at all times. Never short circuit them 
and do not use fixed mechanical locking devices for depressing the switch 
button. The switch button must be manually operable at all times.

The M4000 operator and the operator's assistant should follow a uniform 
system of visual and verbal signals in order to prevent confusion during the 
testing process. For example, when the test connections have been completed 
and all personnel are in the clear, the operator's assistant should make visual 
contact with the M4000 operator and call “ready”. The M4000 operator, 
before bringing up the test voltage, should acknowledge the assistant's signal, 
and advise all present by calling out “coming hot”. Upon completion of the 
test, the operator should call out, “all clear”. To demonstrate further that the 
test has been completed, it is good practice for the M4000 operator to extend 
the Operator's Switch at arm's length with the button released, for all to see.
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After the tests are completed, all test leads should be disconnected first from 
the equipment terminals and brought down to ground level before they are 
disconnected from the M4100 Instrument. The #6 copper test set ground 
should be the last lead to be disconnected from the set.

WARNING Never attempt to disconnect the HV Test Cable or the Low Voltage cables 
from either the terminals of the test specimen to which they are connected 
at the outboard end, or from the receptacles on the M4100 instrument at 
the inboard end, unless the M4000 VOLTAGE CONTROL is set to 
ZERO, and the Operator's Safety Switch and the Extension Safety Switch 
are both released. Attempts to disconnect leads while the M4000 is 
energized may result in a serious, and possibly lethal, electrical shock.

Safety Precautions for Various Types of Apparatus
In addition to the items included in ”Safety Practices – General Rules” 
on page 1-20, the following are specific considerations that have to do with the 
testing of various types of apparatus:

Bushings When performing either single or multi-hot-collar tests using rubber Hot 
Collars, be aware that the rubber collar is a conductor, and that it is at the test 
voltage during the test.

Breakers Prior to any testing, steps should be taken to disable the breaker so as to avoid 
inadvertent operation during testing. In a closed breaker test, both bushings 
will be energized at test potential, and contact between the bushings and either 
test personnel or test leads should be avoided.

When testing lift-rods, operating rods, or any component internal to the 
breaker, the operating mechanism should be blocked, fuses removed, and any 
other necessary measures taken to ensure that the breaker is inoperative.

Transformers 1. When performing bushings tests, the opposite windings should be 
grounded.

2. When performing excitation tests, floating terminals should be considered 
live.

3. Use caution when applying test voltages to a transformer from which the 
oil has been removed. Recommended test voltages for testing a 
transformer without insulating fluid are listed in the Doble Test 
Procedures manual.

4. Under no circumstances should test voltages be applied to oil impregnated 
insulation while the insulation is under vacuum.
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Instrument 
Transformers

In addition to isolating and grounding live terminal(s) of the primary winding, 
secondary fuses and other leads should be removed in order to completely and 
effectively isolate the unit from the system. This is especially important in the 
case of potential transformers.

Voltage Regulators Check to ensure that there are no closed secondary links in order to eliminate 
the possibility of backfeed.

Surge Arresters Everyone is instructed to stand clear during the testing of surge arresters 
because of the possibility of their violent failure.

Capacitors 1. Close all the grounding switches on the device housing in order to ground 
the bottom terminals of the capacitor.

2. Make sure capacitor stacks are discharged before you come into contact 
with them. Internal resistors should not be relied upon for discharging 
individual capacitor cells. Capacitors intended for usage may not contain 
internal resistors. Resistors in failed capacitor cells should be considered 
suspect. For additional protection, it is recommended that the terminals of 
individual cells be discharged before personnel come in contact with them.
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Safety Summary
In summary, it is worth noting that many of the accidents that happen around 
high voltage apparatus and its associated conductors involve personnel who 
are familiar (perhaps too familiar) with high voltage equipment. Staying alert 
and ever watchful requires constant training and awareness of the inherent 
hazards.

The greatest hazard is the possibility of getting on a “live” circuit. To avoid 
this requires constant vigilance – for oneself and for one's fellow workers.

In addition to the obvious dangers, personnel should be alert to recognize 
subtle dangers as well. For example, during transformer excitation-current 
tests, the “floating” terminals may have significant voltages induced in them 
by simple transformer action. Thus, all terminals of an apparatus under test, 
unless grounded, should be considered to be “live” while the test is in 
progress.

In the case of potential transformers or any transformers which may be 
interconnected, voltage can be back-fed through the secondaries to produce 
high voltage on the primary, although the primary is seemingly isolated from 
the power system. This re-emphasizes another rule: All terminals of an 
apparatus to be tested should be completely isolated.

Remember: SAFETY
.........................FIRST, LAST, ALWAYS!
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2. M4000 Software

Upgrading or Installing M4000 Software
Your M4200c Controller comes with all necessary software pre-installed. This 
consists of the Windows XP operating system, the M4000 program, and for 
users of the Doble Test Assistant, the optional DTA program. You may also 
request the optional Leakage Reactance Test or External Reference Test 
software. You may need to install this software if you are loading it onto an 
office computer or laptop, upgrading from a previous version, or reinstalling 
it. This chapter covers the following subjects:

• Installing M4000 software on your PC.
• Introduction to M4000 Software/Icon Descriptions/Configuration 

Settings (see page 2-6)

Software Installation
WARNING Before starting, BACK-UP YOUR TEST DATA

NOTE If you have customized limit files, location.txt, and division.txt files from 
DTA, save them separately, so you can transfer the data to the new version.

M4000 Software
NOTE The first time a test is run with newly installed software, the M4200c 

Controller or your laptop computer being used as a Controller must 
update the M4100 Instrument firmware. The user is notified of this 
process by the message, “Downloading firmware to the M4100 
Instrument – Please wait”. Do not interrupt this process. Otherwise, the 
previous version of the software must be reloaded onto the M4200c or 
your laptop, then the new version installed once again.

This section contains the steps to follow to install the M4000 software.
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If you have already installed the current version of the M4000 software, and 
you only wish to add either or both of the optional features, Leakage 
Reactance and External Reference/Source testing, each of these disks contains 
its own setup function and can be installed separately as described below. To 
install the M4000 software and/or either of the optional features, follow this 
procedure:

1. Make sure all your existing test data is backed up!

2. In Windows, select the “Run” option from the Start button menu. The 
Run dialog box appears. 

3. Insert the installation diskette in the A: drive (or CD into its drive).

4. Type the following in the Run dialog box: A:\setup (or corresponding 
drive letter for the CD drive), and press the ENTER key.

5. Select the language for the installation instructions. After installation, any 
of the listed languages can be chosen at any time from the Advanced tab of 
the Tools/Configuration window, as long as they have been installed in 
step 8 below.

Figure 2.1  Language Options

6. The program will ask in which directory to install the M4000 Software. It 
is recommended to stay with the default settings. Note that it is different 
from the existing version, so that you may use either version on the same 
computer. Press the ENTER key.

NOTE Optional Leakage Reactance software must be installed in the same 
directory; the optional DTA software may go in its own directory.

7. You will be asked to select some installation options:
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• Launch M4000 at Startup: Select this option if this computer is 
dedicated to M4000 tests, since it automatically runs the M4000 
program when starting the computer (If you have the icon for the old 
version of the software in your startup folder, remove it).

• Set the serial communications port to COM2: select this only if 
installing the software on an M4200c controller.

Figure 2.2  M4000 Software Installation Options

8. You will then be asked to select safety options:

Figure 2.3  Safety Settings

• Beeper Is Enabled: Enables the audible warning feature that signals 
the beginning of each test (recommended).
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• Both LV leads must be inserted to run test: requires that both the 
red and blue leads be inserted into the test set to run a test (rarely 
used).

• Safety strobe is required to run test: In the event there is a failure of 
the strobe bulb or cable, this should be disabled so as to be able to 
continue testing without it.

• Safety switch must be released between tests: Serves to discourage 
user from artificially holding safety switch down for the duration of 
several tests.

• Restrict the Safety Configuration settings: If selected, serves to lock 
the above 4 selections so that they cannot be changed from within the 
application.

NOTE Use this last option with care, since if a need arises to change one of the above 
settings (a burnt out strobe light bulb), you cannot change the settings and 
continue testing without reinstalling the software.

9. A screen will appear where your company name, as you wish it to appear 
in the Nameplate area, can be input. Leave it blank if you prefer to fill the 
name in manually each time.

10. Finally, you will be asked which languages you wish to have installed on 
the computer. You may choose English, French, Spanish, and Portuguese, 
and different users may switch among them from the 
Tools/Configure/Advanced menu.

Figure 2.4  Languages Installed

11. If using diskettes, insert subsequent disks when prompted and press the 
ENTER key.

12. You will be asked if you wish to read the “readme” file.
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13. Since you are able to have both the old and new versions on the same 
computer, you may wish to be able to switch back and forth at first. To 
avoid downloading firmware to the M4100 each time you switch, do the 
following:

• Find the M4i.x0, Bootblok.x0, and Loader.x0 files in the directory 
where the new version 3.0 is installed (the default is C:\Program 
Files\Doble\M4000).

• Copy these 3 files into the directory of the older version you are using.
Installation of the M4000 Software is now complete.

Doble Test Assistant (DTA) Software (Optional)
See instructions found with the DTA software.

Optimization

COM port Setting
If the software has been installed on a PC, you may have to adjust the COM 
port setting if the wrong choices were made during installation. If you are not 
able to run any tests on the M4000, but get a communications error, proceed as 
follows:

1. Select Tools/Configuration, and choose the Instrument tab.

2. Set the Serial Port to COM 1.

3. Make sure the baud rate is set to 9600.

4. Click OK, reboot the computer, and try again.

5. If there is still trouble communicating, your laptop may require another 
choice. Possible COM port choices are 1, 2, 3, or 4.

Besides the COM port setting, you must be sure no other program is running 
that wants to access this same COM port. Review programs located in your 
startup folder which start up each time the computer is booted up, and remove 
any that may try to grab the COM port. Or, from the System icon in the 
Control Panel, go to the Hardware tab and select Device Manager. Disable any 
items that require the selected COM port.

Mouse Settings
You can modify the mouse settings for maximum visibility on the M4200c 
Controller: 
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• From the Windows “Start” button, choose “Control Panel” from the 
“Settings” menu item. 

• Double-click on the Mouse Icon, then select the “Motion” tab.
• Click the “Show Pointer Trails box, adjust the scale marker to “Long” 

and click OK. This will cause the mouse to leave a trail behind it when 
moved, and increase visibility in bright sunlight.

Time/Date Format
You may want to change the time/date format. The default is mm/dd/yyyy for 
date, and 12 hour format for time. To change this format, Select “Control 
Panel” from the Windows Start button menu. Time and date format can be 
changed from the “Date and Time” icon, and this change reflects through to 
the M4000.

Introduction to M4000 Software

What’s New
Aside from some behind the scenes changes to make this program a modern 
up to date 32 bit program, here are some features visible to the user:

Clipboard 1. The clipboard now has 200 lines instead of 36, so that almost any type of 
testing should be able to fit in one single file.

2. The M4000 program now supports English, French, Portuguese, and 
Spanish.

3. Serial Number and Manufacturer fields have been added to the nameplate 
area.

4. The column widths on the test grid are user-configurable.

5. For each test, time, date, air temperature, and humidity are recorded and 
can be viewed.

6. A new file structure has been implemented, allowing user-specified file 
names for easier data manipulation.

7. The printout now has a grid around the data, for a more professional look.

8. The Clipboard mode now has graphing capabilities (see ”Graphing Test 
Results” on page 3-11).

9. The Clipboard mode now offers automatic temperature correction (see 
”Temperature Correction” on page 2-12).
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Leakage Reactance 10. One Leakage Reactance file can now contain all tests in a series: Three 
Phase Equivalent, Per Phase, and tests on different taps. Data entry is now 
more intuitive.

External Reference 11. On the External Reference form, both UST and GST tests can be stored all 
on the same form.

12. You may now store reversal readings on the same line and automatically 
average the results.

13. You may now store test circuit loss associated with the GST test, and the 
program will automatically subtract the loss from the test results.

The M4000 Program
To start the M4000 Software: turn on the M4200c Controller; or, if using your 
laptop, and the program executable is not in your “StartUp” group:

1. Select All Programs from the Windows Start button menu.

2. Select the Doble Program Group.

3. Select the M4000 icon.

4. Click the OK button on the “About The M4000 Software” window. You 
are now at the M4000 clipboard screen. The menu bar contains a number 
of choices, with a row of short-cut icons just below.

Icons
Before step 4 above, the basic icons shown and their functions are described as 
follows:

Icon Description

Open M4000 data file. New M4000 files have the extension 
.m4k, but old M4000 files can also be opened using this 
command.

Exit the M4000 Software, or select Exit from the File pull 
down menu.
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Menu Bar
The Menu Bar functions are described as follows:

Mode: Allows selection of available test modes. Clipboard is automatically 
included with the M4000 software. External Reference/Source, Leakage 
Reactance, and DTA are optional software add-ins.

Diagnostics: These help you check the status of the M4000 Insulation 
Analyzer, and to diagnose any problems that may exist. See ”Running 
Diagnostics” on page 4-21 for a description of this item

View: De-selecting an item from this menu will remove the icon bar from your 
screen. Select again to restore it.

Tools: Here you can clear test and nameplate data, view a test note or 
temperature/humidity data, or adjust configurations. See the “Configuration” 
section in this chapter for a full description of these options.

Enter DTA Field System Software, or select DTA from the 
Mode pull-down menu. With DTA, the second test mode 
available is DTA. See the DTA instruction manual for use of 
the DTA option. DTA contains specific forms for different 
apparatus types, along with an expert system to evaluate 
results. Since this is optional software, this icon will not be 
active if DTA software is not installed.
Enter Clipboard Mode or select Clipboard from the Mode 
pull-down menu. Without DTA, the only test mode is 
Clipboard. The clipboard mode is described further in this 
chapter. It provides a generic form for testing any apparatus.

Enter External Reference/Source Mode, or select External 
Reference/ Source from the Mode pull-down menu. Since this 
is optional software, this icon will not be active if External 
Reference software is not installed.

Enter Leakage Reactance Test Mode, or select Leakage 
Reactance Test from the Mode pull-down menu. Since this is 
optional software, this icon will not be active if Leakage 
Reactance software is not installed.

Find help, or press the F1 key, or select the items from the 
Help pull-down menu item. Help is described in the 'Using 
Help' section of Chapter 1.

Icon Description
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Clipboard Test Mode
To enter Clipboard test mode, click the  icon, or select Clipboard from 
the Mode pull-down menu item.

The following screen will appear:
 

Figure 2.5  Clipboard Screen

Clicking on the following icons will perform the described functions:

Icon Description

Open a File. If a Clipboard file is saved, it can be retrieved by 
clicking on this icon, pressing F9, or selecting Open from the 
File pull-down menu.

Save a File. This can also be done by pressing CTRL+S to 
save the file with the existing name, or the F8 key to save with 
a new name.

Print the current Clipboard form. This can also be done by 
selecting Print from the File pull-down menu item, or by 
pressing F7.
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Enter the DTA Field System program. This can also be done 
by selecting DTA from the Mode pull-down menu item.

Click to open a Clipboard screen, where tests may be run and 
recorded.

Click to enter External Reference/Source Mode, or select 
External Reference/ Source from the Mode pull-down menu.

Click to enter Leakage Reactance Test Mode, or select 
Leakage Reactance Test from the Mode pull-down menu.

Run a single test. This can also be done by selecting Run A 
Single Test from the Test pull-down menu item, or by 
pressing F2.

Run a multiple test. This can also be done by selecting Run A 
Multiple Test from the Test pull-down menu item, or pressing 
FN+F11.

Enter a note. When clicking on this icon, the software will ask 
you which line the note corresponds to. The default is for line. 
This can also be done by selecting Edit Test Note from the 
Edit pull-down menu item.

View the air temperature and percent humidity associated 
with each line of test data. This can also be done by selecting 
Display Temp./Humidity from the Edit pull-down menu item.

Allows user to activate automatic temperature correction 
function for the clipboard test mode.

Graph the selected clipboard results

Icon Description
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NOTE If you are using the pull-down menus and wish to remove these icons, 
click on the View pull-down menu item and then click on Toolbar. This 
will disable the icons. They can be retrieved by repeating the same action.

Menu Items
The menu items are File, Mode, Test, Diagnostics, View, Tools, Window, 
and Help. The principal functions included under these items are better 
accessed by using the icons described in the previous paragraphs. The features 
under what used to be the Edit menu are now found under Test by selecting 
the Clear menu item. The Diagnostics commands are described in Chapter 
Six, M4100 Instrument.

Mode Menu
Select the type of test desired. Choices are:

• Clipboard (for Power Factor, Exciting Current tests)
• Leakage Reactance (Requires optional software)
• External Reference/Source (Requires optional software)
• DTA (Requires optional software)

Test Menu
This menu contains the start single test (F2) and start multiple tests (F11) 
commands.

Toggle sheet note. Click this icon to display or hide a note 
area for the entire clipboard sheet at the bottom of the screen.

Toggle Nameplate. Click this icon to display or hide all but 
the test data. This allows the user to hide or display the 
Nameplate information, time, date, Administration and Test 
Condition buttons.

About M4000 For Windows. This can also be chosen by 
selecting About M4000 For Windows from the pull down 
menu item.

Icon Description
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Diagnostics
This menu contains several self-test options, described in ”Running 
Diagnostics” on page 4-21.

View Menu
Commands here allow display or hiding of the:

• Toolbar (row of icons)
• Status Bar (along the bottom of the screen, it includes status of the 

Caps Lock and Num Lock functions, which should be off)
• Nameplate data fields
• Sheet note located just above the Status bar at the bottom of the screen.

Tools Menu
This menu includes the following:

• Insert a test line command, inserts a new row above the row in which 
the cursor sits.

• Remove an empty test line removes the empty line on which the cursor 
sits. If the line is not empty, a warning message appears.

• Clear command for test results, nameplate data, test note, and sheet 
note

• Test Note command, which allows access to individual test notes for 
each line of test data

• Temp and Humidity command, which allows access to the 
temperature and humidity readings for each line of test data.

• Temperature Correction, as described below, enables the user to select 
the type of apparatus under test so as to activate automatic temperature 
correction.

• Graph results command, allowing the user to select test results on the 
clipboard and graph them.

• Configuration settings for both the software and the instrument, 
described under ”Configuration” on page 2-13.

Temperature Correction
To activate automatic temperature correction:

1. First, run your tests and fill in the rows with the results.
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2. Click the temperature correction icon , or select Temperature 
Correction from the Tools menu.

3. In the Temperature Correction window, fill in the rows on the clipboard 
screen to which you wish to apply the temperature correction. These rows 
must have temperature data associated with them for this function to work.

4. Select the Equipment Type and Sub-types where applicable.

5. Click OK, and Clipboard will apply the appropriate correction factor to the 
selected rows of test data.

Configuration
There are five option tabs available in the M4000 Configuration window, 
accessed from the View menu item. They are System, Clipboard, DTA, 
Instrument, and Advanced.

System Configuration
When selecting the System tab, the following appears:

Figure 2.6  M4000 System Configuration
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Ramp Mode - Auto Ramp Mode raises the voltage automatically at a rate 
selected separately in the Clipboard Configuration and DTA Configuration. 
Manual Set Voltage allows raising the voltage by pressing the PGUP key to 
raise the voltage rapidly, the PGDN key to lower the voltage rapidly, the up 
arrow key to raise the voltage slowly, and the down arrow key to lower the 
voltage slowly. The rates at which the voltages are raised and lowered 
manually are selected separately in the Clipboard configuration and the DTA 
Configuration.

Line Frequency - Select the frequency that corresponds to the user's system; 
or, if trying to duplicate a test result made at another frequency, select either 
frequency. Under normal system conditions, make the ± 5% selection. If your 
power line frequency is itself experiencing this degree of variation, you may 
be required to make the ± 10% selection to avoid the effect of electrostatic 
interference. The M4000 users Line Frequency Modulation to measure above 
and below power line frequency to avoid measurement of electrostatic 
interference.

M4000 Data Directory - This is the directory in which the Clipboard data is 
to be stored. To change the default settings, use the mouse to click into the 
M4000 Data Directory field. Then, edit the settings to reflect in which 
directory the Clipboard data is stored.

Select a directory other than C:\DOBLE\DTA for data storage for both 
Clipboard data and DTA data.* Click on the OK button to accept your 
changes.

* For example, use C:\Doble\DTA\DATA.

Company: If filled in, this line will cause all tests to use the information in the 
“Company” field when starting a new clipboard test.

Clipboard Configuration
When selecting the Clipboard tab, the following appears:
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Figure 2.7  Clipboard Configuration

Test Type - If Line Frequency Modulation is selected, a test at ± 5% of the 
reference frequency, will be performed. This selection is desirable when 
testing in the presence of electrostatic interference. If Line Sync Reversal is 
selected, a test at the positive polarity and a test at the negative polarity in 
reference to the input voltage at the base frequency is performed. This 
selection is desirable when performing tests using a resonator or exciting 
current tests on a transformer.

Display Mode - If Reference to 10 kV is selected, all results will be reported 
as if 10 kV were the applied voltage. If results obtained were tested at 2 kV, 
current and watts measurements will be multiplied by 5. Historically, this is 
the way all Doble tests have been performed. If Actual Values are selected, all 
results will be reported in reference to the applied voltage.
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Loss Factor - There are two options available, Power Factor and Dissipation 
Factor, practically identical in routine usage. Dissipation Factor may be 
chosen when the user wishes to duplicate nameplate data from international 
manufacturers. However, the two are virtually identical at Power Factor 
readings below 5%. Units may be selected as Percent or Actual (and, for 
Dissipation Factor, mW/VAr). Power Factor is generally expressed in percent, 
and Dissipation Factor as Actual.

Voltage Ramp Settings - The rate of voltage change corresponding to the 
Auto Ramp Mode and Manual Set Options is entered in these fields. For 
example, the default settings call for an increase of 100 volts every time the up 
arrow is pressed when manually bringing up the voltage.

• Manual Mode Slow Step - The increment of voltage corresponding to 
each press of the up and down arrow key for manually setting the 
voltage. To change the default settings, click the mouse in this field 
and enter the desired voltage.

• Manual Mode Fast Step - The increment of voltage corresponding to 
each press of the PGUP and PgDn key for manually setting the 
voltage. To change the default settings, click the mouse in this field 
and enter the desired voltage.

• Auto Mode Ramp Step - The increment of voltage corresponding to 
the automatic voltage ramping steps. Using the default setting means 
that the voltage is raised and lowered in 500 volt increments. In the 
Auto Ramp Mode, voltage is lowered when a reversal is performed.

Click on the OK button to accept the selections.

DTA Field Configuration
This only applies to users of DTA Field System Software. When the DTA 
Field Configuration tab is selected, the following appears:
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Figure 2.8  DTA Configuration

Test Type - See Clipboard Configuration for a description of this item.

Voltage Ramp Settings - See Clipboard Configuration for a description of 
this item.
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Instrument Configuration
When the Instrument Configuration tab is selected, the following appears:

Figure 2.9  Instrument Configuration

Serial Port - It may be necessary to change this setting to accommodate 
laptops being used with the M4100. The M4200c uses COM2, and laptops 
usually use COM1. The “bits per second” setting should not be changed from 
the default 9600.

USB Converter- If using a Serial to USB converter to utilize a USB port on 
your laptop for connection to the M4100, check your PC settings to obtain the 
comport that has been set by the converter. For Windows XP, go to the Start 
button, select Control Panel/System (or alternately, right-click My Computer 
and select Properties), then click Hardware and then Device Manager. Click 
the plus sign next to Ports (Com & LPT) to see the comport assigned to your 
converter.
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Settling Time Delay- The time, at maximum test voltage, during which the 
M4000 samples the data. If it appears that excessive electrostatic interference 
is affecting test results, the settling time may be increased in order to sample 
the data over a longer period of time. To change the value in this field, click 
the mouse in this field and enter in a new value.

Safety Settings - These may be set as desired, provided the option “Restrict 
the Safety Configuration settings” was not set during software installation. 
If it was, and you want to change these settings, you will have to re-install the 
software and de-select that option. It is recommended that unless they are not 
functioning, the user should leave the beeper and strobe light operational. The 
settings are:

• Beeper - If the beeper is enabled, four beeps will sound when voltage 
is applied to a specimen. If the beeper is disabled, there will be no 
audible warning of applied voltage.

• Both Low Voltage Leads must be inserted to run test - it is 
recommended this box be left unchecked, since most tests require only 
one lead.

• Safety Strobe required to run test- If “required to run a test” is 
selected, the strobe must be plugged in or a test cannot run. If the 
strobe is not available, select “not required”.

• Safety switch must be released between tests - Prevents users from 
defeating the purpose of the safety switch by artificially holding it 
shut. The switches should be pressed when the message onscreen tells 
you to.

Click on the OK button to accept your selection.

Advanced Configuration
When the Advanced tab is selected, the following is displayed:
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Figure 2.10  Advanced Configuration

Language: Choose from English, French, Spanish, and Portuguese, if selected 
for installation.

Filter Type: The default is Slow, and should not be changed without 
consulting Doble.

Capacitor Model: The default is Parallel, and should not be changed without 
consulting Doble.

Inductor Model: The default is Parallel, and should not be changed without 
consulting Doble.

Allow Multiple Documents: If this box is checked, more than one set of test 
data can be active and displayed at once.

Current Range: The default is Auto, and should not be changed without 
consulting Doble.

Watts Range: The default is Auto, and should not be changed without 
consulting Doble.

Grid Font Size: Allows you to increase the size of the fonts on your screen, 
making it easier to see the data.

Print Font Size: Increases the size of the font used in printing.
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Using Help
When Help is selected, two options are presented:

1. Contents F1.

2. About M4000 For Windows... 

Contents
The Help/Contents option opens the Help window:

Figure 2.11  Help Window

When Contents is selected, you can find how to use Help by pressing F1. The 
contents screen also has a series of buttons along its top:

The Glossary button has topics that are specific (such as, Auto Mode 
Ramp Step).

If you are unsure which item to select, you can use the Search function 
located on the top of the Help screen to find a specific topic.

To return to the previous screen, press Back located on the top of the Help 
screen.

To view each item in the list of contents, press the >> button. To go back to 
the Help of the previous item, press << button.
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About M4000 For Windows
Selecting this item displays the current version of M4000 Software and 
firmware.

Printer Setup
The default printer setting for your M4200c Controller is for a thermal printer. 
This enables the use of the M4200c Controller's built-in printer. If using a 
laptop, you must use Windows to add in the necessary printer drivers for your 
office printers.

Printing
To print a Clipboard form, select Print from the file pull-down menu item, or 
press F7. The following screen will appear:

Figure 2.12  Clipboard Form Report Generator

To print a field, select it by clicking on the square, adding a a checkmark. To 
print to a file, select “Save the report to a file” by clicking its box, adding a 
checkmark. Results can be saved in text (txt) or comma separated variable 
(csv) format.

A detailed description of each of these fields can be found in ”Entering 
Clipboard Information” on page 3-1.
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3. Running M4000 Tests

There are four test modes available with the M4000 software; all but 
Clipboard require optional software:

• Clipboard Mode
This is a generic form for recording and storing test results, nameplate 
information, weather conditions, test parameters, and notes, and is 
described below. A new graphing function allows test results to be 
graphed.

• External Reference/Source Mode (page 3-12)
This test mode enables the user to perform tests using an external 
source and reference, extending the range of test voltage above the 12 
kV of the M4000 test set.

• Leakage Reactance Mode (page 3-16)
This test mode enables the user to measure transformer leakage 
reactance. Auxiliary hardware is required in the form of the M4110 
Leakage Reactance Interface, or the M4130 Leakage Reactance 
Module.

• DTA Mode (page 3-17)

Entering Clipboard Information

Nameplate Information
Within the Clipboard form, the following is what is considered nameplate 
information:

Figure 3.1  Nameplate Information
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Entering this information is vital to properly identify the test and the 
equipment tested.

Administrative Information
Next to the Nameplate Section is an Administration button. When clicking this 
button, the following screen will appear:

Figure 3.2  Administrative Information

The following is an identification of these terms:

Checked By The person who checked the results (if different from 
the user).

Tested By The user of the M4000 Insulation Analyzer.

Controller No. The serial number is located on the bottom of the 
M4200c Controller.

Instrument No. The serial number is located on the front panel of the 
M4100 Instrument.

Sheet No. Identification for each single Clipboard Form is done 
with filenames when saving the form. Sheet number 
was a form of identification used on older paper test 
forms and the space is provided if the user needs to use 
it to further identify the test.

After entering this information, click on the OK button to save it.
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Test Conditions
Clicking on this button will show the following screen:

Figure 3.3  Test Conditions

The Weather is a pull down menu item with the selections accessed by 
clicking on the  (down arrow icon).

Entering Air Temperature and Humidity is unnecessary if using the 
Temperature Probe. If not, it is necessary to enter data in each field. In either 
case, Oil Temperature is required if testing oil-filled equipment. For 
transformers, use the top oil temperature.

Click on a Convert button first to enter the temperature in Fahrenheit.

Clicking the OK button will save the entries.

In the Clipboard mode, each row of test data contains the Test Conditions 
information. Test conditions for all the tests on the clipboard form can be seen 

by clicking the  icon, or selecting Tools/Temp. and Humidity. The 
data found on the Test Conditions screen is that of the last test run.
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Test Results Information
Each line of the Clipboard test results contain the following fields:

Column Description
No name... Number – indicates the test line (row) number. There are 

36 rows, accessible by scrolling down with the down 
arrow key.

TEST ID Test Identification – on each test line, you can enter a 
serial number or description of the test to be performed.

LC Line Configuration – To get an explanation of the letter 
displayed in this column, click the “?” on the icon bar. 
Clicking on the  will display the pop-up list of choices.

Circuit Desc. Circuit Description – the abbreviation in this column 
defines the test circuit used when performing a test on a 
line of the Clipboard Form. Clicking on the  will 
display a pop-up window of all the choices. Select the 
desired choice. See “Test Modes Of The M4000 
Analyzer, in the Doble Test Procedures manual.

kV Kilovolts – this column indicates the test voltage, in 
thousands of volts, to be used during the test (for 
example, 10.00 means 10,000 volts).

mA Milliamperes – this column contains the specimen test 
current results in milliamps. You cannot enter or make 
changes in this column. The results are recorded after 
pressing F5 to accept results of a test.

Watts Watts – this column contains the specimen watts loss test 
results in watts. You cannot enter or change results in 
this column. The results are recorded after pressing F5 to 
accept results of a test.

Meas%PF Measured Percent Power Factor. This column contains 
the calculated percent power factor from the 
Milliamperes and watts loss results obtained from the 
test. You cannot enter or change results in this column.
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Corr. Fact. Temperature Correction Factor. This column includes 
automatic application of temperature correction factors 
to the Clipboard Form. The default correction factor is 
1.00.

The Measured Percent Power Factor is multiplied by this 
Temperature Correction Factor to obtain the Corrected 
Percent Power Factor in the column to the right of the 
Corr. Fact. Column. See ”Temperature Correction” 
on page 2-12 for this automatic function.

Corr%PF Corrected Percent Power Factor. In this column, you will 
find the results of the Measured Percent Power Factor 
Times the Correction Factor. You cannot enter or change 
results in this column.

Cap. /Ind. Capacitance/Inductance. Whether the current is 
capacitive or inductive is displayed in this column. You 
cannot enter or change results in this column.

RT Rating. You may enter a one letter rating (G. B. I., etc.) 
of the insulation in this column.

N Note. If a note is entered for a single line, a check mark 
will show in this box. A test note is entered by selecting 
Test Note... from the Tools pull-down menu item, or by 
clicking on the notepad icon. You will be asked to which 
test line the note corresponds. The default test line is No. 
1.

To enter a note that relates to the entire Clipboard Form, 
type in the area at the bottom of the screen titled, Sheet 
Note (If it is hidden, click Sheet Note from the View 
menu).

To clear a note, select Clear from the Tools pull-down 
menu item.

Column Description
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Running Single and Multiple Clipboard Tests
Either single or multiple tests (up to six at once) may be run. Each row or line 
of the test form represents one test, and for each test, the following 
information should be entered into the appropriate columns:

• Test ID
• Line Configuration (LC); the default value: A, Reference to 10 kV, 

Line Frequency Modulation, 60 Hz, is the most common (use B for a 
50 Hz test). Use C, Reference to 10 kV, Line Sync Reversal, for 
testing with a resonator or for excitation current tests, regardless of 
system frequency.

• Circuit Description (GST-Ground, GST-Guard, UST)
• Test kV

The above information may be entered before initiating a test. Or, a test may 
be initiated immediately, and you will be prompted to enter the line number, 
Line Configuration, Circuit Description and Test kV.

To run a single test, press F2, or click the  icon. 

To run multiple tests (up to six), press FN+F11 or click the  icon.
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Raising Test Voltage
After making the necessary entries, the following screen appears:

Figure 3.4  Safety Screen

This screen shows the parameters that will be used when the test is run. 
Double-check the cable connections and test parameters. If the test parameters 
are not correct, click on the Abort button or press the ESC key.

When the parameters are correct, proceed with the test by depressing both 
safety push buttons, and either pressing the ENTER key or clicking on the 
Continue button.

WARNING High voltage will be present after starting the test. Pressing the ESC key 
or F4, or releasing a safety push-button, will turn off the high voltage.

The following screen will appear:
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Figure 3.5  Test in Progress

The test will proceed automatically if Auto Ramp Mode is selected in the 
Clipboard Configuration, or will be ramped up by the operator if Manual Set 
Voltage is selected in the Clipboard Configuration. The digital values for these 
parameters will be shown to the right of the meters. The table on the screen 
describes test conditions and power factor test results. The line on the bottom 
of the screen displays the status of the test. When running multiple Clipboard 
tests, the line number of the test that is running will be displayed on the same 
line. For each test line, the voltage will ramp to the required maximum test 
voltage twice. This is required to implement the selected electrostatic 
interference cancellation technique (Line Synchronized Reversal or Line 
Frequency Modulation).

Test Results
After the test is completed, the following appears:
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Figure 3.6  Test Complete

There are choices listed at the bottom of the screen. An explanation of each 
key's function is as follows:

Icon Description

Pressing F1 will display “Screen Help” which is also available by 
clicking on this icon.

Pressing F2 or FN+F11 will “Restart Test”, also available by 
clicking on this icon.

Pressing F5 will “Accept Results” of the test(s) successfully 
performed, return to the Clipboard Form, and copy the results into 
the proper columns. When performing multiple tests, only tests 
completed prior to a stopped test will be accepted into the 
Clipboard Form. This is also available by clicking on this icon.
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Clearing Test Results
After acceptance of tests, you can clear the test results by selecting Clear/Test 
Results from the Tools pull-down menu item, or, by pressing F10. When this is 
done, the following screen appears:

Figure 3.7  Clear Test Results

You have the option to clear all tests, clear a single test line, or clear multiple 
test lines.

Pressing F6 will “Discard Results” and returns you to the 
Clipboard Form. This is also available by clicking on this icon.

Icon Description
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Saving Test Results
To save the nameplate and clipboard data, select the  icon, or the Save 
As... item under the File menu. You will be prompted to select a file name. 
You may save in the selected folder (typically C:\doble\dta\data).

Figure 3.8  Saving Clipboard

NOTE As you add tests in Clipboard, you may want to periodically save the file 
to include added test data. All 200 lines may be saved under a single file 
name. But after saving with a given file name the first time, all subsequent 
saves with the same name will result in the message, “This file already 
exists. Do you want to replace it?” Select the “Yes” button, or the new 
data will be not be saved. However, if the Serial Number or Special ID 
fields have been edited since the last save, the filename, which is based on 
one of these two fields, will have changed and the file will be saved based 
on the new filename. Once all 36 lines are filled with data, save it one last 
time. Then, to continue, you must clear the data and start a new file name. 

Graphing Test Results
With the new graphing function, you can graph data on the clipboard sheet.

1. Run a test or open a file, placing data on the clipboard.

2. Select the test data you wish to be graphed.
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3. Click the  icon. In the pop-up window, select whether you want a 
Histogram or a Trend.

4. If a Histogram is chosen, select the value you wish to plot. In Bins, select 
the number of ranges you wish to use to categorize your data, then click 
Draw.

5. If a Trend is chosen, select values to plot on the X and Y axes, then click 
Draw.

6. After you have drawn the graph, there are several icons along the top you 
can select to change the type of graph, or to refine it’s appearance.

External Reference/Source Test (Optional Software)

Running A UST Test

Figure 3.9  External Reference Main Screen
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1. Select “External Reference” from “Mode” on the M4000 menu bar, or 
click the External Source icon.

2. There are two test types: UST Measure Blue and GST Guard Blue. Select 
UST Measure Blue from the Test Mode column.

3. There will be one clipboard sheet per test sequence with a maximum 
number of tests in a sequence of 12.

4. Before running a test, enter the capacitance and power factor of the 
reference capacitor, and the maximum test voltage.

5. Start a test by selecting Test from the menu bar, or by pressing F2, or by 
clicking one of the lightning bolt icons (single or multiple tests can be 
run). The line frequency will be measured and recorded.

6. You will be prompted to select a line number on which to place test 
results, and whether the test is a Normal or Reversal (the first test for a 
given line is by default a Normal test).

7. The safety screen is displayed with your selected settings. When you are 
ready to begin the test, select the Continue button.

WARNING Observe the warning noted in Figure 3.10.

Figure 3.10  Warning

8. The M4000 is now ready to measure. The message “Set Test Voltage, Line 
(x), Then Press F3 To Measure”, appears (where (x) is the selected line 
number).

9. When you have set the external source to the desired voltage, press the F3 
key. The message, “Do not change voltage - collecting data” appears.
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10. When the message, “Test Done, Line (x)”, where (x) is the selected line 
number, press the F5 key to accept results. The mA, Watts, Percent Power 
Factor, and Capacitance/Inductance is recorded on the clipboard sheet.

11. At this point, a reversal could be run for this line (x). To do this, repeat 
steps 5 through 10, selecting the same line number, and selecting 
“Reversal”. Since performing reversals requires reversing the leads on the 
external source, it will be practical to perform a series of Normal tests first, 
and then go back, reverse the leads to the external source, and perform a 
series of Reversal tests corresponding to the Normal tests.

12. Once you have pressed F5 to save the reversal results, the line(s) that 
contain both Normal and Reversal data will be check-marked in the CR 
column. If you are testing indoors, it is unlikely you will need to perform 
Reversal Tests.

Running a GST-Guard Test
1. Select “External Reference” from “Mode” on the M4000 menu bar, or 

click the External Source icon.

2. There are two test types: UST Measure Blue and GST Guard Blue. Select 
GST Guard Blue from the Test Mode column.

3. There will be one clipboard sheet per test sequence with a maximum 
number of tests in a sequence of 12.

4. Before running a test, enter the capacitance and power factor of the 
reference capacitor, and the maximum test voltage.

5. Start a test by selecting Test from the menu bar, or by pressing F2, or by 
clicking one of the lightning bolt icons (single or multiple tests can be 
run). The line frequency will be measured and recorded.

6. You will be prompted to select a line number on which to place test 
results, either a Specimen Test or Setup Correction Test (the first test for a 
given line is by default a Specimen Test), and either the Normal or 
Reversal mode (the first test for each line is by default a Normal mode 
test).

7. The safety screen is displayed with your selected settings. When you are 
ready to begin the test, select the Continue button. 

WARNING For the External Source Test Mode, safety switches and the strobe light 
are not used. The External Source voltage is not controlled by the M4000. 
Proper safety precautions must be taken. 
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8. The M4000 is now ready to measure. The message “Set Test Voltage, Line 
(x), Then Press F3 To Measure”, appears (where (x) is the selected line 
number).

9. When you have set the external source to the desired voltage, press the F3 
key. The message, “Do not change voltage - collecting data” appears.

10. When the message, “Test Done, Line (x)”, where (x) is the selected line 
number, press the F5 key to accept results. The mA, Watts, Percent Power 
Factor, and Capacitance/Inductance is recorded on the clipboard sheet.

11. At this point, if your test was a Specimen Test, you could run the Setup 
Correction Test for this line (x). To do this, repeat steps 5 through 10, 
selecting the same line number, and selecting Setup Correction Test. Since 
performing the Setup Correction Test requires removing the high voltage 
cable from the specimen, it will be practical to perform a series of 
Specimen Tests first, and then go back, remove the high voltage cable 
from the specimen, and perform a series of Setup Correction Tests 
corresponding to the Specimen tests. If the losses of the High Voltage 
cable and transformer can be guarded, it is not necessary to perform the 
setup.

12. Once you have pressed F5 to save the Setup Correction Test results, the 
line(s) that contain both the Specimen Test and Setup Correction Test will 
be check-marked in the CR column.

13. You now have the option of repeating your tests in the reversal mode. 
Simply repeat steps 5-12, always selecting the Reversal mode instead of 
the Normal mode. When finished, you will have done either two tests per 
line (no reversal tests made) or four tests per line (including reversal tests). 
If testing indoors, Reversal Tests are not likely to be necessary.
72A-1230   Rev. F 3-15



Running a GST-Guard Test
Ju

ly
 2

2,
 2

00
5

Leakage Reactance Test (Optional Software)

1. Click on the Leakage Reactance button  to display the Leakage 
Reactance test. Fill in Location, Manufacturer, and Serial Number.

2. Click the Benchmark tab and enter the nameplate data; this includes the 
transformer impedance, and the MVA, kV, and tap positions at which it 
was measured in the factory.

3. If this is not the first test, enter the benchmark values from the first test; if 
it is the first test, enter the transformer nameplate impedance in both the 
impedance and reactance benchmark fields.

4. Select the Winding Configuration, then the Test Configuration. If this is 
the first test, perform a 3 phase equivalent test for comparison to 
nameplate impedance, then three per phase tests (one per phase) to obtain 
benchmark values for each phase for comparison to future tests.

5. Use the Phase column to identify the winding measured.

6. Click the Run a Test icon  to start the test.

For complete details of this test, including test setup and connections, see 
“Leakage Reactance Testing” in the Doble Test Procedures manual. 

NOTE Always exit Windows before shutting off your M4000 Insulation 
Analyzer.
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DTA Mode
The remainder of this chapter describes how to run tests in the Doble Test 
Assistant (DTA) Mode. For a complete description of the DTA program, refer 
to the DTA Field System for Windows Users Guide. It is recommended that 
this manual be available for reference.

NOTE The DTA Mode is not available unless the DTA software has been 
purchased and has been loaded onto the M4000. If you are not using DTA, 
all testing with the M4000 will be done in the “CIipboard” mode, as 
described earlier.

DTA Tests
With no test type selected, the main M4000 screen appears as follows:

Figure 3.11  M4000 Main Window

To test in the DTA Mode:

• Click on the  icon, 
or

• Select the “Mode” item on the menu bar using the mouse, or by 
pressing ALT+M. Then select DTA option.

Either the icon or the menu method will bring you to the DTA Data Manager, 
seen in Figure 3.12.
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DTA Data Manager

Figure 3.12  DTA Data Manager

If you are using the windows version of DTA for the first time, the working 
directory may appear as “C:\DOBLE\DTA\DATA”. If you have been using the 
DOS version of DTA, your working directory is “C\DTA\DATA”. If you wish 
to continue using the old directory, or wish to change the directory, proceed as 
follows:

1. Click the Source button under the icons at the top of the screen.

2. From the pop-up window, select the new directory.

3. If using DTA version 4.1, run the program, and from the main screen:

4. Select Change from the Directory menu.
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5. In the resulting pop-up Source Directory window, type in the desired 
directory.

6. Click on “Dir List” if you want to browse through your computer files and 
locate another.

Preparing for a DTA Test
NOTE The M4000 software version 3.xx requires DTA software version 5.xx.

1. Click the New icon   if no previous tests for this apparatus are 
available in DTA. This will create a new test and a new apparatus record.

2. If a previous test exists in your DTA directory, select it from the existing 
apparatus tests in the right-hand column (if there is still no list, you may 
have the wrong directory). Double click the desired apparatus in the right-
hand panel of DTA. To sort the displayed list, click on the column you 
wish to sort by.

3. See the DTA Users Guide on how to arrive at the ID panel of the new test 
form, if necessary.

4. If the open file contains previous test data, click the Next Test Date icon 

. This creates a new, blank, set of test sheets.

5. Enter the atmospheric conditions by clicking the  icon, or by 
selecting Test Conditions from the View menu.

6. After entering necessary nameplate data and other apparatus identification, 
proceed to the Overall test form.

7. Connect the test cables to the apparatus to be tested. See the DTA test form 
for help in making the connections for the tests listed, or see the Doble Test 
Procedures manual.

Starting a DTA Test
1. Move the cursor to the “Test kV” field for the test to be performed. Type in 

the required test voltage.
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2. Start a test by clicking the  icon, or by selecting from the Test 
menu, Run Test - M4000. The “Test Conditions” window will appear if 
you haven’t yet filled it in, with “Prb” in the air temperature field. This 
indicates that air temperature will be entered automatically by the M4000 
Temperature and Relative Humidity Sensor. If “Prb” doesn’t appear, then 
the temperature/humidity sensor is not connected or is not working. An oil 
temperature is required for oil-filled equipment. If the Temperature and 
Relative Humidity Sensor is not used, an air temperature is also required.

3. Click the OK button in the Test Conditions window.

4. A “Run M4000 Test” pop-up window will appear.

5. Choose to run a single or a multiple test. A single test is a test for the line 
the cursor is on. The multiple test will run all tests associated with one set 
of connections. Select the appropriate choice (see the DTA manual for 
details). You will most likely select Multiple Tests - Default.

6. In some types of apparatus, such as live-tank breakers or three-winding 
transformers, both red and blue leads are generally used. In such cases, 
DTA will ask you where each color lead was placed. You may select the 
Setup button in any case, to check the selected test voltage for each test 
you plan to do, as well as the default test circuit.

You will then be presented with a safety screen, where test circuit and voltage 
can be checked. This is your last chance to be sure these parameters are 
correct, and to abort the test if they are wrong.
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Figure 3.13  Safety Screen

1. Select the “Abort” button to return to DTA and make changes. Make this 
choice if the test voltage needs to be changed.

2. Select the “Configure” button to change other test parameters, such as 
Frequency or Test Type.

WARNING High voltage will be present after starting the test. Pressing the ESC or F4 
key, or releasing a safety switch button, will turn off the high voltage.

When the parameters are correct, proceed with the test by:

3. Pressing both safety switch buttons.

4. Selecting the “Continue” button by highlighting it and pressing the 
ENTER key.
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The following screen will appear:

Figure 3.14  DTA Test In Progress

The test will proceed automatically. The test specimen’s current, watts loss, 
and voltage will be displayed in three analog meters (horizontal bars) on the 
screen. The digital values for these parameters will be shown to the right of the 
meters. The table on the screen describes test conditions and test results. The 
horizontal bar at the bottom of the screen displays the status of the test.

For each test being performed, the voltage will ramp to the preselected 
maximum twice. This is required to implement the selected interference 
cancellation technique (Line Synchronized Reversal or Line Frequency 
Modulation).

When the test is over, the status bar will read “Test Done”.
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Figure 3.15  End of DTA Test
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DTA Icons and Function Keys
A list of function keys is displayed at the bottom of the screen after the test. In 
addition, a row of icons appears at the top of the screen. An explanation of 
each icon and key function follows:

After pressing the F5 key to accept results, the test data and insulation rating 
should be reviewed for correctness. The operator can continue to the next test 
on the DTA form.

NOTE Always exit Windows before shutting off your M4000 Insulation 
Analyzer.

Selecting this icon or 
function key…

Does this…

  icon or F1 key Displays screen Help

  icon or F2 or F11 key Restarts the test

  icon or F5 key Accepts test results, returns to the 
DTA form, and copies the results into the 
proper locations. When performing 
multiple tests, only tests completed prior 
to a stopped test will be accepted into 
DTA

  icon or F6 key Discards test results, returning to the 
DTA form
3-24 72A-1230   Rev. F



M4000 Insulation Analyzer User Guide

Ju
ly

 2
2,

 2
00

5

Using A Resonator

Figure 3.16  The Doble Resonator

The Doble Type C Resonating Inductor is an iron-core reactor with an 
adjustable air gap, capable of resonating capacitances within a range of 0.05 to 
1.0 microfarads at 60 Hz, and a range of 0.07-1.4 at 50 Hz. It is designed to 
extend the current range of Doble 10 kV Power-Factor Test Sets up to four 
Amps, assuming a lossless specimen, at voltages up to 10 kV. It extends the 
use of the set for testing relatively long cable lengths, large rotating machines, 
and other high-capacitance specimens. The ultimate range of the resonator 
depends not only on the capacitance of the specimen but also the total losses of 
the specimen under test.

Figure 3.17  Power-Factor Test Set and Type C Resonating Inductor
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The Resonator, shown schematically in Figure 3.18, is contained in a metal 
housing measuring 24 x 17 x 15 inches, and weighs approximately 185 
pounds.

NOTE L adjustable from 7 to 140 Henries @60Hz.

Counter dial calibrated per calibration chart supplied with each unit.

Resonator chassis ground connected to test ground through cable shield 
or external test ground lead.

Figure 3.18  Schematic of Type C Resonating Inductor

Operating Procedure of Type C Resonating Inductor
The Resonator is connected to the M4100 Instrument by means of an 8-ft,10 
kV jumper cable. The regular 10 kV test cable is connected between the 
Resonator and the test specimen. Cable receptacles will be found in the rear of 
the Resonator case and can be used interchangeably (see Figure 3.18).

The Resonator is equipped with a core-clamping arrangement to reduce the 
noise level when the Resonator is in use, and more importantly, to minimize 
vibration. A speeder-type wrench is provided for use with this clamping 
arrangement and for use in tuning the Resonator. The clamping adjustment is 
located in the front vertical face of the Resonator while the tuning control is 
located in the top panel. Turning the clamping adjustment approximately 180° 
counterclockwise or clockwise will either unclamp or clamp the core, 
respectively.

If the equivalent 10 kV charging current of the test specimen is known, the 
Resonator may be set approximately by adjusting the tuning control until the 
counter setting corresponds to this current. Mounted on the Resonator panel is 
a reference chart relating the approximate counter reading to the specimen 
current.
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Accurate tuning of the Resonator is obtained by turning the tuning control 
until the current taken from the 120 volt supply is a minimum. To do this in 
the Clipboard test mode, follow this procedure:

1. Set the test for Line Sync Reversal (Under the LC column, select C).

2. Connect the M4000, the resonator, and the specimen as shown in 
Figure 3.17

3. Select the “System” tab from the “Tools/Configuration” menu of the 
M4000.

4. Set the M4000 to the “Manual Set Voltage” Ramp Mode.

NOTE Do not raise the test voltage beyond the allowed limit for the attached 
specimen.

5. Unclamp the Resonator Core.

6. Raise the test voltage to about 2 kV, using the Page Up (fast) or Up Arrow 
(slow) keys.

7. Observe the “input current” in the “Test Results” box.

8. Tune the Resonator until the “input current” of the M4000 is at a 
minimum.

9. To fine tune, raise the voltage to the final test voltage, or as close to it as 
possible, and repeat steps 7 and 8.

10. Reclamp the Resonator core.

11. Lower the voltage. The Resonator is tuned and you are ready to enter 
information on the row in the clipboard you are using for the test.

12. When filling in the clipboard row prior to starting the test, remember to 
select one of the “Line Sync Reversal” choices, C or F, in the LC (Line 
Configuration) column. For a description of all the Line Configuration 
choices, see “Glossary”, in the “Contents” selection of the M4000 “Help” 
menu.

13. When finished using the Resonator, you may wish to return to Tools/
Configuration and return the M4000 to its original settings of “Auto. 
Ramp Voltage” Ramp Mode in the System Configuration.

Due to the high currents involved requiring the use of the Resonator, the 120 
volt supply cord to the M4100 should be of relatively large wire gauge in order 
to minimize the line voltage drop.
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General Description of Type C-1 Coupler - RIV Test Procedure
NOTE Recommended for M2H only.

RIV (Radio-Influence Voltage) measurements may be of value in detecting 
corona on all types of insulation systems. One of the most common 
applications of RIV is with reference to rotating machinery insulation. The 
RIV Coupler in Figure 3.19 permits coupling of the radio-noise meter to the 
specimen with AC test voltage provided by the test set (refer to ANSI Guide 
C68.3- and IEEE Standard 454, “IEEE Recommended Practice for the 
Detection and Measurement of Partial Discharges (Corona) During Dielectric 
Tests”). The method usually employed detects partial discharges in the 1 MHz 
range. While some radio-noise meters use a diode-noise generator to produce 
reference signals, it is also feasible to use a radio receiver in conjunction with 
a standard signal generator. The signal generator should be capable of putting 
out a signal in the vicinity of 1 MHz, 50% modulated at 400 Hz, with a 
metered, adjustable output between 1 and 100,000 microvolts.

Figure 3.19 is a schematic of the Test Set complete with Resonator and 
coupling network (i.e., RIV Coupler) arranged for RIV (Radio-Influence 
Voltage) measurements. Note that the three components are arranged 
physically in series by means of two shielded jumper cables furnished with 
this equipment. One of the cables is connected between the M4100 Instrument 
and the Resonator. The second is connected between the Resonator and the 
RIV Coupler terminal marked “TRANSFORMER”. A standard 60-ft cable is 
used between the specimen and the RIV Coupler terminal marked 
“SPECIMEN.”

For low-capacitance specimens, when the Resonator is not used, connection is 
made directly from the M4100 Instrument to the RIV Coupler terminal 
marked “TRANSFORMER.”

Connection between the RIV Coupler and the radio-noise meter used for 
making RIV measurements is made by means of a single-circuit lead and 
telephone plug which plugs into the receptacle marked “DETECTOR” in the 
front of the Coupler. A separate common ground must be run from the M2H 
transformer case to the ground terminal of the radio-noise meter. To minimize 
shunting effects on the radio-noise meter, the capacitance between the RIV 
measuring lead and ground must be kept low. For this reason, use of a 
common two-conductor or shielded single-conductor lead is not recommended 
between the RIV Coupler and radio-noise meter.
3-28 72A-1230   Rev. F



M4000 Insulation Analyzer User Guide

Ju
ly

 2
2,

 2
00

5

Note that the circuit in Figure 3.19 is so arranged that, when the telephone 
plug is removed from the Coupler, the lower terminal of the coupling capacitor 
is connected to the test-setguard circuit. In this way, the Coupler may be left 
connected for power-factor tests. The telephone plug must be removed or the 
capacitor current and losses will be included in the measurement. Note that if 
the telephone plug (i.e., the radio-noise meter) is left connected, the Coupler 
adds only a small watts loss to the measurement being made. Despite the 
shielding, some stray capacitive currents are measured. The stray currents (at 
10 kV) may be measured with the Coupler connected for test but with no 
specimen connected. For low-capacitance specimens, this current may be 
subtracted before the power-factor calculation is made, if it is appreciable 
compared with the specimen current.

Figure 3.19  Coupling Arrangement for RIV Measurements with 10 kV Test 
Sets

The RIV Coupler is contained 
in a metal housing measuring 
9¼ x 14½ x 11½ inches, and 
weighs approximately 25 
pounds.
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NOTE When the telephone plug is not connected to the Coupling Box, the lower 
terminal of the Coupling Capacitor is connected to the Test Set Guard 
Circuit. When the telephone plug is inserted into the receptacle, the 
Guard connection to the lower terminal of the Coupling Capacitor is 
removed and ground is applied to the low end of the 600 Ohm resistor via 
the barrel of the telephone plug.
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4. M4100 Instrument Troubleshooting

Assigning A Trouble To The M4100 Instrument (Or The M4200c Con-
troller)

This section is intended to guide the operator’s initial steps in troubleshooting 
problems with the performance of the M4000 Insulation Analyzer. It outlines 
the resources available for diagnosis of problems and points to specific 
information in this chapter, or to the M4200c Controller manual. The overall 
purpose of this chapter is to support user personnel in diagnosing and fixing a 
majority of the difficulties that might be encountered in the field.

NOTE If it is clear that a problem is associated with the M4200c Controller, refer 
to the M4200c Controller manual. If it is clear that a problem is associated 
with the M4100 Instrument, continue through this chapter. If there is 
doubt as to the cause of a problem, proceed to the next page.

Doble’s Customer Service staff is always available to support its 
customers if more guidance is required.

Quick Checks
Certain problems are very common and attributable to operator error or 
mishandling. Before investigating more complex causes of observed 
problems, run through the following list to determine if a simple oversight is 
the cause of trouble:
72A-1230   Rev. F 4-1
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NOTE A majority of test set problems involve only the test leads, i.e. the High 
Voltage Test Cable and the Low Voltage Test Leads. Be especially alert to 
the condition of these items. They can be readily tested by following the 
procedures in ”Running Other Tests” on page 4-42.

Troubleshooting Resources
The operator should consult this chapter first when a problem appears. It will 
help isolate the problem to the M4200c or the M4100 and will point to the 
most appropriate resources available to resolve the problem as quickly as 
possible. There are four categories of resources available, and these are 
summarized in Table 4.2.

Table 4.1  Quick Checks: Can You Answer Yes To These Items:

Item

The communications cable is securely connected between the 
M4200c (or third-party controller) and the M4100.

Both the M4200c and M4100 are turned on and connected to an 
active, stable power source, appropriately rated and grounded.

Both safety switches were held closed during a specimen test and 
released between tests as required.

The test cables are securely connected to the specimen under test, 
and the specimen is ungrounded.

All the test leads are in good condition.

The printer is correctly loaded with paper of the proper kind.

Neither unit has been dropped recently or otherwise undergone 
rough treatment.

The floppy disk drive was empty during M4000 software boot-up.

The Num Lock and Caps Lock keys on the keyboard are switched 
off.
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Isolating Trouble
The first step in pinpointing a problem is to determine whether the problem 
lies with the M4200c (or third-party controller) or the M4100. Consult 
Table 4.3 to determine which is the malfunctioning unit and what to do next.

Table 4.2  M4000 Troubleshooting Resources
Resource Description M4100 

Reference

Symptoms The most basic troubleshooting tool is the 
observation of a symptom of trouble by the M4000 
operator. It is often the starting point for more 
detailed diagnostics.

page 4-12

Error Messages The M4000 Insulation Analyzer automatically 
recognizes certain exception conditions and 
displays corresponding error messages to the 
operator. A Help button is also available in each 
displayed message box to provide guidance on 
suggested causes and cures.

page 4-16

Diagnostics The M4000 supports automated self-diagnostic tests 
that are useful in validating system operation and 
troubleshooting problems that may occur. 
Diagnostics should be run on a regular basis to 
ensure that the M4000 Insulation Analyzer is 
functioning properly. The Diagnostics should also 
be used to investigate potential causes of error 
messages. Test results should be sent to Doble if 
Doble assistance is being requested.

page 4-21

Other Tests Certain relatively simple external and internal tests 
can be performed to characterize a problem and 
point to a specific solution. In some cases these tests 
can avoid the need for component swapping as a 
diagnostic tool.

page 4-42 
and 
page 4-50
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Avoiding Problems
The M4000 test set is rugged and can give many years of trouble-free service 
if it is handled with reasonable care. The following practices are suggested to 
minimize performance problems in the field.

Precautions It is recommended that the following precautions be followed:

• Keep the M4100 Instrument and Accessories clean and dry. Select a 
suitable storage location.

Table 4.3  Isolating the Problem
Observation Suggested Action

A numbered error message 
appears in the display.

The M4100 is likely to be at fault. See 
”Troubleshooting from Error Messages” 
on page 4-16. Also, click on Help for 
further guidance.

An un-numbered error 
message appears in the 
display.

The M4200c is likely to be at fault. See 
”Troubleshooting from Diagnostics” 
on page 4-21. Also, click on Help for 
further guidance.

The M4000 fails to 
complete the test of a 
specimen or yields unusual 
results.

The M4100 is likely to be at fault. See 
”Troubleshooting from Symptoms” 
on page 4-12.

The M4000 does not print as 
expected.

The problem lies with the M4200c. See the 
M4200c Controller manual.

A Diagnostics test has 
failed.

If the Communications Loopback Test has 
failed, the fault lies with the M4200c; see 
”Communications Loopback Test” 
on page 4-40. If any other Diagnostics test 
has failed, the M4100 is probably at fault; 
see ”Running Other Tests” on page 4-42.

Either the display or 
keyboard is nonresponsive 
or responds in an 
unexpected manner.

The M4200c is at fault. See the M4200c 
Controller manual.

The M4000 software is 
either not working or acting 
erratically.

The fault probably lies with the M4200c. 
See the M4200c Controller manual.

Any other symptom, not 
described above, is evident.

See ”Troubleshooting from Symptoms” 
on page 4-12.
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• Do not drop the instrument.
• Do not bend or coil the High Voltage Test Cable too tightly, no smaller 

than a 12-inch diameter coil.
• Do not use test leads for hoisting.
• Do not drag the High Voltage Test Cable or other leads across the 

ground, particularly if the ground surface is crushed stone.
• Do not yank at a Low Voltage Test Lead to disconnect its outboard 

clip, and do not yank any lead from its instrument connection.

Preventive 
Maintenance

The following preventive maintenance actions are suggested:

• Periodically check all screw connections for tightness.
• Examine the High Voltage Test Cable periodically and check for 

corrosion, loose screws, gouges or cuts in the outer protective jacket, 
and for signs of tracking on the inboard and outboard potheads.

• Examine the inboard connectors of the various leads and accessories 
periodically.

• Periodically examine the connectors on the instrument case.
• Visually examine the safety switches periodically for worn 

connections.
• Periodically check that the HV Pothead receptacle on the instrument 

case is clean and dry.
• Periodically run the Calibration Verification Test (page 4-26) to check 

for proper system operation.

Detailed Troubleshooting Of The M4100 Instrument
This section provides information that is useful in:

• Troubleshooting problems related to M4100 performance
• Performing specific external and internal checks to isolate the cause of 

M4100 malfunctions
• Accessing and replacing M4100 components which have failed
• Installing upgrades to certain M4100 components

NOTE To address M4000 test set performance problems, it is important to follow 
the guidelines in the previous section before making the assumption that 
the M4100 is at fault.

The major parts of this section and their purposes are summarized below:
72A-1230   Rev. F 4-5
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Section Purpose Page 
Reference

Overview of M4100 Get introduced to the M4100 
Instrument

page 4-7

Overview of 
Individual 
Replaceable 
Components

Identify all customer-replaceable 
components of the M4100

page 4-9

Troubleshooting from 
Symptoms

Obtain detailed guidance on 
troubleshooting, starting with 
observed symptoms of 
malfunction

page 4-12

Troubleshooting from 
Error Messages

Obtain detailed guidance on 
troubleshooting, starting with 
observed error messages

page 4-16

Troubleshooting from 
Diagnostics

Get help in running and 
interpreting the results of 
automated self-diagnostic tests

page 4-21

Running Other Tests Identifying additional tests that 
can be run to troubleshoot 
problems without gaining access 
to internal components

page 4-42

Accessing M4100 
Components

Learn how to remove the 
instrument’s covers and identify its 
major components

page 4-46

M4100 Internal 
Checks

Learn about internal checks that 
can be performed to diagnose 
problems without replacing 
components

page 4-50

Replacing M4100 
Components

Obtain detailed instructions on 
replacing components for the 
purpose of diagnosis or repair 
Replace:

page 4-56

Front Panel Assembly page 4-58

Guard Front Panel Board page 4-61
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Overview of M4100
The M4100 stimulates the insulation specimen under test with an AC voltage 
up to 12 kV in magnitude, an applied potential whose fundamental frequency 
is at or near the power system frequency. The instrument directly measures the 
specimen’s current and voltage to derive all reported output parameters 
relating to insulation properties, including power loss, capacitance and power 
factor. The applied AC voltage is asynchronous with the power line frequency 
so that electrostatic interference can be filtered out. The M4100 contains 
digital control, power, analog measurement and safety circuits.

An overview of the M4100 and its major components gives a good starting 
point for gaining basic functional knowledge that is helpful in effective 
troubleshooting. A block diagram of the M4100, illustrating its major 
components, appears in Figure 4.1 on page 4-8.

Amplifier Assembly page 4-63

Guard Mode Switch Board page 4-66

Timing Board page 4-68

DSP/CPU Board page 4-70

Safety Board page 4-72

Main Reference Assembly page 4-74

Guard Board page 4-76

Low Voltage Power Supply Board page 4-78

Heater/Temperature Controller 
Board

page 4-80

Field Calibration Reference page 4-82

I/O Protection Board page 4-83

Transformer page 4-85

HV Pothead page 4-91

Fan Filter page 4-93

Fan page 4-94

Section Purpose Page 
Reference
72A-1230   Rev. F 4-7
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Figure 4.1  M4100 Block Diagram
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Overview of Individual Replaceable Components
An overview of each of the instrument’s replaceable components is provided 
below. While a few other M4100 components exist, they are not 
field-replaceable.

Front Panel Assembly
03D-1056

The Front Panel Assembly includes all front 
panel-mounted components, including the 
Guard Front Panel Board and the I/O 
Protection Board. 

Guard Front Panel Board
04D-0536

The Guard Front Panel Board provides 
interconnections for the low voltage test 
leads and the Guard Mode Switch Board.

Amplifier Assembly
03D-1055-01

The Amplifier Assembly converts the AC 
input signal – whether synchronous with the 
power system frequency or derived from a 
crystal oscillator – to AC test stimulus 
power. It drives a 10 kV step-up transformer 
through safety relay contacts.

Guard Mode Switch Board
04D-0551

The Guard Mode Switch Board consists of 
an array of semiconductor (FET) switches 
that routes the measured specimen and 
reference currents to the Guard Board, in 
accordance with the desired test mode.

Timing Board
04D-0533

The Timing Board serves two main 
purposes. First, it provides a high speed 
clock for A/D conversion. The clock is 
either synchronized to a selected test 
frequency, generally between 40 and 70 Hz, 
or synchronized to the line frequency. 
Second, this board provides a frequency 
counter used to measure the test frequency.

DSP/CPU Board
04D-0520

The DSP/CPU Board serves as the M4100 
system controller and as a digital signal 
processor for high speed algorithmic 
processing of analog signals.
72A-1230   Rev. F 4-9
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Safety Board
04D-0544

The Safety Board latches off the Amplifier 
Assembly and opens the safety relays when 
a potential operator safety hazard or 
hardware overload is detected. It also 
reports safety status and receives safety 
commands from the DSP/CPU Board.

Main Reference Assembly
04D-0583

The Main Reference Assembly stores 
calibration standard values used in 
comparing the measured specimen power 
factor and capacitance values.

Guard Board
04D-0527

The Guard Board provides signal 
conditioning of the specimen and reference 
currents for A/D conversion. Its functions 
include shunt selection, signal scaling, 
anti-alias filtering and A/D conversion. The 
optimum current range is selected 
automatically unless the operator manually 
specifies a range.

Low Voltage Power Supply 
Board
384-0138

The Low Voltage Power Supply Board 
supplies +5 VDC, –5 VDC, +15 VDC and 
–15 VDC for internal use throughout the 
M4100 Instrument.

Heater/Temperature 
Controller Board
04D-0547

The Heater/Temperature Controller Board 
senses the internal temperature and controls 
the fan.

Field Calibration Reference 
(Optional)
04D-0524

The Field Calibration Reference provides a 
means for checking calibration of the 
M4100 in the field using pre-calibrated, 
precision resistors. It can also be used as an 
external reference for other types of 
measurements, such as transformer 
short-circuit impedance tests and turns-ratio 
tests.
4-10 72A-1230   Rev. F
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I/O Protection Board
04D-0546

The I/O Protection Board provides serial 
communications between the M4100 and 
M4200c and interfaces with the safety 
strobe light, temperature/humidity sensors 
and safety switch. It also provides certain 
safety features under hardware and software 
control.

Transformer
03D-1054

The Transformer steps up the voltage output 
of the Amplifier Assembly to a maximum of 
12 kV for application to the specimen under 
test.

HV Pothead
03C-0056-07

The front panel-mounted HV Pothead is a 
connector providing a high-voltage 
connection to the specimen under test.

Fan
380-0042

The fan cools the interior of the M4100 by 
moving air through the instrument when 
necessary. It is normally not on.
72A-1230   Rev. F 4-11
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Troubleshooting from Symptoms
This section provides M4100 troubleshooting guidance based upon observed 
malfunction symptoms. Find the observed symptom in Table 4.4, and take the 
suggested action(s) to solve the problem.

Table 4.4  M4100 Troubleshooting from Symptoms

Symptom Suggested Action

M4100 does not power up 
properly

In a normal power-up sequence:
• Front panel Power indicator comes 

on and stays on.
• Front panel Processor indicator 

flashes about once per second until 
M4200c communications is 
established, then comes on and stays 
on.

• Front panel Heater indicator remains 
off.

If power-up is abnormal:
1. Check F1, a 4-A fuse, as described in 

”LVPS Fuses” on page 4-52.

2. Check fuses F1 and F2 on the 
Heater/Temperature Controller Board as 
shown in Figure 4.41 on page 4-80.

3. Check the power supply voltages as 
described in ”Low-Voltage Power 
Checkout” on page 4-51.
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Cannot begin a test; the test 
set trips, with an overcurrent 
error message

1. Isolate the cause by restarting a test after 
alternately:

• Disconnecting the High Voltage Test 
Cable from the M4100

• Disconnecting the High Voltage Test 
Cable from the specimen (but still 
connected to the M4100)

If the symptom disappears, test the cable 
by referring to ”Checking the High 
Voltage Test Cable” on page 4-42. 
Replace the High Voltage Test Cable if 
necessary.

2. Check connections to the specimen.

3. The size of the specimen may be beyond 
the capacity of the test set, or the point 
to which the High Voltage Test Cable is 
connected may be grounded.

4. Check the HV Pothead for tracking, 
arcing, pothead separation and 
cleanliness. If it is faulty, replace it.

Table 4.4  M4100 Troubleshooting from Symptoms (Continued)

Symptom Suggested Action

DANGER Avoid personal contact with 
the High Voltage Test Cable 
while it is connected to the 
M4100. Death or severe 
injury is an imminent risk.
72A-1230   Rev. F 4-13
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Instrument takes an 
unusually long time to make 
a measurement or never 
stops ranging

1. Check and clean connections to the 
specimen. Use a clip lead between the 
High Voltage Test Cable and specimen 
to insure good contact.

2. Check the High Voltage Test Cable by 
referring to ”Checking the High Voltage 
Test Cable” on page 4-42. Then check 
the HV Pothead. If either component is 
faulty, replace it.

3. Check for an unstable AC power source 
or a faulty power cable.

Reported Current, Watts, 
and/or % Power Factor are 
zero

1. Check cable and ground connections.

2. Insignificant values (% Power Factor 
between 0 and –0.04%, Watts < 10 µW, 
and Current < 0.1 µA) are rounded to 
zero. These results can occur when 
measuring across a vacuum or SF6 
interrupter, or when testing a good oil 
sample using the UST circuit.

Tests made using GST 
circuits yield high, negative, 
or unstable readings

1. Check for a guard-to-ground short as 
described in ”Checking M4100 
Guard-to-Ground Insulation” 
on page 4-43. If a short is detected, see 
”Guard-to-Ground Shorting Problems” 
on page 4-51.

2. See ”Orange Cable Checkout” 
on page 4-54.

Table 4.4  M4100 Troubleshooting from Symptoms (Continued)

Symptom Suggested Action
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Negative watts obtained in 
UST or GST-Guard circuit

This may simply be due to surface dirt and 
moisture. Clean and dry the specimen’s 
surface and retest it. This condition is most 
often found when testing bushing C1 
insulation, transformer Ch1 insulation, or 
rotating machinery interwinding insulation. 
In the case of a bushing, the offending 
surface may be that on the lower part of the 
bushing inside its parent apparatus, or on the 
inside surface of the shell. See the paper in 
1987 Doble Minutes on negative watts, page 
2-501.

Communications error 
message

If any of a variety of 
communications-related error messages (see 
Appendix C) is displayed, take the 
following steps in sequence until the cause 
of the problem is identified:
1. Run the Communications Loopback 

Test described in ”Communications 
Loopback Test” on page 4-40.

2. Check the communications cable 
(between the M4100 and M4200c) for 
bent connector pins and breaks or frayed 
areas in the cable jacket. Replace the 
cable if necessary (see item 5 of 
”Accessory Bag” on page A-2).

3. Check the M4100 power supply 
voltages as described in ”Low-Voltage 
Power Checkout” on page 4-51. 
Replace the Low Voltage Power Supply 
Board if necessary.

4. If no other cause is determined, replace 
the I/O Protection Board in the M4100 
(see ”Replacing the I/O Protection 
Board” on page 4-83).

Table 4.4  M4100 Troubleshooting from Symptoms (Continued)

Symptom Suggested Action
72A-1230   Rev. F 4-15



Avoiding Problems
Ju

ly
 2

2,
 2

00
5

Troubleshooting from Error Messages
The M4000 Insulation Analyzer automatically recognizes certain exception 
conditions and displays corresponding error messages to the operator. Most 
error messages that pertain to the M4100 are numbered. These are described 
below.

NOTE A complete list of all M4000 error messages appears in Appendix C.

A few messages that point to very simple problems can be displayed, such as 
not having the M4100 turned on, not having it connected to the M4200c (or 
your laptop), or attempting to energize a specimen that is at ground potential. 
Other, less obvious messages are addressed below.

Error messages are listed in numerical order, followed by one or more 
suggested actions to take in response to the message. A Help button is also 
available in each displayed message box to provide guidance on suggested 
causes and cures.]
Table 4.5  Error Messages

# Error Message Suggested Action

20 Watchdog Reset 
Error

1. After installing new software and when 
performing the first test thereafter, an 
interruption in firmware download may 
have occurred (i.e. the test set was 
turned off while the message, 
“Downloading Firmware” was 
displayed. See ”M4000 Software” 
on page 2-1).

2. If performing an excitation current test, 
repeat the test at a lower voltage.

3. If testing with a portable power supply, 
stabilize the supply by preloading it with 
a space heater or similar load.

4. Reload the old version of software, then 
the new version again (see ”M4000 
Software” on page 2-1).

28 Earth Ground 
Open

1. Connect the M4000 to ground.

2. Connect the M4000 ground to the same 
ground as the system’s AC power 
source.
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33 One or both safety 
switch cables 
disconnected

1. Clean all cable terminations.

2. If the problem persists, replace the I/O 
Protection Board (see”Replacing the I/O 
Protection Board” on page 4-83)

34 1. Check the AC power source for 
abnormally low voltage.

2. If this message was reported when 
running a specimen test, run 
”Subsystem Diagnostics” on page 4-34.

3. If the problem is still unresolved, 
replace the Amplifier Assembly and 
rerun its diagnostic. Rerun the original 
specimen test at rated voltage 
(see”Replacing the Amplifier 
Assembly” on page 4-63).

35 Overcurrent on 
Power Amp Output

The instrument’s output current limit has 
been exceeded.
1. Repeat the test at a lower voltage.

2. Check all test connections.

3. Check for an inadvertently grounded 
specimen.

36 Power Amp DC 
Supply High

Check the AC power source for abnormally 
high voltage.

37 Power Amp DC 
Supply Low

1. Check the AC power source for 
abnormally low voltage.

2. Try a heavier gauge or shorter AC line 
cord to the M4100.

3. Replace the Amplifier Assembly (see 
”Replacing the Amplifier Assembly” 
on page 4-63).

Table 4.5  Error Messages (Continued)

# Error Message Suggested Action
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39 Phase Lock Loop 
Not Locked

1. If a portable generator is being used to 
power the M4000, stabilize its output 
frequency by adding a load, such as a 
space heater, to load the generator.

2. If the symptom occurs in line sync mode 
only, replace the Amplifier Assembly. If 
it occurs in both state modes, reseat the 
W8 cable connectors between the Guard 
Board and Guard Mode Switch Board 
(see Figure 4.26 on page 4-53). Replace 
the Guard Board and Guard Mode 
Switch Board, one at a time, if reseating 
the cable connectors does not help.

41 Strobe Not 
Flashing

Replace the strobe lamp. If the fixture needs 
replacing, temporarily operate the 
instrument without a strobe:
1. Select Instrument from the 

Tools/Configuration menu in the 
M4000 software.

2. Disable the strobe requirement.

50 Lead Changed 
During Test

1. Clean all cable terminations.

2. If the problem persists, replace the 
Guard Front Panel Board (see 
”Replacing the Guard Front Panel 
Board” on page 4-61).

51 Safety Switches 
Not Released 
Between Tests

This is intended as a safety feature. When a 
test or a “multiple test” has been run, the 
safety switches must be released before 
starting the next test or “multiple test”. Do 
not press the safety switches until the final 
pre-test warning screen is displayed. 
Otherwise the next test cannot be run.

Table 4.5  Error Messages (Continued)

# Error Message Suggested Action
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53 One or Both Low 
Voltage Leads 
Disconnected

1. If this error is displayed during 
Calibration Verification, rerun the test at 
a temperature above freezing.

2. Clean all cable terminations.

3. If the problem persists, replace the 
Guard Front Panel Board (see 
”Replacing the Guard Front Panel 
Board” on page 4-61).

54 Overcurrent 
Occurred

Input current is excessive.
1. Try a 240 V AC power source instead of 

a 120 V source.

2. Check the HV Pothead guide for 
internal separation or tracking.

56 Input Current Peak 
Maximum 
Exceeded

Input current is excessive.
1. Try a 240 V AC power source instead of 

a 120 V source.

2. Check the HV Pothead guide for 
internal separation or tracking.

57 Transformer 
Overtemperature 
Occurred

Wait several minutes and repeat the test, 
leaving the test set on until the fan turns on 
to cool it. If the fan does not eventually turn 
on, see ”Fan Operation” on page 4-50.

63 Voltage Input 
Saturated

Replace the Guard Board (see ”Replacing 
the Guard Board” on page 4-76).

64 Requested 
Maximum Voltage 
Exceeded

Replace the Guard Board (see ”Replacing 
the Guard Board” on page 4-76).

Table 4.5  Error Messages (Continued)

# Error Message Suggested Action
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133

137

No Response from 
M4000, Check 
Connections
&
Invalid Message 
Number

1. Make sure the M4100 is turned on.

2. For All Error Numbers in the 130’s: If 
the error appears during a test, there 
may be another application running on 
your computer which is interfering with 
communication to the M4100. Contact 
Doble for analysis and solution to this 
problem. To begin with, remove all but 
the M4000 program from your startup 
menu.

3. If you are using a laptop PC in place of 
the M4200c, select “Configuration” 
from the “Tools” menu, click the 
“Instrument” tab, and select “Com1” for 
Serial Port, save and exit. 

4. If using a USB to Serial adapter, make 
sure the software driver has been 
installed.

5. Run the Communications Loopback 
Test as described in ”Communications 
Loopback Test” on page 4-40.

6. Check the voltage between either safety 
switch’s Pin 3 (third from left) and the 
chassis. If less than 4.9 V, reseat both 
ends of the W46 cable (see ”W46 Cable 
Checkout” on page 4-55).

7. Check the operation of the Low Voltage 
Power Supply Board by following the 
procedure given in ”Low-Voltage Power 
Checkout” on page 4-51.

Table 4.5  Error Messages (Continued)

# Error Message Suggested Action
4-20 72A-1230   Rev. F



M4000 Insulation Analyzer User Guide

Ju
ly

 2
2,

 2
00

5

Troubleshooting from Diagnostics
The M4000 test set supports automated diagnostic tests that are useful in 
validating system operation and troubleshooting problems that may occur. 
Diagnostics should be run on a regular basis to ensure that the M4000 
Insulation Analyzer is functioning properly. The Diagnostics should also be 
used to investigate potential causes of error messages.

Running Diagnostics
Diagnostics can be accessed from the Diagnostics pull-down menu. Access 
the menu by clicking on Diagnostics in the menu bar, as shown in Figure 4.2. 
The following seven tests are available:

NOTE The M4150 and M4151 Calibration References are optional, and the 
Calibration Verification and Field Recalibration diagnostic tests cannot 
be run if they are unavailable. Furthermore, certain remedial procedures 
described in the System Status section cannot be completed without them.

• System Status (page 4-23)
• Calibration Verification(page 4-26)
• Field Recalibration (page 4-31)
• Subsystem Diagnostics (page 4-34)
• M4100 Component List (page 4-38)
• Thermal Profile (page 4-39)
• Communications Loopback Test (page 4-40)

Figure 4.2  Diagnostics Pull-Down Menu
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The first six of these tests are applicable to the M4100; the last one is not. Use 
of the Communications Loopback Test is described in ”Communications 
Loopback Test” on page 4-40.

Follow these recommendations in deciding when to run each test:

* When contacting Doble by telephone or e-mail 
(customerservice@doble.com), it will be helpful to have the results from these 
two tests, including the contents of the Calver.log file, located in the DTA 
directory. 

Diagnostic Test Run the test when suggested by a 
displayed message, when indicated in a 
troubleshooting flow chart or table, or:

System Status * Run this test if you are experiencing any 
malfunction or error.

Calibration Verification* 1. Run this test periodically to run a mock 
specimen measurement, which checks 
all system connections, including high 
and low voltage cables.

2. Run this test after replacing a 
component or otherwise repairing the 
M4100.

Field Recalibration Run to calibrate the test set when one of the 
calibration verification tests results in a Fail 
or Re-cal rating. 

Subsystem Diagnostics Run this test to exercise specific M4100 
components.

M4100 Component List Run this test to obtain a list of recognized 
M4100 components and their revision 
numbers.

Thermal Profile Run this test if the M4100 appears to be 
overheating or if an over-temperature 
indication appears.

Communication Loopback 
Test

Run to check communications between the 
M4200c Controller (or laptop) and the 
M4100 Instrument.
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Once the operator specifies a particular diagnostic test to run, the following 
function keys are available for use:

F1 Display Help contents

F2 Run the selected diagnostic

Following are descriptions of each of the five Diagnostics tests that are 
applicable to the M4100.

System Status
NOTE Do not run this test when the temperature is below freezing.

The System Status diagnostic determines and reports the calibration status of 
the Guard Board, Main Reference Assembly, Field Calibration Reference and 
Backplane. It also performs a checksum test of the Guard Mode Switch 
Board’s ID PROM.

To run the System Status diagnostic:

1. Select System Status from the Diagnostics pull-down menu.

2. Press F2 to start the test.

A display like that shown in Figure 4.3 appears when the test is complete. 
The results can be printed or saved as a file using options in the File 
pull-down menu.
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Figure 4.3  System Status Test Results

This test is passed when every item’s status is reported as Enabled. Any other 
result has the following implications:

Guard Status 
Disabled

Critical: This condition must be corrected before testing 
continues.

Corrective Procedure: Replace the Guard Board and run the Field 
Recalibration Test. 

The consequences of continued testing in the uncorrected state are:

• Calibration Verification cannot be performed
• Measurement error uncertainty (2% Capacitance relative and 0.1% 

Power Factor absolute)
• Guard failure in Subsystem Diagnostics

Main Reference 
Status Disabled

Critical: This condition must be corrected before testing 
continues.

Corrective Procedure: Replace the Main Reference Assembly and run the 
Field Recalibration Test.

The consequences of continued testing in the uncorrected state are:

• Calibration Verification cannot be performed
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• Measurement error uncertainty (1% Capacitance relative and 0.15% 
Power Factor absolute)

• Retest failure in Subsystem Diagnostics

Field Reference 
Status Disabled

Non-critical: This condition must be corrected before Calibration 
Verification can be performed.

Corrective Procedure: Replace the Field Calibration Reference. 

The consequences of continued testing in the uncorrected state are:

• Calibration Verification cannot be performed
• Calibration Reference (Calref) failure in Subsystem Diagnostics

Factory Status 
Disabled

Non-critical: This condition may be caused by any of the following: 

1. A calibration dependent assembly has been changed.**

Corrective procedure: Run the Calibration Verification. 

2. Guard Mode Switch IDPROM checksum test failed.

Corrective procedure: Replace the Guard Mode Switch Board and run the 
Calibration Verification.* 

3. Either the Guard status or Main Reference status is disabled.

Corrective procedure: Refer to the foregoing results and run the Calibration 
Verification.

* It may be possible to correct an ID PROM checksum failure without 
replacing the Guard Mode Switch Board; call Doble.

** Calibration dependent assemblies are:

• - Guard Board
• - Main Reference Assembly
• - Guard Modeswitch Board
• - System BackPlane

The Consequences of continued testing in this state are:

- Calibration Verification Test can be performed if the cause is due to 
changed assembly

- Subsystem Diagnostics will fail bptest Test

- Measurement error uncertainty (.25% Capacitance relative and .04% 
Power Factor absolute.)
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If none of the above applies and all statuses are ENABLED the problem is 
likely to be the inability to successfully complete a Calibration 
Verification test. Run the diagnostic and the results should indicate the 
problem.

NOTE If the corrective procedures described do not fix the System Status error 
then Call Doble.

Calibration Verification
NOTE For a simple check of the M4000 Insulation Analyzer's measurement 

system, test the empty Doble Liquid Insulation Cell, energized at 5 kV. 
See ”Checking Instrument Accuracy in the Field” on page 4-43.

A more comprehensive check can easily be performed in the form of the 
Calibration Verification. It is suggested that a Calibration Verification be 
performed (providing the optional M4150 or M4151 Calibration Reference is 
available):

• Upon receipt of an M4000 Insulation Analyzer from Doble or from 
another location within your company

• At monthly intervals
• When questionable readings are obtained

The Calibration Verification provides the quickest assurance that the 
measurement system and the test leads are working correctly. It exercises the 
red and blue resistors, the guard connection of the high voltage lead, and tests 
GST internal loss.

NOTE Do not run this test when the temperature is below freezing.

Prior to performing a Calibration Verification, run the System Status 
diagnostic (page 4-23) to ensure that all system variables are enabled.

The figures in the example below reflect the use of the M4150 Calibration 
Reference.

To perform the Calibration Verification:

1. Select Calibration Verification from the Diagnostics pull-down menu.

The screen shown in Figure 4.4 appears.
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Figure 4.4  Calibration Verification Initial Screen

2. Press F2.

3. Follow the on-screen directions, as shown in Figure 4.5.

Figure 4.5  Calibration Verification Instructions

Connections for the Calibration Verification are shown in Figure 4.6 and 
Figure 4.7. The Field Adapter cable, shown in these figures, is an 
accessory cable found in the cable bag which connects from the High 
Voltage Test Cable to the black connectors on the Field Calibration 
Reference.
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Figure 4.6  Setup for Blue Resistor Test

Figure 4.7  Setup for Red Resistor Test

There is a test abort criterion described in the first test of each setup. The 
test abort allows the operator to correct a setup error and then restart from 
the point where the error was first detected, without losing successfully 
completed test information.
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At the conclusion of the Calibration Verification, a summary table like that 
shown in Figure 4.8 will be displayed.

Figure 4.8  Calibration Verification Results

The summary table can be printed or saved as a text file. Both options are 
available on the File pull-down menu.

Calver.log File Upon completion of the Calibration Verification, the M4000 software creates 
a file named Calver.log and stores it in the DTA directory. This file 
summarizes information on test aborts and test failures. An example of such a 
file is shown in Figure 4.9.
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Test Date: 06/29/95
Test Time: 10:14:45
System Serial Number = 59400175
Test Fail: 3mA SinTheta = -0.045979%
Final Error Code = 00-00-0-04H
End of Test

Test Date: 04/03/96
Test Time: 14:33:16
System Serial Number = 59400175
Final Error Code = 00-00-00-00H
End of Test

Test Date: 04/26/96
Test Time: 10:48:42
System Serial Number = 59400175
Test Abort: Error #53
Test Not Running -
One or Both Low Voltage Leads Disconnected
Final Error Code = 00-00-00-00H
End of Test

Test Date: 04/26/96
Test Time: 10:50:43
System Serial Number = 59400175
Test Abort: Error #53
Test Not Running -
One or Both Low Voltage Leads Disconnected
Final Error Code = 00-00-00-00H
End of Test

Figure 4.9  Example of Calver.log File Contents

Additional data are continually added to the file by each subsequent 
Calibration Verification. The print option, if selected at the end of a test, prints 
only results from the test just completed.

 When a failure is encountered, Doble can provide troubleshooting guidance if 
needed. A copy of the Calver.log file, found in the DTA directory, is essential.
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Field Recalibration
Run this test if any of the Calibration Verification test ratings are Re-Cal or 
Fail. With the M4100 Field Calibration feature, calibration can be done in the 
field for 7 of the current ranges if the optional M4151 Field Calibration 
Reference is used, and for 3 ranges if the optional M4150 Field Calibration 
Reference is used. The optional Field calibration Reference, if available, is 
located on the face of the M4100 Instrument. Test result information may be 
found in the fieldcal.log and currfcal.log files, both found in the DTA 
directory.

The Optional M4150 
Field Calibration 
Reference

Figure 4.10  M4150 Field Calibration Reference

This is the reference box that has been used since the inception of the M4000.  
Using the M4150, the M4000 software performs a reference test on the test set 
for the three middle current ranges (10, 30, and 100 mA).  The M4100 
calibration can be checked, and, if necessary, adjusted.  Except for special 
certification requirements, usually reserved for testing at Nuclear Power 
Plants, the reference check and calibration made possible by the M4150 
should be more than adequate to assure accurate data.

The Optional M4151 
Field Calibration 
Reference

Figure 4.11  M4151 Field Calibration Reference
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For situations demanding more complete calibration, Doble offers the M4151 
Field Calibration Reference. Using this option, seven current ranges can be 
checked and calibrated (leaving only the three high current ranges used with a 
resonator unchecked). The seven ranges tested by the M4151 are 300 µA, 1 
mA, 3 mA, 10 mA, 30 mA, 100 mA, and 300 mA. These three high current 
ranges not tested require both a resonator and an external capacitor for 
checking and field calibration, and are not available.

To perform a Field Recalibration test:

1. Select Field Recalibration from the Diagnostics pull-down menu.

The screen shown in Figure 4.12 appears.

Figure 4.12  Field Recalibration Main Screen

2. Press F2

3. Follow the on-screen directions, as shown in Figure 4.13.
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Figure 4.13  Field Recalibration Instructions

The Field Adapter cable is an accessory cable which connects from the High 
Voltage Test Cable to the black connectors on the Field Calibration Reference.

There is a test abort criterion described in the first test of each setup. The test 
abort allows the operator to correct a setup error and then restart from the point 
where the error was first detected, without losing successfully completed test 
information.

At the conclusion of the Field Recalibration, a summary table like that shown 
in Figure 4.14 will be displayed.

Figure 4.14  Field Calibration Results
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The summary table can be printed or saved as a text file. Both options are 
available on the File pull-down menu.

Fieldcal.log File Upon completion of the Field Recalibration, the M4000 software creates a file 
named Fieldcal.log and stores it in the DTA directory. This file summarizes 
information on test aborts and test failures.

Subsystem Diagnostics
Subsystem Diagnostics checks numerous M4100 components. It first verifies 
proper communications between the M4200c Controller and the M4100 
Instrument, then runs tests on the following M4100 components:

DSP/CPU Board

Backplane

Low Voltage Power Supply Board

Heater/Temperature Controller Board

Timing Board

Safety Board

Amplifier Assembly

Guard Board

Guard Mode Switch Board

Main Reference Assembly

Field Calibration Reference

To perform these diagnostics:

1. Select Subsystem Diagnostics from the Diagnostics pull-down menu.

2. Press F2 to start the process, which takes several minutes.

When all the tests are completed, the result (PASSED or FAILED) for each 
M4100 Component is reported, as in Figure 4.15.
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Figure 4.15  Subsystem Diagnostics Results

Results can be printed either in brief or in full. To print the test results:

3. Select Print from the File menu.

The screen shown in Figure 4.16 appears, allowing a choice of the level of 
detail to be printed.
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Figure 4.16  Print Detail

A Brief Report contains the text that is displayed on the results screen. If 
Detailed Report is selected, all the fields shown above become active, 
allowing the operator to select which specific components’ test results to 
print. In the example above, since the Safety Board diagnostic failed, that 
result is selected for a full printout.

The printed test result resulting from a typical choice is provided in 
Figure 4.17. Such a printout is useful if the operator finds it necessary to 
consult Doble for assistance.
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Figure 4.17  Component Test Result, Subsystem Diagnostics
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M4100 Component List
The M4100 Component List provides a listing of recognized system 
components, which is helpful in diagnosing certain problems. The listing 
characterizes each component as to its identity and calibration history.

To generate this list:

1. Select M4100 Component List from the Diagnostics pull-down menu.

2. Press F2.

 Figure 4.18 shows an example of the resulting list.

Figure 4.18  M4100 Component List Results

This summary can be printed or saved to a file via the File menu.
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Thermal Profile
The Thermal Profile diagnostic displays internal and external temperatures 
measured by the M4100.

NOTE To monitor external parameters the Remote Sensor must be connected to 
the M4100.

To run a Thermal Profile:

1. Select Thermal Profile from the Diagnostics pull-down menu.

2. Press F2.

As the profile is running, continuously updated temperature and humidity 
values are displayed on the screen, as exemplified in Figure 4.19.

Figure 4.19  Thermal Profile Results

3. Stop the monitoring by pressing F4 or ESC.

Once the update process is stopped, results can be printed or saved to a file via 
the File menu.
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Communications Loopback Test
The Communications Loopback Test is run to assure that proper 
communications exist between the M4200c and M4100. It should be run 
whenever a communications error occurs.

This test verifies the serial link between the M4200c and the M4100 using two 
external Burndy connector pieces (male and female types) included in the 
Accessories Bag. If these connectors cannot be located, contact Doble (see 
items 29 & 30, page A-3).

The Communications Loopback Test is run by selecting that option 
(Figure 4.20) from the Diagnostics pull-down menu and following the 
on-screen instructions.

Figure 4.20  Running the Communications Loopback Test

The M4000 Software prompts the operator to perform the same test twice, 
with and without the communications cable in place. If both tests pass and a 
communications problem still exists, the M4100 LVPS is probably at fault.

Proceed as follows:

1. Follow the directions provided in Figure 4.20, i.e., remove the 
communications cable from the M4200c and replace it with the test plug. 
Then press F2 to start the test.

A screen like that shown in Figure 4.21 will appear when the first test is 
complete. In this example the first loopback test passed.
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Figure 4.21  Communications Loopback Test, First Result

2. Follow the directions provided in Figure 4.21, i.e., remove the test plug 
and connect the communications cable in its place, then attach the other 
test plug to the far end of the cable. Press OK to continue.

A screen like that shown in Figure 4.22 will appear when the second test is 
complete. In this example both loopback tests passed.

Figure 4.22  Communications Loopback Test, Final Results
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Running Other Tests
Certain additional tests can be run without gaining access to the M4100 
interior. Any of the following tests can and should be run based upon an 
indicated error message, symptom or diagnostic test result.

Checking the High Voltage Test Cable
Most of the difficulties encountered with the High Voltage Test Cable are of a 
mechanical nature, external, and easily identified. The following resistance 
measurements are helpful in locating internal defects that cause erratic or 
otherwise abnormal test results.

NOTE The High Voltage Test Cable must be isolated for the following 
measurements. Disconnect it from the M4100 and the specimen.

Continuity The end-to-end resistance of each cable conductor (i.e. the center conductor, 
guard shield and ground shield), measured with a low-voltage ohmmeter, 
should be less than 1 ohm. If any conductor’s resistance is greater, replace the 
High Voltage Test Cable.

DC Insulation 
Resistance

The DC resistance of insulation between cable circuits (i.e. center conductor to 
guard shield and guard shield to ground shield), measured with a low-voltage 
instrument (500 V or less) at either end of the cable should be 100 megohms or 
greater. If any insulation resistance is less, replace the High Voltage Test 
Cable.

Checking the Low Voltage Test Leads
The Low Voltage Test Leads are both single-conductor shielded cords 
terminated by a clip on one end and a locking plug on the other. Note that Pins 
1 and 2 of the inboard connector are short-circuited to each other and 
connected to the lead shield. Pin 3 is connected to the center conductor of the 
lead to which a clip is attached at the outboard end.

NOTE The Low Voltage Test Leads both must be isolated from the M4100 for 
the following measurements. Both leads should be tested.
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Continuity The center conductor and shield should each have less than 1-ohm resistance.

The center conductor’s resistance is measured between the clip and Pin 3 of 
the inboard connector. In order to check the shield, penetrate the outer 
insulation of the lead (approximately 1-2 inches from the outboard clip) using 
a thin/sharp pointed electrode (pointed ohmmeter probes are suitable for this 
purpose). The shield resistance is measured between Pins 1 or 2 of the inboard 
connector and the ohmmeter probe penetrating the insulation.

If either conductor’s resistance is greater than 1 ohm, replace that Low Voltage 
Test Lead.

DC Insulation 
Resistance 

The DC insulation resistance of a lead, measured with a low-voltage 
instrument, between the center conductor and shield should be 100 megohms 
or greater. This measurement is made by connecting one probe of the DC 
instrument to the clip at the lead’s outboard end, and the other probe 
connected to the shield (Pins 1 and 2 of the lead’s inboard connector).

If abnormally low insulation resistance is observed, the condition of the 
insulation between the center conductor and shield at the clip end of the lead 
should be checked.

If any insulation resistance is less than 100 megohms, replace that Low 
Voltage Test Lead.

Checking M4100 Guard-to-Ground Insulation
The DC insulation resistance between the Guard and Ground circuits of the 
M4100 should be in the range 2.5-4 megohms. The measurement is made 
between the blue and silver terminal posts on the front panel, with the M4100 
turned off and the AC power cord removed. A low-resistance path between 
these points is a frequent cause of large negative values of GST watts, 
especially when running the Field Recalibration Test diagnostic.

If a short or low resistance is detected between these points on the front panel, 
perform the internal checks described in ”Guard-to-Ground Shorting 
Problems” on page 4-51.

NOTE The short circuit may be intermittent, so it may be necessary to move or 
shake the instrument in order to stimulate the short.

Checking Instrument Accuracy in the Field
In lieu of elaborate laboratory checks, it has been found that the Doble Liquid 
Insulation Cell, properly cleaned and dried, is a reliable standard that can be 
used in the field for a quick, simple accuracy check.
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The characteristic charging current (capacitance) and watts-loss of the Liquid 
Insulation Cell should be measured whenever a new instrument or cell is 
received, and the test data should be recorded for future reference. The test 
connections and procedure are the same as for testing a liquid-insulation 
sample, except that the test is conducted in both the UST and GST modes. The 
cell should be clean and dry, and a stable voltage source should be utilized.

Typically, a clean and dry Liquid Insulation Cell check produces results 
approximately as follows by the UST method:

NOTE In the absence of insulating liquid, the dielectric-breakdown strength of 
the Liquid Insulation Cell is significantly reduced. Due to the relatively 
close spacing of the cell plates, an internal flashover will likely occur 
around 7 or 8 kV when the cell is dry.

The charging current measured is a function of the geometric dimensions of 
the cell and, therefore, some variation may occur between different cells; 
however, the current reading should be repeatable when using the same cell, 
properly assembled with electrode spacings unchanged. The measured current 
and watts-loss will be slightly higher when the calibration is checked by the 
GST method owing to stray capacitive coupling to ground.

Voltage Verification
The factory performs voltage accuracy tests at 5kV using a high voltage RMS 
voltmeter (Valhalla, model 4600). The following procedure is a similar 
voltage verification test performed at a reduced voltage (500 Volts).

Additional 
Instrumentation 
Required:

Digital Voltmeter (DVM) with a minimum input capability of 750 VRMS and 
an accuracy of +/- 0.5% on the AC Volt scale. The following models are 
acceptable for doing a reduced voltage measurement test in the field; Fluke 
models 8060A, 8025A, Fluke 85, Fluke 25, Fluke 27 or equivalent.

Test Setup: • Test set must be grounded and the High Voltage Lead connected. 
Confirm the center conductor of the High voltage Cable is isolated 
from ground.

• Connect the DVM from the High Voltage Lead center conductor to the 
Guard circuit (blue terminal on the front panel of the M4100 
instrument).

Test Voltage Current Capacitance Watts-Loss

5 kV 400 microamperes 106 pF +0.0020
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• Select the Clipboard mode to perform the test and configure a test with 
the potential of 500V. The test must be performed in Manual mode, 
and any test circuit will do.

• Raise the test voltage to 500V and record the DVM reading on the 
Calibration Verification Certificate.

The setup for the test is shown in the following diagram:
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Accessing M4100 Components
DANGER Ensure that the AC power cable is disconnected prior to removing any of 

the M4100 covers. To avoid static discharge, ground yourself and the test 
set before handling any circuit boards.

The following procedures require access to internal M4100 components:

• Performing internal checks
• Replacing internal components for purposes of diagnosis and repair
• Upgrading components

This section provides guidance in accessing M4100 internal components and 
identifying those components and their interconnections. Subsequent 
replacement procedures are detailed in ”Replacing M4100 Components” 
on page 4-56.

Access to all internal M4100 components requires removal of the instrument’s 
front and top covers. Access to certain components, notably many of the 
instrument’s PC boards, also requires removal of the card cage cover. 
Instructions for both actions are provided below.

DANGER Always disconnect AC power before gaining access to internal M4100 
components. If re-application of power is necessary to perform an 
internal check, follow the procedural instructions carefully to minimize 
the risk of electrical shock. In particular, make certain that only 
voltmeter probes come in contact with internal test points. Furthermore, 
the High Voltage Test Cable and Safety Switch extension must always be 
disconnected from the Transformer case during internal measurement 
and inspection.

Removing the Front and Top Covers
The front and top covers must be removed to gain access to internal 
components. Keep screws that are removed together in a safe location for 
re-assembly.

Take the following steps to remove the covers:

1. With the power cable disconnected, snap off the front cover. To do so, 
stand facing the unit and grip the edges of the front cover panel with both 
hands while pulling towards you. Then, turn the unit around so that the 
black rubber feet are facing you.

2. Use a flat-blade screwdriver to remove the top two rubber feet.

3. Lift the top cover up and towards the rear. Then, turn the unit around again 
so that the front panel is facing the operator.
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The resulting top view of the instrument is as shown in Figure 4.23.

Figure 4.23  M4100 Interior View 

Transformer
Cover

ground)

Amplifier Assembly
(chassis ground)

Transformer
(connected
to guard)

(chassis

Main Reference Assembly
(connected to guard)

Card
Cage

Low Voltage Power Supply Board
(under corner brace)
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Removing the Card Cage Cover
The card cage cover must be removed to gain access to any of the following 
components:

• DSP/CPU Board
• Guard Board
• Guard Mode Switch Board
• Safety Board
• Timing Board 

NOTE These PC boards are sensitive to static electricity. Observe the following 
precautions when handling them.

The following precautions significantly reduce the possibility of damaging a 
board through electrostatic discharge (ESD):

• Before handling a PC board, discharge your body’s static charge by 
wearing a wrist strap or touching a grounded surface. 

• Do not remove a replacement board from its anti-static packaging until 
it is ready to be installed. 

• Handle boards by their edges and their extractors (clips). Avoid 
touching components on the board and any edge connectors that plug 
into backplane slots.

Take the following steps to remove the card cage cover:

1. Remove the four screws that attach the card cage cover to the left outside 
wall of the unit using a Phillips head screwdriver.

2. Remove the three screws on the top of the card cage cover using a 
flat-blade screwdriver.

3. Lift the cover off.

A top view of the card cage appears in Figure 4.24.
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Figure 4.24  M4100 Card Cage

NOTE When replacing boards, the board you need to remove may be 
underneath a cable attached to another board. If this is the case, release 
the cable, note where it was connected, and later reconnect it.

connectors, lowvolt. power supply

Low Voltage Power Supply

W8 Connector
DSP/CPU Board

W11 Connector

Timing Board

W9 Connector
Safety Board

Guard Mode Switch Board
Guard Board

Board
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M4100 Internal Checks
Certain internal checks can be performed quite easily, avoiding more 
complicated measures. Many of these checks can be done with the M4100 
unpowered. A few require that AC power be applied with the covers off.

DANGER If re-application of power is necessary to perform an internal check, 
follow the procedural instructions carefully to minimize the risk of 
electrical shock. In particular, make certain that only voltmeter probes 
come in contact with internal test points. Furthermore, the High Voltage 
Test Cable and Safety Switch extension must always be disconnected 
from the Transformer case during internal measurement and inspection.

Fan Operation
With AC power applied, the fan typically does not run continuously. 
Specifically, the fan is supposed to run only when the instrument’s internal 
temperature exceeds 40 C, as measured by a thermostat located on the 
Heater/Temperature Controller Board.

To check for proper fan operation depress and hold the push-button switch 
labeled SW2, which is located along the top edge of the DSP/CPU Board 
(Figure 4.36 on page 4-70). The fan should come on for a few seconds then go 
off. If the fan fails to come on:

1. First try replacing the DSP/CPU Board by following the procedure in 
”Replacing the DSP/CPU Board” on page 4-70, then retesting the fan.

2. If the fan still fails to come on when tested, replace the fan by following 
the procedure in ”Replacing the Fan” on page 4-94.
4-50 72A-1230   Rev. F



M4000 Insulation Analyzer User Guide

Ju
ly

 2
2,

 2
00

5

Low-Voltage Power Checkout
Outputs of the Low Voltage Power Supply Board are readily measured at test 
points accessible on the Heater/Temperature Controller Board (Figure 4.41 
on page 4-80), which is mounted directly on the Low Voltage Power Supply 
Board. Check the following test points for the specified DC voltages:

TP1 Ground reference

TP2 -5 V

TP3 +15 V

TP4 +5 V (>4.9 V)

TP5 -15 V

If any of the measured voltages is out of range, replace the power supply by 
following the procedure in ”Replacing the Low Voltage Power Supply Board” 
on page 4-78.

Guard-to-Ground Shorting Problems
Guard-to-ground shorts can be detected by following the procedure in 
”Checking M4100 Guard-to-Ground Insulation” on page 4-43. A short is most 
likely to be found in one of the following areas. Check each possible cause in 
turn until the source of the problem is isolated:

1. Check the clearance between the Amplifier Assembly and Transformer. 
They must not be touching at any point. If the instrument has been 
dropped, the Amplifier Assembly in the bottom of the instrument could 
have been forced upward into contact with the guard around the 
Transformer. Eliminate the contact.

2. A screw or other metallic object may have fallen under the guard 
surrounding the Transformer, thereby shorting the guard to the chassis. 
Remove the object. This may require removing the Transformer.
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LVPS Fuses
The fuses for the Low Voltage Power Supply Board (LVPS) are located on 
that board. To access the board, remove the triangular metal plate from the left 
rear corner of the M4100. The Low Voltage Power Supply Board and 
Heater/Temperature Board Assembly (Figure 4.25) is then removed after 
disconnecting the cable from the top of the board.

Figure 4.25   Heater & LVPS Assembly as Removed from 4100

Check the fuses visually, and if necessary with an Ohmmeter. Replace any 
fuse that has blown, and monitor system performance for recurrence of the 
symptom.

W46 CableLow Voltage Power 

250V 4A Fuse
(2 250V, 5A fuses
on other side)

Heater/Temperature 

Supply Board

Controller Board

W45 Cable
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W8/W9/W11 Cable Checkout
Check and reseat the W8, W9 and W11 cable connectors, which are identified 
in Figure 4.26.

Figure 4.26  Card Cage

W11 Connector

W9 Connector

W8 Connector
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Orange Cable Checkout
Check the Orange Cable (Figure 4.27) for proper seating. It should not be 
shorting to the chassis, and its insulation should be intact.

Figure 4.27  M4100 Chassis, Covers Removed

Transformer Checks
The metal sheet over the transformer (Figure 4.27) is at chassis ground, while 
the reference box is at guard potential. The two should not be forced together, 
making contact with each other, at any point. The transformer beneath the 
grounded metal cover is also at guard potential. It should not be short-circuited 
to a grounded point, such as the amplifier box next to it near the bottom of the 
M4100. An inadvertent short can develop here if the M4100 has been dropped.

Transformer
(cover removed)

HV Pothead

Orange
Cable

Field Calibration
Reference box

Main References
Assembly

Amplifier
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W46 Cable Checkout
The W46 cable is a 12-conductor cable with a white connector on each end. It 
is located on the Heater/Temperature Controller Board, which is mounted to 
the Low Voltage Power Supply Board.

Take the following steps to check the W46 cable:

1. Locate and remove the Low Voltage Power Supply Board, referring to 
”LVPS Fuses” on page 4-52.

2. Disconnect and reseat both connectors on the W46 cable (Figure 4.25 
on page 4-52).

3. Replace the Low Voltage Power Supply Board (see ”Replacing the Low 
Voltage Power Supply Board” on page 4-78).
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 Replacing M4100 Components
Instructions are provided here for the replacement of M4100 internal, 
replaceable components for the purpose of diagnosing malfunctions or 
eliminating problems.

NOTE It is important to follow the systematic troubleshooting guidelines in 
Chapter 4 and elsewhere in Chapter 6 before replacing any M4100 
component. Forethought will reduce the difficulty and time required to 
fix a problem.

NOTE If a replacement component is packaged in an anti-static bag, do not 
remove it from the bag until instructed to do so. Return all failed 
components to Doble.

Replacement of an internal M4100 component requires removal of the 
instrument’s covers and may also require removal of the internal card cage 
cover. Follow the instructions in ”Accessing M4100 Components” 
on page 4-46 to accomplish these initial steps. That section also includes 
photographs to assist in identifying each component.

Locate the section that applies to the particular M4100 component to be 
replaced, then follow its instructions.

NOTE Remove any loose screws that may have fallen into the instrument during 
a replacement procedure.

DANGER After successfully replacing any M4100 component, also replace all the  
covers that were removed prior to operating the instrument. Failure to do 
so will expose the operator and other persons in the vicinity to lethal 
voltages, potentially resulting in injury or death from electrocution.
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Returning Replaced Components
To gain full credit for a replaced component, it must be returned to Doble 
within 30 days of the replacement component’s delivery.

To return a replaced component:

1. Complete the Material Return Tag supplied with the new component. The 
following entries are required:

•  RWO#: A Repair Work Order Number assigned to each part by 
Doble for tracking purposes. If Doble has not entered this number, 
obtain one by (1) calling Doble Customer Service at
(617) 926-4900, extension 317/321/232 or (2) sending an e-mail 
message to customerservice@doble.com. 

• Test Set Model: The unit model number, in this case 4100.
• Test Set Serial #: The unit serial number, which provides warranty 

information.
• Contact Name: Customer name.
• Problem symptoms.
• Contact Tel. #: Customer telephone number.
If a Material Return Tag was not supplied, please provide the above 
information separately and include the date and the part number, as well as 
any observed problems or symptoms and other relevant comments.

2. Attach the Material Return Tag to the old part.

3. Complete the Customer Satisfaction Questionnaire, supplied with the new 
part, and place it in the box in which the replacement part was shipped.

4. Put the old part in the box and send it to the following address:

Doble Engineering Company
85 Walnut Street
Watertown, MA 02472
USA

Doble pays to ship replacement components to customers under warranty, 
and customers are responsible for payment of shipping costs for returns. 
For out-of-warranty equipment, customers are responsible for all shipping 
charges.
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Removing and Replacing the Front Panel Assembly
The Front Panel Assembly is located on the front of the instrument.

The Front Panel Assembly must be removed in order to replace it and to gain 
access to the Main Reference Assembly, the Guard Front Panel Board, and the 
I/O Protection Board. Keep screws that are removed together in a safe location 
for re-assembly.

Take the following steps to remove and replace the Front Panel Assembly:

1. Unscrew four captive screws (Figure 4.28) that secure the optional Field 
Calibration Reference, if present, to the Front Panel Assembly using a 
Phillips-head screwdriver. 

Figure 4.28  Field Calibration Reference, Screw Locations

2. Pull out the Field Calibration Reference.

3. Remove the screws (Figure 4.29) on the cover of the Main Reference 
Assembly using a Phillips-head screwdriver. Then, lift off the cover.

4. Remove two screws inside the box (see Figure 4.29).

Screws
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Figure 4.29  Front Panel Removal, Nut Location

5. Remove one nut located behind the HV Pothead (Figure 4.29), using a nut 
driver.

6. Remove two screws in the Field Reference Calibration box.

7. Remove the ten self-locking screws that hold the front panel in place using 
a #8 Torx screwdriver.

NOTE These screws can be difficult to remove. If any of them binds during 
extraction, lubricate its front and the rear surfaces with a drop of 
machine oil. Then, use vise grip pliers to remove the binding screws if 
necessary. Later, when replacing the front panel, use new screws if 
available. These can be obtained from Doble if required.

8. Pull the Front Panel Assembly out only slightly. Then, disconnect the 
ribbon cable (W12) that attaches to the I/O Protection Board as well as the 
white cable (W11).

9. Pull the Front Panel Assembly straight out and place it face down on the 
bench.

The resulting top view of the instrument is as shown in Figure 4.30.

Nut

Screws
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Figure 4.30  M4100 Interior View, Front Panel Removed

10. To reinstall the Front Panel Assembly, first unpack the replacement unit 
(or locate the existing one). Position it on the front of the instrument. 
Reconnect the two ribbon cables coming from the I/O Protection Board.

11. Replace the ten self-locking screws that hold the front panel in place using 
a #8 Torx screwdriver.

12. Replace one nut (Figure 4.29 on page 4-59) located behind the HV 
Pothead using a nut driver.

13. Replace the Main Reference Assembly cover and secure it by replacing 
four screws using a Phillips-head screwdriver.

14. Replace the Field Calibration Reference and secure it by tightening four 
captive screws (Figure 4.28 on page 4-58) using a Phillips-head 
screwdriver.

HV Pothead

Field Calibration

I/O Protection Board

Guard Front Panel Board

Box Chassis
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Replacing the Guard Front Panel Board
Note the location of the Guard Front Panel Board in Figure 4.30 on page 4-60. 
It is located immediately behind the Front Panel Assembly. Take the following 
steps to replace it:

1. If it has not already been done, remove the Front Panel Assembly. See 
Steps 1-8, ”Removing and Replacing the Front Panel Assembly” 
on page 4-58.

NOTE Do not remove the replacement board from its anti-static bag until 
instructed to do so. See the Note on page 4-48 for additional ESD 
precautions.

2. Remove six #8 nuts (Figure 4.31) that secure the Guard Front Panel Board 
to the Front Panel Assembly using a 11/32” socket wrench. The nuts are 
located at the corners of the board. 

.

Figure 4.31  Guard Front Panel Board, Nut Locations

3. Remove two #8 nuts (Figure 4.31) that secure the ground connectors to the 
Guard Front Panel Board. Move the connectors off the board.

4. Disconnect two ribbon cables (W12 and W21).

5. Disconnect two ground wires (one orange and one white/green). Pull the 
wires straight up to make board removal easier.

Ground Nuts

Nuts
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6. Disconnect two connectors on cables W27 and W28. Each connector has 
three wires; W27 has one red and two black wires; W28 has one blue and 
two black wires.

7. Carefully lift the Guard Front Panel Board out, easing the wires through 
the holes.

8. Unpack the replacement Guard Front Panel Board and place the new board 
into the instrument.

9. Replace four #8 nuts that hold the board in place using a 11/32” socket 
wrench.

10. Replace two #8 nuts that secure the ground connectors to the Guard Front 
Panel Board after placing the wires back into position on the board.

11. Connect two connectors on cables W27 and W28. Each connector has 
three wires; W27 has one red and two black wires; W28 has one blue and 
two black wires.

12. Connect two ground wires (one orange and one white/green).

13. Connect two ribbon cables (W12 and W21).

14. Replace the Front Panel Assembly by following steps 9-14, ”Removing 
and Replacing the Front Panel Assembly” on page 4-58. 

15. Replace the instrument’s top and front covers by reversing the steps in 
”Removing the Front and Top Covers” on page 4-46.
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Replacing the Amplifier Assembly
Note the location of the Amplifier Assembly in Figure 4.23 on page 4-47. 
Take the following steps to replace it:

1. If it has not already been done, remove the card cage cover. See 
”Removing the Card Cage Cover” on page 4-48.

2. Remove the Nomex insulator shield to access the four deep-set screws 
(described in Step 3). The Nomex insulator is a white, flexible board 
located between the Transformer and the Amplifier Assembly. Grasp a 
corner of the shield and pull it out using a pair of needle-nose pliers.

3. Insert a 15” flat-blade screwdriver into each of the four notches on top of 
the Amplifier Assembly to unscrew the four captive screws (Figure 4.32). 
The four screws attach the Amplifier Assembly to the bottom of the 
chassis.

Figure 4.32  Amplifier Assembly, Captive Screw Locations

NOTE Do not remove the screws on the top cover of the Amplifier Assembly. 
That cover need not be removed as part of this procedure.

4. Remove three screws on the rear panel (Figure 4.33), located between the 
positions for the top two rubber feet, using a Phillips head screwdriver. 
(The top two rubber feet were removed to take off the cover.)

Captive Screws
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 Figure 4.33  Amplifier Assembly, Additional Screw Locations

5. Remove two Phillips screws (Figure 4.33) holding the top cover of the 
amplifier and chassis in place using a Phillips-head screwdriver.

6. Disconnect the ribbon cable (W7) from the Guard Board, which is located 
in the card cage.

7. Release the three white connectors (leading to cables W2, W3 and W4) 
from the front side of the Amplifier Assembly, closest to the Transformer. 
Work from right to left, ending with the white connector closest to the card 
cage.

8. Insert two fingers into the two notches at the top of the Amplifier 
Assembly to ease it out. Then, grasp the edges of the assembly and 
carefully lift it out of the instrument.

NOTE The clearance around the Amplifier Assembly is only about 1/8 inch. If 
the assembly is difficult to remove, insert a flat-blade screwdriver around 
its perimeter to gently pry it out.

9. Unpack the replacement Amplifier Assembly.

10. Insert two fingers into the notches at the top of the new Amplifier 
Assembly and gently guide it into position.

Side Screws

Top Fan Screws
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11. Tighten one of the captive screws by inserting the 15”-long, flat-blade 
screwdriver into one of the notches at the top of the assembly, and reach 
down to tighten the screw. With the first screw in place, use your hands to 
push the assembly towards the opposite end (away from the screw).

12. Tighten the remaining three captive screws using the 15”-long, flat-blade 
screwdriver.

13. Replace the three screws on the rear panel using the Phillips head 
screwdriver.

NOTE Since you have already removed two of the screws holding the fan 
assembly in place, now is a good time to inspect the Fan filter. See 
”Replacing the Fan Filter” on page 4-93.

14. Replace the top two screws holding the fan filter in place using the Phillips 
head screwdriver.

15. Connect the ribbon cable to the Guard Board.

16. Reconnect the three cables to the Amplifier Assembly’s white connectors.

17. Replace the Nomex insulator shield.

18. Replace the card cage cover by reversing the steps in ”Removing the Card 
Cage Cover” on page 4-48.

19. Replace the top and front covers by reversing the steps in ”Removing the 
Front and Top Covers” on page 4-46.
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Replacing the Guard Mode Switch Board
Note the location of the Guard Mode Switch Board in Figure 4.24 
on page 4-49 and in Figure 4.34 below. Take the following steps to replace it:

1. If it has not already been done, remove the card cage cover. See 
”Removing the Card Cage Cover” on page 4-48. The Guard Mode Switch 
Board will be visible as in Figure 4.34.

Figure 4.34  Guard Mode Switch Board

NOTE Do not remove the replacement board from its anti-static bag until 
instructed to do so.

2. Detach the two ribbon cables (W8 and W12) from the board.

3. Detach the four cables (W9, W11, W13, and one unlabeled for future use) 
from the board.

4. Use your index fingers to unlatch both PC board extractors. Then, pull the 
board straight up.

connectors, lowvolt. power supply

Guard Mode Switch Board
W8 Connector

W11 Connector

W9 Connector
4-66 72A-1230   Rev. F



M4000 Insulation Analyzer User Guide

Ju
ly

 2
2,

 2
00

5

5. Remove the replacement Guard Mode Switch Board from its anti-static 
bag and guide it into the slot. Press down evenly on the insides of the PC 
extractors until the board is firmly seated.

6. Reattach the two ribbon cables to the board (W8 to J8 and W12 to J5).

7. Reattach the four cables to the board (W9 to J2, W11 to J1, W13 to J3, and 
the unlabeled cable to J6).

8. Replace the card cage cover by reversing the steps in ”Removing the Card 
Cage Cover” on page 4-48.

9. Replace the top and front covers by reversing the steps in ”Removing the 
Front and Top Covers” on page 4-46.
72A-1230   Rev. F 4-67



Replacing the Timing Board
Ju

ly
 2

2,
 2

00
5

Replacing the Timing Board
Note the location of the Timing Board in Figure 4.24 on page 4-49 and in 
Figure 4.35 below. Take the following steps to replace it:

1. If it has not already been done, remove the card cage cover. See 
”Removing the Card Cage Cover” on page 4-48. The Timing Board will 
be visible as in Figure 4.35.

Figure 4.35  Timing Board

NOTE Do not remove the replacement board from its anti-static bag until 
instructed to do so. See the Note on page 4-48 for additional ESD 
precautions.

2. Use your index fingers to unlatch both PC board extractors. Then, pull the 
board straight up.

3. Remove the replacement Timing Board from its anti-static bag and guide 
it into position. Press down evenly on the insides of the PC extractors until 
the board is firmly seated.

connectors, lowvolt. power supply

Timing Board
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4. Replace the card cage cover by reversing the steps in ”Removing the Card 
Cage Cover” on page 4-48.

5. Replace the top and front covers by reversing the steps in ”Removing the 
Front and Top Covers” on page 4-46.
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Replacing the DSP/CPU Board
Note the location of the DSP/CPU Board in Figure 4.24 on page 4-49 and in 
Figure 4.36 below. Take the following steps to replace it:

1. If it has not already been done, remove the card cage cover. See 
”Removing the Card Cage Cover” on page 4-48. The DSP CPU Board 
will be visible as in Figure 4.36.

Figure 4.36  DSP/CPU Board

NOTE Do not remove the replacement board from its anti-static bag until 
instructed to do so. See the Note on page 4-48 for additional ESD 
precautions.

2. Detach the ribbon cable (W5) from the board.

3. Use your index fingers to unlatch both PC board extractors. Then, pull the 
board straight up.

4. Remove the replacement DSP/CPU Board from its anti-static bag and 
guide it into the slot. Press down evenly on the insides of the PC extractors 
until the board is firmly seated.

connectors, lowvolt. power supply

DSP/CPU Board
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5. Reattach the ribbon cable (W5) to the board.

6. Replace the card cage cover by reversing the steps in ”Removing the Card 
Cage Cover” on page 4-48.

7. Replace the top and front covers by reversing the steps in ”Removing the 
Front and Top Covers” on page 4-46.
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Replacing the Safety Board
Note the location of the Safety Board in Figure 4.24 on page 4-49 and in 
Figure 4.37 below. Take the following steps to replace it:

1. If it has not already been done, remove the card cage cover. See 
”Removing the Card Cage Cover” on page 4-48. The Safety Board will be 
visible as in Figure 4.37.

Figure 4.37  Safety Board

NOTE Do not remove the replacement board from its anti-static bag until 
instructed to do so. See the Note on page 4-48 for additional ESD 
precautions.

2. Detach the three ribbon cables (W4, W6 and W7) from the board.

3. Use your index fingers to unlatch both PC board extractors. Then, pull the 
board straight up.

4. Remove the replacement Safety Board from its anti-static bag and guide it 
into the slot. Press down evenly on the insides of the PC extractors until 
the board is firmly seated.

connectors, lowvolt. power supply

Safety Board
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5. Reattach the three ribbon cables to the board (W4 to J1, W6 to J3, and W7 
to J2).

6. Replace the card cage cover by reversing the steps in ”Removing the Card 
Cage Cover” on page 4-48.

7. Replace the top and front covers by reversing the steps in ”Removing the 
Front and Top Covers” on page 4-46.
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Replacing the Main Reference Assembly
Note the location of the Main Reference Assembly in Figure 4.30 
on page 4-60. Take the following steps to replace it:

1. If it has not already been done, remove the Front Panel Assembly. See 
Steps 1-8, ”Removing and Replacing the Front Panel Assembly” 
on page 4-58. (The Front Panel Assembly must be removed to replace the 
Main Reference Assembly, but the two assemblies are not attached.)

NOTE Do not remove the replacement board from its anti-static bag until 
instructed to do so. See the Note on page 4-48 for additional ESD 
precautions.

2. Remove the cover of the Main Reference Assembly. Do this by removing 
the two screws using a Phillips-head screwdriver.

Removing one screw releases an orange cable.

3. Disconnect the W12 ribbon cable.

4. Remove two screws, one in each front corner of the Main Reference 
Assembly (Figure 4.38), using a Phillips-head screwdriver. Some older 
units have three screws to be removed.

.

Figure 4.38  Main Reference Assembly, Screw Locations

Front Screws

Perimeter Screws and Washers
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5. Remove six screws, along with internal lock washers and flat washers, 
using a flat-blade screwdriver. These screws are located on the perimeter 
of the board (Figure 4.38).

6. With your fingers on the edges of the board, lift the board slightly, tilt it 
back, then lift it straight up and out. (Tilting the board avoids contact with 
screws inside the Main Reference Assembly). 

7. Remove the replacement Main Reference Assembly from its anti-static 
bag and, with your fingers on the edge of the board, place it in the 
instrument by reversing the process in Step 6. Tilt the board initially to 
avoid contact with any screws, then turn it and place it flat on the bottom 
of the assembly.

8. Replace six screws, with internal lock washers and flat washers, using a 
flat-blade screwdriver. These screws are located on the perimeter of the 
board.

9. Replace the screws (two or three depending on your instrument), one in 
each front corner of the Main Reference Assembly, using a Phillips-head 
screwdriver.

10. Connect the W12 ribbon cable.

11. Replace the cover of the Main Reference Assembly by replacing the two 
screws using a Phillips-head screwdriver.

Notice that there is a blue grommet attached to the cable that connects to 
the Guard Mode Switch Board. When replacing the screw that secures this 
cable, set the blue grommet into the notch on the Main Reference 
Assembly cover.

12. Replace the Front Panel Assembly by following steps 9-14, ”Removing 
and Replacing the Front Panel Assembly” on page 4-58.

13. Replace the top and front covers by reversing the steps in ”Removing the 
Front and Top Covers” on page 4-46.
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Replacing the Guard Board
Note the location of the Guard Board in Figure 4.24 on page 4-49 and in 
Figure 4.39 below. Take the following steps to replace it:

1. If it has not already been done, remove the card cage cover. See 
”Removing the Card Cage Cover” on page 4-48. The Guard Board will be 
visible as in Figure 4.39.

Figure 4.39  Guard Board

NOTE Do not remove the replacement board from its anti-static bag until 
instructed to do so. See the Note on page 4-48 for additional ESD 
precautions.

2. Detach the ribbon cable (W8) from the board.

3. Detach the two connectors on cable W9 from the board.

4. Use your index fingers to unlatch both PC board extractors. Then, pull the 
board straight up.

connectors, lowvolt. power supply
Guard Board

W8 Connector

W11 Connector

W9 Connector
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5. Remove the replacement Guard Board from its anti-static bag and guide it 
into the slot. Press down evenly on the insides of the PC extractors until 
the board is firmly seated.

6. Reattach the two connectors to the board (W9 to J2 and W9 to J3).

7. Reattach the ribbon cable to the board (W8 to J1).

8. Replace the card cage cover by reversing the steps in ”Removing the Card 
Cage Cover” on page 4-48.

9. Replace the top and front covers by reversing the steps in ”Removing the 
Front and Top Covers” on page 4-46.
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Replacing the Low Voltage Power Supply Board
Note the location of the Low Voltage Power Supply Board in Figure 4.23 
on page 4-47.

Take the following steps to replace it:

NOTE Do not remove the replacement board from its anti-static bag until 
instructed to do so. See the Note on page 4-48 for additional ESD 
precautions.

1. Remove four screws (Figure 4.40) using a Phillips-head screwdriver. Two 
screws secure the corner brace to the rear panel of the Instrument and two 
screws secure the brace to the side panel.

Figure 4.40  Low Voltage Power Supply Board, Screw Locations

2. Lift off the corner brace to access the board.

3. Remove the white Nomex insulator shield located between the Low 
Voltage Power Supply Board and the chassis. Simply grasp it and pull it 
out.

4. If necessary, move the ribbon cables out of the way to allow access.

5. Release the two connectors on cables W3 and W4 leading from the 
Amplifier Assembly.

Screws
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6. Lift the board out.

7. Remove the replacement Low Voltage Power Supply Board from its 
anti-static bag and place it in the Instrument.

8. Reconnect the two cables and reposition any other cables previously 
moved as necessary.

9. Replace the Nomex insulator shield.

10. Place the corner brace back into position and replace the four screws to 
secure the brace using a Phillips head screwdriver.

11. Replace the top and front covers by reversing the steps in ”Removing the 
Front and Top Covers” on page 4-46.
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Replacing the Heater/Temperature Controller Board
The Heater/Temperature Controller Board is the green board attached to the 
Low Voltage Power Supply Board. Before replacing the Heater/Temperature 
Controller Board, you must first remove the entire, two-board assembly from 
the instrument.

Take the following steps to replace the Heater/Temperature Controller Board:

NOTE Do not remove the replacement board from its anti-static bag until 
instructed to do so. See the Note on page 4-48 for additional ESD 
precautions.

1. Remove the Low Voltage Power Supply Board from the Instrument by 
following Steps 1-6 in ”Replacing the Low Voltage Power Supply Board” 
on page 4-78.

2. Remove the four screws that attach the Heater/Temperature Controller 
Board to the Low Voltage Power Supply Board (Figure 4.41) using a 
Phillips-head screwdriver. This will also release the four spacers.

Figure 4.41  Heater & Low Voltage Power Supply Assembly, Screw Loca-
tions

W46 Cable

Heater/Temperature

Screws

Screws

Controller Board W45 Cable
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3. Release the two connectors leading to cables W45 and W46.

4. Remove the new Heater/Temperature Controller Board from its anti-static 
bag and position it onto the Low Voltage Power Supply Board. Place a 
spacer between the two components at each screw position.

5. Reconnect the two connectors.

6. Replace the four screws that join the components together using a 
Phillips-head screwdriver.

7. Re-install the Low Voltage Power Supply Board into the instrument by 
following Steps 8-11 in ”Replacing the Low Voltage Power Supply Board” 
on page 4-78.
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Replacing the Optional Field Calibration Reference
The Field Calibration Reference, if present, is mounted to the instrument’s 
front panel. Take the following steps to replace it:

1. Unscrew four captive screws (Figure 4.42) using a Phillips-head 
screwdriver. 

Figure 4.42  Field Calibration Reference, Screw Locations

2. Pull out the Field Calibration Reference.

3. Unpack the replacement Field Calibration Reference and place it in 
position in the front panel.

4. Tighten the four captive screws using a Phillips-head screwdriver.

5. Replace the top and front covers by reversing the steps in ”Removing the 
Front and Top Covers” on page 4-46.

Screws
4-82 72A-1230   Rev. F



M4000 Insulation Analyzer User Guide

Ju
ly

 2
2,

 2
00

5

Replacing the I/O Protection Board
Note the location of the I/O Protection Board in Figure 4.30 on page 4-60. 
Take the following steps to replace it:

1. If it has not already been done, remove the Front Panel Assembly. See 
Steps 1-8, ”Removing and Replacing the Front Panel Assembly” 
on page 4-58. Place the Front Panel Assembly face down on the bench.

NOTE Do not remove the replacement board from its anti-static bag until 
instructed to do so. See the Note on page 4-48 for additional ESD 
precautions.

2. Remove six screws (Figure 4.43) that attach the I/O Protection Board to 
the Front Panel Assembly using a Phillips-head screwdriver. Note that one 
of the screws also secures a black and white grounding wire.

Figure 4.43  I/O Protection Board, Screw Locations

3. Release one W21 and two W24 ribbon cables. Since these last two cables 
are both labeled “W24”, note their connection points so that they can be 
correctly re-connected once the board has been replaced. 

4. Release connections to four cables (W22, W23, W25 and W26).

Secure Screws
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Figure 4.44  I/O Protection Board, Cable Connections

5. Carefully lift the I/O Protection Board off the Front Panel Assembly.

6. Unpack the replacement I/O Protection Board from its anti-static bag and 
place the new board onto the Front Panel Assembly.

7. Replace six screws that attach the I/O Protection Board to the Front Panel 
Assembly using a Phillips-head screwdriver. 

• First replace the two middle screws (rather than the screws located in 
the corners) to tack the board in place.

• Before replacing the screw that secures the grounding wire, first insert 
the black and white wire between the I/O Protection Board and the 
standoff. Then, tighten the screw.

8. Reconnect one W21 and two W24 ribbon cables. The W24 cable located 
closest to the Field Calibration Reference connects to J2. The other W24 
cable, located furthest away from the Field Calibration Reference, 
connects to J3.

9. Reconnect four cables as follows:

• W22 to J7
• W23 to J9
• W25 to J1
• W26 to J4

10. Replace the Front Panel Assembly by following steps 9-14, ”Removing 
and Replacing the Front Panel Assembly” on page 4-58. 

11. Replace the top and front covers by reversing the steps in ”Removing the 
Front and Top Covers” on page 4-46.

Ground
to
Upper
Left
Standoff
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Replacing the Transformer
Note the location of the Transformer in Figure 4.23 on page 4-47.

NOTE Due to the vibration the instrument encounters in the field, Doble now 
recommends replacing the originally installed whiz nuts with elastic stop 
nuts. When replacing the Transformer, check to see if it is mounted using 
whiz nuts. If so, mount the replacement Transformer with the more 
reliable elastic stop nuts. 

Take the following steps to replace the Transformer:

1. If it has not already been done, remove the card cage cover. See 
”Removing the Card Cage Cover” on page 4-48. The Transformer cover 
will be visible as in Figure 4.45.

2. Remove the Transformer cover, being careful not to drop any screws 
inside the unit.

• Remove five screws (Figure 4.45) using a 15” Phillips-head 
screwdriver. These screws are located inside the card cage, near the 
top, where the card cage is attached to the Transformer cover.

Figure 4.45  Transformer Cover, Screw Locations on Card Cage

• Remove five screws (Figure 4.46), located on the outside of the 
instrument next to the fan, using a Phillips-head screwdriver.

Screws
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 Figure 4.46  Transformer Cover, Screw Locations on Side Panel

• Remove four screws and washers, located on the top of the 
Transformer cover, using a flat-blade screwdriver

• Lift the cover off. White grommets will come off with the cover. Keep 
all screws, washers, and grommets together in a safe place.

Figure 4.27 on page 4-54 shows the instrument with the Transformer 
cover removed.

3. Replace the whiz nuts with elastic stop nuts if necessary. Otherwise, 
proceed to Step 4.

• Remove the four whiz nuts located at the corners of the Transformer 
where the it attaches to the bottom of the chassis (Figure 4.47). Do this 
by inserting a 7/16” socket wrench into each corner of the Transformer 
and reaching all the way down to loosen and remove the nuts.

Screws
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Figure 4.47  Transformer Mounting Nut Locations

• Place the elastic stop nuts into position using a 15” screwdriver as a 
guide. Place a nylon washer, a metal washer, and then the elastic stop 
nut on the screwdriver (Figure 4.48). Hold these pieces in place while 
inserting the screwdriver into each corner of the Transformer 
Assembly (Figure 4.49), then release the washers and nuts. 

Figure 4.48  Preparing The Screwdriver

Whiz Nut

Whiz Nut
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 Figure 4.49  Guiding the Transformer Mounting Nuts into Position

• Use the 7/16” socket wrench to tighten the nuts. Do not overtighten 
them.

4. Remove the cover of the Main Reference Assembly. Do this by removing 
the two screws (Figure 4.50) using a Phillips-head screwdriver.

Figure 4.27 on page 4-54 shows the instrument with the Main Reference 
Assembly cover removed.

• Remove the four screws (Figure 4.50), where the Main Reference 
Assembly joins the chassis, using a Phillips-head screwdriver.
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Figure 4.50  Main Reference Assembly, Screw Locations 

5. Release the three connectors on cables W2, W3 and W4 (which lead to the 
Amplifier Assembly) by grasping them and pulling the cables away from 
the Transformer. Move other cables out of the way as necessary to clear a 
path for lifting out the Transformer.

6. Remove the Nomex insulator shield located between the Transformer and 
the Amplifier Assembly. Simply grasp the shield and pull it out.

7. With two people, one on each side, lift the Transformer straight up and 
remove it from the Instrument.

WARNING The Transformer is heavy. Two persons are required to safely lift it out of 
the instrument. This step is best accomplished with the M4100 relocated 
to the floor.

8. Unpack the new Transformer. Again using two people, place the new 
Transformer into position in the instrument.

9. Replace the Nomex insulator shield by sliding it in between the 
Transformer and the Amplifier Assembly.

10. Reconnect the three cables.

11. Replace the four screws, near where the Main Reference Assembly 
attaches to the Transformer, using a Phillips-head screwdriver.

Cover

Screws

Screws
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12. Replace the cover of the Main Reference Assembly and secure it by 
replacing the screws using a Phillips-head screwdriver.

Notice that there is a blue grommet attached to the cable that connects to 
the Guard Mode Switch Board. When replacing the screw that secures this 
cable, set the blue grommet into the notch on the Main Reference 
Assembly cover.

13. Replace the Transformer cover and white grommets.

• Replace the five screws near the top, inside edge of the card cage using 
a 15” Phillips-head screwdriver.

• Replace the five screws on the outside of the instrument next to the fan 
using a Phillips-head screwdriver.

• Replace four screws and washers on the top of the Transformer cover 
using a flat-blade screwdriver.

14. Replace the card cage cover by reversing the steps in ”Removing the Card 
Cage Cover” on page 4-48.

15. Replace the top and front covers by reversing the steps in ”Removing the 
Front and Top Covers” on page 4-46.

16. Check for Guard-to-Ground Insulation, as described in ”Checking M4100 
Guard-to-Ground Insulation” on page 4-43.
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Replacing the HV Pothead
Note the location of the HV Pothead in Figure 4.30 on page 4-60. Take the 
following steps to replace it:

1. If it has not already been done, remove the Front Panel Assembly. See 
Steps 1-8, ”Removing and Replacing the Front Panel Assembly” 
on page 4-58. Place the Front Panel Assembly face down on the bench.

2. Remove one 1/4” elastic nut (Figure 4.51), on the back of the Front Panel 
Assembly to release the W30 cable, using a socket wrench.

.

Figure 4.51  HV Pothead, W30 Screw and Nut Locations

3. Remove four #632 nuts with flat washers (Figure 4.51), found in the 
corners of the black plate beneath the HV Pothead, using an 11/32” socket 
wrench.

W30 Nut

#8 Nuts

#8 Nuts
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Figure 4.52  HV Pothead, Ground Screw Location

4. Remove one screw and washer (Figure 4.52), that secure the ground wire 
and the power outlet wire to the side of the HV Pothead, using a 
Phillips-head screwdriver.

5. Carefully lift the HV Pothead out.

6. Unpack the replacement HV Pothead and place it onto the Front Panel 
Assembly.

7. Replace four #632 nuts with flat washers, into the corners of the black 
plate beneath the HV Pothead, using an 11/32” socket wrench.

8. Grasp the ground wire and the power outlet wire (Figure 4.52) and place 
them back onto the side of the HV Pothead. Secure these wires by 
replacing the screw and washer using a Phillips-head screwdriver.

9. Replace the 1/4” elastic nut, on the back of the Front Panel Assembly to 
secure the W30 cable, using a socket wrench.

10. Replace the Front Panel Assembly by following steps 9-14, ”Removing 
and Replacing the Front Panel Assembly” on page 4-58.

11. Replace the top and front covers by reversing the steps in ”Removing the 
Front and Top Covers” on page 4-46.

Ground Screw
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Replacing the Fan Filter
Note the location of the fan filter in Figure 4.53. Inspect the filter from time to 
time to check for accumulated dust or scale. Take the following steps to 
replace it:

1. Remove the four screws that hold the fan’s grill in place (Figure 4.53) 
using a Phillips-head screwdriver.

Figure 4.53  Fan Filter Screw Locations 

2. Remove the old fan filter and replace it with a new one.

3. Replace the four screws using a Phillips-head screwdriver. Use the 
screwdriver to tuck the new filter in place, if necessary.

NOTE Hot air exhausts from the fan outlet. Do not block it.

Screws
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Replacing the Fan
The fan is part of the Amplifier Assembly, which is shown in Figure 4.23 
on page 4-47. Take the following steps to replace it:

1. Remove the Amplifier Assembly from the instrument by following Steps 
1-8 in ”Replacing the Amplifier Assembly” on page 4-63.

2. Remove the Amplifier Assembly cover by removing the two screws that 
hold it in place (Figure 4.54) using a Phillips-head screwdriver. Then, lift 
the cover off.

Figure 4.54  Amplifier Assembly Cover, Fan Screw Locations

3. Remove four screws, with washers, at the corners of the fan (Figure 4.54).

4. Release two connectors at the top of the fan.

5. Cut the tie wrap holding the connectors in place using a pair of wire 
cutters.

6. Unpack the replacement fan and insert it into the Amplifier Assembly.

7. Connect the two connectors.

8. Replace the four screws and washers at the corners of the fan.

Screws

Fan Screws
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9. Replace the Amplifier Assembly back into the instrument by following 
Steps 10-19 in ”Replacing the Amplifier Assembly” on page 4-63.

NOTE Hot air exhausts from the fan outlet. Do not block it.
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Appendix A.  M4000 Components Lists

M4000 Insulation Analyzer
Components that may be included with the M4000 Insulation Analyzer are as 
follows:

No. Number Description Qty

1 010-0097-01 Type M4200c Controller (optional) 1
2 010-0096-01 Type M4000 Instrument Case 1
3 02D-0024-02 Type M2 Cable, HV, 60 ft. 1
4 02C-5200-01 Liquid Insulation Cell (w/carrying case) 1
5 03D-1070-02 Transporter (optional) 1
6 02C-5798-09 Accessory Bag 1
7 2FB-2464-01 Documentation Bag 1
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Accessory Bag

No. Number Description Qty

1 RC Revision Level D 0 EA
2 181-0452 Power Cord, 6 ft. #14/3, Receptacle box 

to Instrument & Controller
2 EA

3 181-0499 Power Cord, 50 ft. #14/3 1 EA
4 181-0117 Cord, Adapter, 1EC320 to Nema5, 

Receptacle box to female plug (for 
laptop)

1 EA

5 05B-0430-01 P/A, Cable, Int-Con. 
(Intercase communication cable)

1 EA

6 02C-0019-01 Cable, Ground, 30 ft. 1 EA
7 02B-0050-07 Cable, Safety SW 8 ft. 1 EA
8 02B-0050-06 Cable, Safety SW 65 ft. 1 EA
9 02B-0020-02 Lead, LV, Blue 65 ft. 1 EA
10 02B-0020-03 Lead, LV, Red 65 ft. 1 EA
11 02B-0026-01 Lead, Ground 3 ft. 1 EA
12 02B-0026-02 Lead, Ground 5 ft. 5 EA
13 02B-0017-01 Red Jumper Cable, Insulated, LD 2 EA
14 02B-0089-01 P/ASY, Prong, Test 

(Type O bushing tap adapter)
1 EA

15 O20-0048-01 P/A, Collar, Cond. Set 1 Ea
16 02B-0012-01 P/ASY, Adapter, Bushing 

(Type S bushing tap adapter)
1 EA

17 2FC-4836-01 Hook, Cable, 9 inch diameter 1 EA
18 03B-1137-01 P/A, Adapter Bushing 

(ASEA bushing tap adapter)
1 EA

19 212-0416 Connector, Female, Undergrounding 
(O+ bushing tap adapter)

1 EA

20 2FB-2463-01 Bag, Cable, Grey 1 EA
21 09C-0613-01 RWK, Strobe Light (optional) 1 EA
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22 09C-0614-01 Temp. & Humid. Sensor (old) (optional) 1 EA
23 03C-1318-01 Temp. & Humid. Sensor (new) 

(optional)
1 EA

24 05B-0492-01 Cable, Strobe Light (optional) 1 EA
25 05B-0493-01 Cable, Temp./Humid Sensor (optional) 1 EA
26 03C-1074-01 P/A, Box, Power Receptacle. 1 EA
27 05B-0495-01 Diagnostic Test Cable, W51, Fld, 

Adapter
1 EA

28 181-0095 Power Cord, 10 ft. 18/3, 
Nemas/IEC 320

1 EA

29 05B-0508-01 Conn., Loopback, Plug 1 EA
30 05B-0509-01 Conn., Loopback, Rcpt 1 EA
31 05B-0503-01 PC to Instrument Cable 1 EA

No. Number Description Qty
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Documentation Bag 

No. Number Description Qty

1 RC Revision Level C 0 EA
2 2FB-2464-01 Bag, Gray Document 1 EA
3 401-0051 Paper 8 3/4 x 100 ft. Thermal Bl 2 EA
4 903-0023 Paper Tube, 2 in x 9 1/2 in White 2 EA
5 401-0076 Software MS DOS 6 x 3.5 Fullman 1 EA
6 903-0026 Diskette Box M4000 1 EA
7 903-0026 Diskette Box DTA 1 EA
8 903-0026 Diskette Box User 1 EA
9 500-0100 Manual Oper M4K Insul. Analyzer 1 EA
10 903-0030 Drive, 5/64, 5 in Lg. Allen HD 1 EA
11 08A-0021-01 Disk Set, Software 1 EA
12 08A-0022-01 Disk, Util. & Root 1 EA
13 401-0121 Windows 3.1 Diskettes
14 Patch Cable & Modem Manual
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Appendix B.  Warranty

RENTAL EQUIPMENT
The Doble Service and Equipment Agreement provides perpetual hardware 
and software maintenance for the M4000 Insulation Analyzer throughout the 
agreement teen.

PURCHASED EQUIPMENT

Limited Warranty
Doble Engineering Company (DOBLE) warrants the products that it 
manufactures to be free from defects in materials and workmanship for a 
period of one year from the date shipped from the factory.

During the one year warranty period, DOBLE will repair or replace, at its 
option, any defective products or components thereof at no additional charge, 
provided that the product or component is returned, shipping pa paid, to 
DOBLE. The purchaser is responsible for insuring any product or component 
so returned and assumes the risk of loss during shipment. All replaced 
products and components become the property of DOBLE.

THIS LIMITED WARRANTY DOES NOT EXTEND TO ANY PRODUCTS 
WHICH HAVE BEEN DAMAGED AS A RESULT OF ACCIDENT, 
MISUSE, ABUSE, OR AS A RESULT OF MODIFICATION BY ANYONE 
OTHER THAN DOBLE OR AN AUTHORIZED DOBLE 
REPRESENTATIVE.

EXCEPT AS EXPRESSLY SET FORTH ABOVE, NO OTHER 
WARRANTIES, EXPRESSED OR IMPLIED, ARE MADE WITH 
RESPECT TO THE PRODUCT INCLUDING, BUT NOT LIMITED TO, 
ANY IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE. DOBLE EXPRESSLY DISCLAIMS ALL 
WARRANTIES NOT STATED HEREIN. IN THE EVENT THE PRODUCT 
IS NOT FREE FROM DEFECTS AS WARRANTED ABOVE, THE 
PURCHASER'S SOLE REMEDY SHALL BE REPAIR OR 
REPLACEMENT AS PROVIDED ABOVE. UNDER NO 
CIRCUMSTANCES WILL DOBLE BE LIABLE TO THE PURCHASER OR 
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ANY USER FOR ANY DAMAGES, INCLUDING WITHOUT 
LIMITATION, PERSONAL INJURY OR PROPERTY DAMAGE CAUSED 
BY THE PRODUCT, ANY INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, EXPENSES, LOST PROFITS, LOST SAVINGS, OR OTHER 
DAMAGES ARISING OUT OF THE USE OF OR INABILITY TO USE 
THIS PRODUCT.

Software Limited Warranty
THIS SOFTWARE PRODUCT IS PROVIDED “AS IS” WITHOUT 
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF 
THIS SOFTWARE PRODUCT IS WITH PURCHASER SHOULD THE 
PRODUCT PROVE DEFECTIVE. PURCHASER (AND NOT DOBLE OR 
AN AUTHORIZED DEALER) ASSUMES THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR, OR CORRECTION.

SOME STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED 
WARRANTIES SO THE ABOVE EXCLUSION MAY NOT APPLY. THIS 
WARRANTY GIVES THE PURCHASER SPECIFIC LEGAL RIGHTS 
AND THE USER MAY ALSO HAVE OTHER RIGHTS WHICH VARY 
FROM STATE TO STATE.

DOBLE warrants the disks on which the software product is furnished to be 
free from defects in materials and workmanship under normal use for a period 
of one hundred and twenty (120) days from the date of shipment from 
DOBLE.

Limitations of Remedies
DOBLE's entire liability and Purchaser's exclusive remedy shall be:

1. The replacement of any disks not meeting DOBLE's “Limited Warranty” 
which are returned to DOBLE.

2. If DOBLE is unable to deliver replacement disks which are free from 
defects in materials and workmanship, Purchaser may terminate this 
agreement by returning the software product and all copies thereof in any 
form and affirming compliance with this requirement in writing. DOBLE 
will refund the purchase price.
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IN NO EVENT WILL DOBLE BE LIABLE TO PURCHASER FOR ANY 
DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR 
OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING 
OUT OF THE USE OR INABILITY TO USE SUCH SOFTWARE 
PRODUCT EVEN IF DOBLE OR AN AUTHORIZED DEALER HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR 
ANY CLAIM BY ANY OTHER PARTY.

SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION 
OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, 
SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY.

For Equipment Maintenance, Contact:
Contact your Doble Representative.

Doble Engineering Company
85 Walnut Street
Post Office Box 9107
Watertown, MA 02472-9107
Tel: 617 393 2900
Fax: 617 926 0528
72A-1230   Rev. F B-3
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Appendix C.  Error Messages

M4100 Instrument Run Time Error Messages
This appendix lists the error messages displayed while using the M4000 
Insulation Analyzer.

Error # Description of Error

1 Invalid Message Number
2 Invalid Message Length
3 Unsupported Message
4 Test is Currently Running
5 Not Enough Free Space in FLASH for Application
6 Unused
7 FLASH Did Not Program Properly
8 FLASH Did Not Erase Properly
9 Invalid Number of Application Bytes Received
10 FLASH Execute Checksum Error
11 Boot Block Checksum Test Failed
12 Static RAM Test Failed
13 UART Internal Loopback Test Failed
14 - 19 Reserved for Future Use
20 Watchdog Reset Error
21 Invalid Message Parameter
22 Unused
23 Safety Switch 1 Open
24 Safety Switch 2 Open
25 Unused
26 Calibration Reference Overvoltage
27 Unused
28 Earth Ground Open
29 Safety Circuit DC Supply Low
30 Unused
72A-1230   Rev. F C-1
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M4000 Firmware/Application Errors

31 Unused
32 Internal Amp Cable Disconnected
33 One or Both Safety Switch Cables Disconnected
34 Power Amp Power Bad
35 Overcurrent on Power Amp Output
36 Power Amp DC Supply High
37 Power Amp DC Supply Low
38 M4000 Synchronization Error
39 Phase Lock Loop Not Locked
40 Strobe Cable Not Plugged In
41 Strobe Not Flashing
42 - 49 Reserved for Future Use
50 Lead Changed During Test
51 Safety Switches Not Released Between Tests
52 Software Buffer Overrun
53 One or Both Low Voltage Leads Disconnected
54 Overcurrent Occurred
55 Amplifier OverTemperature Occurred
56 Input Current Peak Maximum Exceeded
57 Transformer OverTemperature Occurred
58 Test Stopped By Controller
59 Comm. Timeout Detected By Instrument
60 Main Reference OverTemperature Occurred
61 Calibration Reference OverTemperature Occurred
62 High Voltage Over 12.5 kV
63 Voltage Input Saturated
64 Requested Maximum Voltage Exceeded

Error # Description of Error

Error # Description Of Error

81 Unable to open application file
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M4000 Communications Errors

82 Application file is corrupted

83 Error downloading application

84 Error programming FLASH ROM. application not found in 
FLASH.

85 M4100 FLASH ROM has been corrupted

Unable to open M4100 Firmware file. Tests cannot be run

M4100 Firmware file is corrupted. Tests cannot be run

Error downloading M4100 Firmware. Tests cannot be run

Error programming FLASH ROM. M4100 Firmware not found 
in FLASH. Tests cannot be run

M4100 FLASH ROM has been corrupted. tests cannot be run

M4100 Firmware file requires an updated version. Tests cannot 
be run

Error # Description Of Error

Error # Description of Error

100 No Errors
101 Undefined Error
102 Requested Port Out Of Range
103 Port Already Set Up
104 Invalid Buffer Size Requested
105 No Memory For Buffers
106 Communications Not Initialized
107 Invalid Parameter
108 Buffer Is Empty
109 Buffer Is Full
110 Timed Out
111 Cts Inactive
112 Cd Inactive
113 Dsr Inactive
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114 Error Accessing Comm. Port
115 Xmodem Exception
116 User Keyboard Abort
117 File I/O Error
118 Xmodem Protocol Error
119 Widetrack Rx Not On
120 Shared-Interrupt Parameter Wrong
121 Crc Mode Error
122 Modem Didn’t Send Ok
123 No Modem Response
124 Function Not Supported
125 Illegal Baud Rate
126 Illegal Parity
127 Illegal Word Length
128 Illegal Number Of Stop Bits
129 Missing Copyright Notice
130 Driver Not Installed
131 User Buffer Overflow
132 Failure To Connect To Port
133 No Response From M4000, Check Connections
134 Communications Parity Error, Check Connections
135 Communications Overrun Error, Check Connections
136 Communications Framing Error, Check Connections
137 Invalid Message Number
138 Invalid Message Checksum
139 Invalid Message Length
140 Invalid Message ACK/NAK Byte
141 Received Loopback Message Does Not Match 

Transmitted Message
142 No Loopback Message Received
151 Error reading EEPROM data
152 Error writing EEPROM data
153 Board name not specified

Error # Description of Error
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154 Board slot not found
195 Illegal stop bits
196 Illegal word length
197 Illegal parity setting
198 Timed out
199 Function not supported
295 Handshake Line in use
296 Port Settings failed
297 Windows OS error
298 COM Port not found
299 COM Port in use

Error # Description of Error
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Appendix D.  Part Numbers

Doble part numbers of replaceable M4100 components are provided in this 
appendix.

Description Part Number

Front Panel Assembly 03D-1056
Guard Front Panel Board 04D-0536
Amplifier Assembly 03D-1055-01
Guard Mode Switch Board 04D-0551
Timing Board 04D-0533
DSP/CPU Board 04D-0520
Safety Board 04D-0544
Main Reference Assembly 04D-0583
Guard Board 04D-0527
Low Voltage Power Supply Board 384-0138
Combined Assembly (LVPS & H/TC) 03D-1057-01
Heater/Temperature Controller Board 04D-0547
Field Calibration Reference 04D-0524
I/O Protection Board 04D-0546
Transformer 03D-1054
HV Pothead 03C-0056-07
Fan 380-0042
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Preface

Structure of this Manual
This manual consists of 5 chapters and a glossary.

Chapter 1 “Overview” reviews the general features of the Doble 
Test Assistant Field System.

Chapter 2 “Apparatus Test Forms” detail the contents of each set 
of test forms and how to use them to run a test.

Chapter 3 “Running A Test” takes you through the process of 
running a test.

Chapter 4 “Commonly Used Functions” explains how to perform 
typically needed tasks.

Chapter 5 “Frequently Asked Questions” answers tester’s most 
commonly asked questions.

Glossary “Glossary” defines terms specific to the M4000 
Insulation Analyzer.

Conventions Used in this Manual
The following terms and typographical conventions are used in the manual:

Convention Description

Windows Refers to the Microsoft Windows operating system, 
Version 95 or later.

Click Quickly press and release the left mouse button.

Double-click Quickly press and release the left mouse button twice 
without moving the mouse.

Select Position the cursor on the desired option and click the 
left mouse button once. Or, highlight the desired 
option using the arrow keys and press ENTER. Or, press 
ALT and the underlined letter.

Press Type a single keyboard key. For example, press ENTER.

FN+(appropriate key) Press and hold the FN key, and press (appropriate key).

Bold Courier Text Indicates characters to be typed.
72A-1260   Rev. G -i
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1. Overview

What Is DTAF
The DTA Field System is a data collection and analysis tool used by engineers 
involved in performing Doble power factor tests. The data entry screens are 
designed explicitly for the particular apparatus under test, and for the 
particular test being performed. The DTA Field System provides a means of 
entering, analyzing (using an optional built in Expert System), and 
maintaining power factor test data. This test data can be entered into the 
program manually by the user, or automatically recorded by the M4000 
Instrument. A test data file contains all the nameplate data collected in the 
field, as well as the test data itself. It is recommended that data gathering 
parameters be discussed before starting a testing program, to assure that the 
necessary nameplate and apparatus identification information is included with 
the test data.

After The Test Data Is Collected
Once data has been entered, analyzed by the program’s optional Expert 
System, and reviewed by the tester, it is ready to be exported to the DTA 
Office System, a database where all test data is stored and can be examined 
and retrieved at will. It may reside on the M4200 controller or laptop as well, 
but it should be backed up and preferably stored in the DTA Office System for 
safekeeping and to allow company-wide analysis of data.

The File Containing The Test Data
The file for each apparatus tested contains 1 or more tests for that apparatus. In 
earlier versions, it was called a Compressed Dataset (CDS). In this version is 
is a renameable file. It is now in XML format. DTA can read both formats, but 
all new files created, or changes made in old files, will be saved in the new 
XML format. The same file is used for the whole history of tests made on that 
particular apparatus. Once a new file is started for a particular apparatus, it is 
the only file used for that apparatus. The tests for certain “child” apparatus, 
such as bushings and surge arresters, which form an integral part of the 
“parent” apparatus (such as a transformer), are included in this file. If a 
bushing or surge arrester is changed during the history of the “parent”, these 
changes are recorded within this same file.
72A-1260   Rev. G 1-1
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Editing The Test Data
After files are saved in DTAF, they may be updated, deleted, and copied.

The Expert System
The Expert System performs all the analysis that an experienced tester would 
normally perform on the test data. Comparisons are made to nameplate data 
and previous test data, if available. Included in DTAF are the Limit files, an 
electronic version of what used to be called the Doble Test Data Reference 
Book. These files contain limits for the test data recommended by Doble. 
DTAF compares the test data to these limits. It also compares data from 
identical apparatus tests (such as tests on identical transformer bushings or 
surge arresters). Individual measurements, such as current, watts, and 
capacitance, are also analyzed by the Expert System.

NOTE The Expert System analyzes the test data one line at a time as it is entered 
into the apparatus form. To complete analysis, the user must perform an 
overall analysis of each page after all the data has been collected for that 
page. This is done with the command Test/Recalculate (F9).

Installing The Software
The software is available on CD or on 13 floppy disks. You must be using 
Windows 98 or newer, and Windows Explorer 5.0 or newer. This version of 
DTA requires M4000 software version 3.2 if running with the M4000 
Insulation Analyzer. To install:

1. Run the installation software with the Setup.exe file. You will not 
overwrite existing Location.txt or Division.txt files.

2. You will be asked to choose a destination folder. The default (C:\Program 
Files\Doble\DTAF) is different than was the previous version of DTA, so 
you can have both versions installed and use them at the same time.

3. You will be asked where the DTA 5.2 icon should go. You can place it in 
the same folder as that of the older version, as the icons are different and 
you will be able to distinguish between the icons representing both the old 
and new versions.

4. If you are using DTA for the first time, or are upgrading but have never 
bothered with the Location and Division field choice lists, you may want 
to create them now. By creating lists for these fields, you can control what 
is entered in them (see Restrict Location Entries To Choice Lists, under 
”Tools” on page 1-9). Just select Edit Choice Lists from the Tools menu. A 
choice list may also be set up for the Company field.
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5. After installation is complete, if you are upgrading from version 4.1, and 
have configured your Location.txt and Division.txt files, you will want to 
transfer that data to the new program. The corresponding files are now 
Location.xml and Division.xml. They can be opened with Microsoft 
Notepad. A typical file looks as follows:

<?xml version="1.0"?>

<TABLE>

<LOCATION>Location 1</LOCATION>

<LOCATION>Location 2</LOCATION>

<LOCATION>Location 3</LOCATION>

<LOCATION>Location 4</LOCATION>

<LOCATION>Location 5</LOCATION>

</TABLE>

Figure 1.1  Appearance Of New Location.xml File

6. You may update this file manually, changing only the middle part of 
each line between the > < marks (i.e. Location 1, Location 2, etc.).

7. You may also use the Edit Choice List command from the Tools menu. 
There you can edit the Location, Division, and Company lists. If you have 
an updated list in electronic form, you may cut and paste that list into the 
desired Edit Choice List window.

8. If you need to add rows, use the same format. Only one location per row is 
permitted. Save the file when finished.

9. There is an “applet” which will automatically convert your Location.txt 
and Division.txt to xml files for you. Call your Client Service Engineer at 
Doble for details.

10. When you open a file with version 5.2, and then wish to exit it, DTA will 
ask if you wish to save it. If you say no, it will leave the file in the format 
of the older version. If you say yes, it will save it in the new XML format, 
keeping the old file version but with an X in the filename extension instead 
of an A. This makes the file invisible to the old version, unless the Recover 
command is used. Version 4.1 and older cannot read the new XML 
formatted files.

11. If you encounter difficulties while installing, and obtain a message such as 
“run time error xxxx”, or “msado15_dll.bmp”, you may not have the latest 
version of a Microsoft program called MDAC. To check, click the Start 
button, then type regedit.
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NOTE Be very careful when entering the Windows Registry. Any changes you 
make may render the computer unusable!

12. Click the + sign next to HKEY_LOCAL_MACHINE; then, the + sign 
next to Software, then the one next to Microsoft, then the one next to 
DataAccess.

13. In the right-hand panel, the files FullInstallVer and Version should be 2.6 
or later; if not, close the registry window, and download the file 
MDAC_TYP.exe from the Microsoft website at 
“http://www.microsoft.com/downloads/details.aspx?FamilyID=6c050fe3-
c795-4b7d-b037-185d0506396c&DisplayLang=en”.

14. Or, go to WWW.Microsoft.com/downloads, type into the keyword search 
field “microsoft data access”, and select the latest version of MDAC 
(currently 2.8 or better). This will also take you to the download site.

NOTE You may have to slightly modify this procedure for foreign language 
versions of Windows.

15. Install on your computer.
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The Main Screen: Data Manager

Figure 1.2  DTA Field Version 5.2 Main Screen

Left-Hand Pane
The main screen is a Windows Explorer-style screen. The left-hand pane 
shows the entire content of the selected directory which is shown above the 
dataset list, next to the Data Source button. You may view all tests in the 
selected directory, or view selected tests by Location, Apparatus Kind, 
Serial Number, Date, Special ID, or Flags.

The right pane shows the sub-contents of the selection on the left pane. For 
example, if the user clicks List All, a list of sub-categories will appear, 
including Location, Apparatus Kind, Serial Number, Date, and Special ID. If 
the user clicks the Location heading in the left pane to open the list of 
locations, and then clicks one of those locations, the right pane will show all 
the tests found at that location.

Another way to sort and find test data is to click the List All heading in the 
left-hand pane (to show all available tests), and then sort the results in the 
right-hand pane by clicking the column header of the column you wish to sort 
by. For example, to show the list of test data as it was displayed in the Data 
Manager of previous versions of DTA, click the List All heading in the 
left-hand pane and click the Date column header in the right-hand pane.
72A-1260   Rev. G 1-5



Right-Hand Pane
Se

pt
em

be
r 1

3,
 2

00
5

Right-Hand Pane
Apparatus listed in the right-hand pane may be sorted by clicking on the 
column header of the item, such as Location, that you wish to sort by. An 
explanation of some of the column headers follows:

Special ID This is a field containing any unique company ID that is used to better identify 
the apparatus.

CCT Designation This allows the user to identify the apparatus by the circuit on which it is 
located (Circuit Designation).

# Indicates the number of separate test dates that exist for this apparatus.

Test Date This is the most recent test date among all available test dates for this 
apparatus.

Flags Flags are used to identify certain properties of the apparatus test data:

• C: Rating Conflict in latest test. This means that the user has rated the 
test differently than the DTA Expert System.

• I: Non-G rating in latest test. The insulation has been rated D, I, or B.
• T: Latest test has retest date. An apparatus has been deemed in 

questionable condition, and a retest date has been set in DTA to alert 
the user than this apparatus should be tested sooner than the normal 
test cycle. Retest Date can be found in the Nameplate Administration 
window, from the View menu (an apparatus file must be open).

• N: Latest test has a note. A note is used to add information regarding 
the apparatus or the test which may be of note.

• O: “Other” has been selected somewhere from a choice list, such as 
Manufacturer or Type. If this is the case, then the user should have 
entered the missing Manufacturer or Type, and sent an E-mail to 
Doble requesting an update on the limit files to include the missing 
choice.

• A: Indicates that the Checked By field in the Nameplate 
Administration window (selected from the View menu) contains data. 
This is how DTA now indicates that the test has been reviewed and 
approved. This does not lock the data.

• X: If you place an X in the second ratings column next to a row of data 
and press F9 Recalculate, that row will be left out of the expert 
system’s calculations and will not be rated. Useful if you have bad 
data you want to keep for reference but don’t want to be seen by the 
expert system.
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File Name Shows the name of the apparatus file. File name is based on either Serial 
Number or Special ID or both, in either order, or on Serial Number and Circuit 
Designation or Special ID and Circuit Designation, and this choice is made 
from the Configuration window, when selected from the Tools menu on the 
main screen. Or, change the name as desired in Windows Explorer.

Adjustable Column Widths
In the right-hand pane, the column header widths can be adjusted using the 
mouse by hovering the pointer over the vertical line between column headers 
until it becomes a double arrow; then, drag the vertical column divider line to 
the left or the right. The user can also adjust the vertical divider between the 
left and right-hand panes.

Test Data Directories
To change the directory you wish to be displayed, click the Data Source 
button and choose the desired directory. The field to the right of the Data 
Source button contains the current directory, and by clicking the down arrow 
at the end of this field, a history of previous directories viewed can be seen. 
Click one of these to revert to that directory.

Special Key Status
In the bottom right-hand corner of the screen on the status bar are three fields: 
INS, NUM, and CAPS. These refer to the keyboard keys of those names. 
These three keys toggle on and off, and when on, show up in bold black. 
During use of the DTA Field System, these keys should be toggled OFF.
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Icons
The following icons are displayed along the top of the main screen:

Menus

File 1. New: Create a new Apparatus file.

2. Open: Open the selected Apparatus file.

3. Delete: Delete the selected Apparatus files.

Main Screen Icon Use

The Open icon, used to view a selected 
CDS. Select the apparatus test to view in the 
right-hand pane.

The Copy icon, used to copy selected files to 
another directory.

The Delete icon, used to delete one or more 
selected files.

The E-mail Dataset icon, which 
automatically places one or more selected 
files in an E-mail as attachments, making it 
easy to E-mail test results to Doble or 
others.

The Print icon. Prints the list of datasets in 
the currently selected directory.

The Help icon.
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4. Send To: choose Mail Recipient to create an E-mail with one or more 
selected Apparatus files attached, or Folder to place selected Apparatus 
files in another directory.

5. Clone: Use this function to clone duplicate apparatus, such as spare 
bushings, single phase transformers, or several breakers of a kind (see 
”Cloning” on page 4-3).

6. Update: Used to update the following fields where needed: Division, 
Company, and Location.

7. Print: print the full list of displayed Apparatus files (see ”Printing” 
on page 4-4).

Edit 1. Refresh List: Re-display the right-hand panel

2. Select All: selects all Apparatus files in the current directory

Tools 1. Configure: Contains the following DTA configuration items:

• Company: the contents of this field are automatically placed in the 
Company field.

• Data Entry Mode: select automatic (M4000), where the test set enters 
the data for you, or Manual, when you want to enter some test data 
manually from old test-data sheets.

• Frequency: Select a test frequency of 50 or 60 Hz.
• Filename Based On: Although the new XML file structure allows the 

user to modify the filename for each apparatus, the default filename is 
based on either Serial Number, Special ID, or both, or Serial Number 
and Circuit Designation or Special ID and Circuit Designation, as 
chosen here by the user.

• Use Temp Probe: Require or not the use of the temperature/humidity 
probe.

• Ask Tested By On New Test: If set to Yes, a pop-up window will 
appear when you create a new test data in an existing file, with the 
Tested By field ready to fill in.

• Restrict Location Entries to Choice Lists: If set to yes, requires user 
to obtain the entry for the Location field from the available choice list, 
rather than allowing manual entry.

2. Edit Choice List: Allows user to set up or modify choice lists for the 
Location, Division, and Company fields. This helps testers when entering 
information in these fields, allowing for a more uniform set of entry data.

3. Purge Deleted Files: After deleting a file with File/Delete, remove it from 
your computer with this command.
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4. Recover Deleted Files: After deleting a file, recover it with this 
command.

5. Clear Source Directory List: clears all previous directory paths, leaving 
only the current one.

Window If more than one window is open, allows the user to select the window to view 
(main screen or apparatus test screen).

Help Contains the help file and the software version number.

What’s New
The DTA Field System program contains these new features:

1. New Windows Explorer-style layout, making it easier to view and select 
apparatus tests

2. All available tests for an apparatus are now easy to see and select from 
tabs shown on one screen; and all nameplate data screens are similarly 
available.

3. Transformer Leakage Reactance test forms are now included. Prior test 
data may be entered manually.

4. Exciting Current screen now shows whether the current measured is 
capacitive or inductive, important in the analysis of the current patterns.

5. A new format (XML) has been introduced for test data, replacing the old 
CDS format. Now, the files are recognizable in Windows Explorer. Files 
can be transferred among directories with Windows Explorer without fear 
of overwriting, since each file has a unique name based on apparatus 
Serial Number, Special ID, or both. See details below. When you open a 
file with the older CDS format, DTA will then save it in the new XML 
format and rename the old file with an x (instead of A) extension, so that it 
will still exist, but not appear in the old DTA version without using a 
Recover command. With the XML file structure, the user can accept the 
default names given to each apparatus, or change the names to any other.

6. New forms have been introduced for Coupling Capacitor Potential 
Devices, enabling the user to choose the form based on the number of 
porcelain units in the stack, and on the type of base box (air-filled, 
accessible POT terminal, or oil-filled inaccessible POT terminal).

7. The Live Tank Breaker forms now include CT forms, for testing the CT’s 
associated with these breakers, including Serial Number fields for each 
CT.
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8. Mandatory ID fields now clearly marked on nameplate ID screen with an 
asterisk (*).

9. Important new data fields have been added, such as water moisture 
content, temperature, and percent saturation (automatically calculated 
from the previous two items). Oil quality and DGA fields are now part of 
DTA.

10. Surge Arrester nameplate fields for Unit and Overall Catalog numbers 
have been added, allowing the user to determine the arrester type at a 
glance.

11. New clearer method for replacement of bushings and arresters exists, 
which allows the user to see both the old and the new unit’s data.

12. An increased number of bushings can now be associated with a 
transformer.

13. New Print templates.

14. The History function now displays all historical data.

15. You can cause the DTA expert system to ignore a row of data by placing 
an X in the second insulation rating column.

16. The Test By setting causes a pop-up window with the Tested By field to 
display when creating a new test date, facilitating entry of the tester’s 
identification.

17. Easier editing of Company, Location, and Division files, and ability to 
restrict entries into the Location field to choice list only.

18. Reason For Testing list increased.

19. It is now possible to delete an individual line of test data.

20. You can show or enter temperature data in F or in C.

New File Names
All files will now have an XML extension. The file name will consist of the 
apparatus serial number, Special ID, or both, in either order, as well as 
either Serial Number or Special ID combined with the CCT Designation 
field (user configurable) with all symbols removed, followed by an 
underscore “_” character, followed by a representation of the apparatus 
type. Following is a table showing the old and new file name extensions:
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Apparatus Old File Name New File Name 
Extension

Autotransformer w/o Tertiary xxxxxxxx.A11 s/n_XA.XML

Autotransformer w/ Tertiary xxxxxxxx.A12 s/n_AT.XML

Two-Winding Transformer xxxxxxxx.A13 s/n_X2.XML

Three-Winding Transformer xxxxxxxx.A14 s/n_X3.XML

Voltage Regulator xxxxxxxx.A15 s/n_VR.XML

Oil Circuit Breaker xxxxxxxx.A21 s/n_BO.XML

Live Tank Breaker xxxxxxxx.A23 s/n_BX.XML

Air-magnetic Breaker xxxxxxxx.A25 s/n_BA.XML

Air Blast Breaker xxxxxxxx.A26 s/n_BL.XML

Vacuum Breaker xxxxxxxx.A27 s/n_BV.XML

Recloser xxxxxxxx.A29 s/n_RC.XML

Dead-tank SF6 Breaker xxxxxxxx.A2B s/n_BS.XML

Potential Transformer, Single 
Phase Metering Outfit

xxxxxxxx.A31 s/n_PT.XML

Current Transformer xxxxxxxx.A35 s/n_CT.XML

Coupling Capacitor xxxxxxxx.A41 s/n_CC.XML

Surge Arrester xxxxxxxx.A51 s/n_SA.XML

Rotating Machinery xxxxxxxx.A60 s/n_RM.XML

Spare Bushing xxxxxxxx.A71 s/n_SB.XML

Cables and Terminations xxxxxxxx.A81 s/n_CP.XML

Miscellaneous xxxxxxxx.A99 s/n_MS.XML
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2. Apparatus Test Forms

Overview
Each apparatus file consists of one or more tests entered in electronic forms. 
The forms include at least an identification page, used to identify the 
apparatus, and an overall test page, where tests are performed on the main 
apparatus. Additional forms are available as part of the file for related tests, 
such as bushing C1 and C2 tests, hot collar tests, ratio tests, exciting current 
tests, oil tests, other miscellaneous tests, and a separate “diagnostics” sheet for 
performing unique tests specified by the user. The test data for each test date is 
contained separately in the file, and the various test dates can be compared 
using the History and Next Date/Previous Date functions.

This is a list of existing forms:

Table 2.1  List of Apparatus Test Forms Available In DTA Field System

Apparatus

Autotransformer with tertiary

Autotransformer without tertiary

Cables and terminations

Coupling Capacitor

Current transformer

Dead Tank SF6 breaker

Live tank SF6, air, or minimum oil breaker

Medium Voltage air blast breaker

Medium voltage air magnetic breaker

Medium voltage vacuum breaker

Miscellaneous test form

Oil circuit breaker

Oil-filled reactor
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The Test Circuits Built Into The Apparatus Forms

Viewing The Default 
Tests

Most Apparatus forms have default circuits built into them, to speed testing. 
For example, the main test on a Current Transformer is a GST-Ground test, 
and the DTA CT form has this circuit programmed in as a default circuit for 
that test. To see the default test for each line of a form, simply place the cursor 

on that line and click the Run A Test  icon. Select Single Test. From the 
resulting Setup window, the test circuit for that line may be observed. To see 
the circuits for multiple lines, select Multiple Tests, refresh the screen with the 
Setup button, and enter the line numbers for which you wish to see the test 
circuits.

Figure 2.1  Setup Window

Potential transformer (and 1 Ph M.O.’s)

Recloser

Rotating machine

Spare bushing test form

Surge arrester

Three winding transformer

Two winding transformer

Voltage regulator

Table 2.1  List of Apparatus Test Forms Available In DTA Field System

Apparatus
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Modifying The 
Default Tests

You may need to modify these defaults. For example, you may wish to test a 
Current Transformer without detaching the Live Tank Breaker attached on one 
side and the Disconnect Switch attached on the other. To do this:

1. Attach Low Voltage Leads to both the Live Tank Breaker and the 
Disconnect Switch support insulators, and guard them both using a 
GST-Guard circuit.

2. To modify the default circuit, simply select the row on the DTA Apparatus 
form you wish to change. When ready to start the test, with the necessary 
Low Voltage Leads in place to guard the attached apparatus, click the Run 

A Test  icon. In the resulting Setup window, select the desired 
circuit (GST-Guard RB).

3. Click OK to run the modified test.

Placing The Guard 
Leads Or Hot Collar

The practice of guarding attached apparatus is described in the M4000 Test 
Procedures manual. Here are some basic rules:

1. You cannot place a guard lead at a point on the bus that is not separated 
from the point being energized, or ground, by an insulator or an open 
interrupter, or part of either.

2. If guarding a stack of support insulators, attach a Low Voltage Lead at a 
point between two units of porcelain in each involved stack.

3. If the support insulator stack has only one porcelain unit, then the guard is 
effected by wrapping a hot collar around that unit at a point that has been 
cleaned and dried beforehand, and attaching the collar to a Low Voltage 
Lead.

NOTE When connecting leads and collars, be aware of any overhead lines that 
may be live, and maintain safe clearances!

The following information applies to all the electronic forms:

Opening An Apparatus File

If There Are No Previous Tests In DTA For This Apparatus

Click the New  icon or select New from the File menu. You will be 
prompted to select an apparatus from the Create A New Test window.
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If A Previous Test Is Available In DTA
Select the apparatus in the right-hand pane, and click the Open icon, or select 
Open from the File menu. You may also double-click the apparatus in the 
right-hand pane. See Chapter One on how to display and sort your apparatus 
test files.

Icons Displayed With A File Open
When a file is opened, the following icons are shown along the top of the 
screen:

Table 2.2 Icons Displayed When An Open File Is Active

Icon Description

New File Create a new file from an apparatus choice 
list. Use also File/New.

Delete Delete the file(s) selected in the right-hand 
panel.

Save Saves a file. Use also File/Save.

Nameplate 
administration

View the reason for test, type of test set, 
manpower usage, administrative and test 
interval information. Use also View/Admin

View Note Position the cursor on the screen or line 
whose note you wish to view, and click. Use 
also View/Note. Shortcut key is F4.

Test conditions View test conditions, which include weather 
description, air temperature, apparatus (top 
oil) temperature, and humidity. Use also 
View/Test conditions.

Run a test Once on the desired test screen, click to 
initiate a test (single or multiple). Shortcut 
key for automatic test is F2.
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Menu Items Displayed For Open Files

File
1. New: Start a new test date for an apparatus already in DTA.

2. Delete: Deletes the active dataset.

3. Save: Saves the current test date nameplate and test data.

4. Print Standard: Prints all of the nameplate and test data.

5. Print Custom: Provides a choice list of items to select for printing. This 
can be saved for each type of apparatus, to make printed reports uniform 
and contain only the required data.

6. Exit: Close the currently opened file.

Send To Select one or more files, then click to a) 
send selected file(s) to another folder, or b) 
attach selected file(s) to an E-mail

Help Click and point to desired area for help

 First Test Date View first test date results

 Previous Test Date View previous test date

 Next Test Date View next test date, or create a new test

Last Test Date View latest test date results

Close Form Closes the active dataset

Table 2.2 Icons Displayed When An Open File Is Active

Icon Description
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View
1. Advice: Place the cursor on the line of test data for which an explanation 

of the rating is desired, and select this command to see the DTA expert 
system analysis. Shortcut key is F5.

2. Note: Place the cursor on the screen or line whose note you wish to view, 

and select this command or click the  icon. Shortcut key is F4.

3. Test Conditions: Place the cursor on the screen or line of test data for 
which you wish to view test conditions, and select this command, or click 

the  icon.

4. Admin: View the administrative information associated with the test date, 
such as test set type, reason for test, manpower usage, order numbers, and 

names of testers; or, click the  icon.

5. Layout: View apparatus layout for purpose of labeling location of 
bushings and apparatus configuration. Includes vector diagram of 
transformers. This feature is not available for all apparatus.

6. Tooltip: Check or uncheck this feature to activate or de-activate it. It adds 
a description of the icon over which the cursor is hovering.

Test
To be active, a test screen must be displayed. The commands include:

1. Run Test-M4000: run a single or multiple test using the M4000. Shortcut 
key is F2.

2. Run Test-Manual: displays the reversal data, including meter readings an 
scales selected, for current, watts, and capacitance. Use this command to 
enter data manually from a paper sheet.

3. Previous Test: view the previous test date, if any.

4. Next Test: view the next test date, if any.

5. Recalculate: After all data is entered on a selected screen, use this 
command to cause the expert system to reconsider all the data on that page 
as a whole. Shortcut key is F9.
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6. History: Allows the user to view all test dates for a selected row of test 
data, in order to view the trend of the data over time. It requires that there 
be more than one test for a chosen apparatus, as indicated on the 
right-hand panel of the main DTA Explorer screen, under the “#” column. 
To use this feature:

• Open an apparatus with more than one test date (a number greater than 
1 under the “#” column).

• Select a row of test data for which you want to view all available test 
dates at once in order to view its trend over time.

• Select the History item, and the Test History window will appear, 
showing all test data for that row over time.

• If you wish to view move from one test date to another, select the row 
in the Test History window representing the date you wish to view, 
and click the Move To button.

• The shortcut key is F3.
7. Clear Line: Clears all data from the line on which the cursor is placed. 

Useful for removing unwanted data, or for removing a single test from an 
otherwise acceptable page of data. The user may also leave the data on the 
line, but prevent the Expert System from considering it. See”Flags” 
on page 1-6.

Tools
Edit Choice Lists: Allows user to edit the Location, Division, and Company 
choice lists.

Window
If a test screen is open along with the main screen, allows user to select which 
screen to view.

Help
Access the Help file, or view the software version number. Shortcut key is F1.
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Data Entry

Nameplate Data
There may be more than one nameplate data entry screen. When an apparatus 
file is opened, as described above, the default screen shown is the 
Nameplate/Main, or in the case of surge arresters, just the Nameplate screen. 
When the Nameplate tab along the top of the electronic form is selected, the 
tabs along the bottom of the electronic form show the various nameplate data 
entry screens, such as Main, Bushing, Arrester, Tap Changer, and Leakage 
Reactance, as applicable to the apparatus.

NOTE You may want to enter some fields while back at the office, so as not to 
have to spend time doing it in the field. Such things as tap positions and 
voltages, or hot collar test circuits and skirt choice, may be filled out 
ahead of time, providing the test kV is entered on the rows to be saved. 
Without the test kV, such preparatory work will be lost when the dataset 
is closed.

Test Data
Test data is entered on the various screens as indicated by the tabs along the 
top of the electronic forms, which can be selected as desired. The nameplate 
data should be entered before starting the test.

Special Entry Fields
Fields that require entry from a choice list are identified by the down arrow to 
the right of the field and cannot be entered manually; the down arrow must be 
clicked to display the choice list.

DTA Screens
Each Apparatus has a series of screens for testing and identification, some of 
which are common to more than one apparatus. Following are descriptions of 
the individual screens.

Nameplate Administration
This window is available to all apparatus, and is opened from the View menu 

once an apparatus form has been selected, or by clicking the  icon. the 
following window appears:
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Figure 2.2  Nameplate Administration window

Some of the fields include:

• Checked by: When this field is filled in, the “A” flag (accepted) is set, 
and will show up on the main DTA screen in the Flags column.

• Reason: The reason for the test. It is helpful to include the test reason, 
so as to be able to search for particular reasons, such as Fault 
Operation or Acceptance. This field is also found directly on the main 
screen.

• Retest Date: Allows the user to set a date for the retesting of a 
questionable apparatus. This date is assumed to be sooner than the date 
of the normal test cycle. An entry here sets the “T” flag, and will show 
up on the main DTA screen in the Flags column.

• Test Set Type: Record the type of test set used. For manual entry, the 
default format is for 10 kV data (M4000, MH, M2H). If manually 
entering 2.5 kV (MEU) data, you must first select MEU in this field.

• Travel Time & Duration: These allow the user to keep track of 
manpower used for the testing process.

The Identification Screen
There are ID screens for the main apparatus, for its bushings, its surge 
arresters, if any, its tap changers, if any, and for nameplate impedance 
information used with the leakage reactance tests on transformers. Fill in all 
that is possible. Some fields are required to activate temperature correction 
factors:
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Some are required to enable DTAF to find the apparatus limit files:

All of these required fields are marked with an asterisk (*) on the nameplate 
screens.

Table 2.3  Fields Required On ID Screen To Activate Temperature 
Correction Factors

Apparatus Fields Required On Identification Screen

Power Transformers The left-most field for kV and kVA, 
Coolant, Tank Type, Year of Manufacture

Instrument transformers Insulation Type (for tests 2 and 3)

Bushings Manufacturer, Type, kV

Oil Circuit Breakers Bushing type and manufacturer

Voltage regulators Tank type

All other apparatus No temperature correction factor applied

Table 2.4  Fields Required On ID Screen To Enable Limit Files

Apparatus Fields Required On The Identification 
Screen

Power Transformers Left-most field for kV and kVA, Coolant, 
Tank type

Instrument transformers, 
bushings, circuit breakers, 
voltage regulators, and 
reclosers

Manufacturer, Type, kV

Cables Manufacturer, Insulation type

Surge Arresters Manufacturer, Unit or Overall catalog 
number
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Arrester Nameplate

Figure 2.3  Arrester Nameplate Screen

1. To enter arrester nameplate data as part of a transformer form, make sure 
the Nameplate tab above and the Arrester tab below are selected. Or, in the 
case of a stand alone arrester form, the Nameplate tab above should be 
selected.

2. Click Add Arrester.

Figure 2.4  Add An Arrester Window

3. Identify the Location of the arrester unit (top, middle, bottom, which 
phase), and the Serial Number.
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4. Select the manufacturer from the choice list by clicking the down arrow.

5. Find the Overall or Unit catalog number of the arrester. If the stack is 
made up of only one unit, there is only an overall catalog number. If the 
stack is made up of two or more units, the bottom unit in the stack will 
have both a unit and an overall catalog number, and the others will have a 
unit number. Try to obtain all the unit numbers to enter into DTA 
(although the overall catalog number will do).

NOTE Without an Overall or Unit catalog number, the limit file for the arrester 
cannot be found and DTAF will not be able to compare test results to the 
expected limits.

6. Once the unit or overall catalog number has been entered, DTA will 
automatically enter the rated and the test kV. You are ready to test.

7. To save time adding arrester nameplate data for identical arresters, select 
the row containing the arrester you wish to copy, and then click the Clone 
Arrester button. The pop-up window will appear already filled in with the 
data from the selected arrester, and the user only needs to change data 
particular to this new arrester, such as serial number and location.

8. Use the Modify or Delete buttons to modify or delete arrester information. 
An arrester can be deleted only if there is no test data associated with it.

9. To replace an arrester, see”Replacing A Bushing Or Surge Arrester” 
on page 4-7.

Bushing Nameplate

Figure 2.5  Bushing Nameplate Screen

1. To enter bushing nameplate data as part of another apparatus form, make 
sure the Nameplate tab above and the Bushing tab below are selected. Or, 
in the case of a S pare Bushing form, select the Nameplate tab; the 
Dimensions tab may also be selected for additional bushing information.
2-12 72A-1260   Rev. G



Doble Test Assistant Field System User Guide

Se
pt

em
be

r 1
3,

 2
00

5

2. Click the Add Bushing button.

Figure 2.6  Add A Bushing Window

3. Select the bushing designation from the Designation pull-down list, then 
add its serial number. If desired, the bushing designation can be 
user-configured.

4. Select the bushing manufacturer and type from the next two pull-down 
lists.

5. For bushings with test or potential taps, fill in the nameplate C1 and C2 
power factor and capacitance, if available.

6. Fill in the kV and amperage rating, as well as the year of manufacture.

NOTE Bushing Manufacturer, Type, and kV must be filled in to enable the 
DTAF expert system to find the limit files and to perform a complete 
expert analysis. Nameplate Capacitance and Percent Power Factor should 
also be filled in for comparison of test results to nameplate data. All are 
required for full evaluation of oil circuit breakers!

7. Different manufacturers will supply information such as Catalog or Class. 
Fill these in if applicable.

8. The Tap column will have an X in it if the bushing type as described in 
DTAF’s limit file is known to have a test or potential tap.

9. Click the Bushing Dimensions button if you wish to save this information 
in this apparatus file.

10. To save time adding bushing nameplate data for identical bushings, select 
the row containing the bushing you wish to copy, and then click the Clone 
Bushing button. The pop-up window will appear already filled in with the 
data from the selected bushing, and the user only needs to change data 
particular to this new bushing, such as serial number and nameplate 
capacitance and power factor.
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11. Use the Modify or Delete buttons to modify or delete bushing information. 
A bushing can be deleted only if there is no test data associated with it.

12. To replace a bushing, see”Replacing A Bushing Or Surge Arrester” 
on page 4-7.

Bushing Dimensions The bushing dimensions screen is reached by clicking the Add a Bushing 
button. If a bushing already exists, use the Modify a Bushing button. Click the 
Bushing Dimension button to display the screen.

Capacitor Nameplate 
(CCPD’s)

There is a Main and a Capacitor nameplate screen. On the Main screen, enter 
at least Manufacturer and Type. Use the Cap Arrangement field to choose the 
type of CCPD being tested: oil-filled or air-filled base, and number of 
porcelains in the stack (1-6). Modern CCPD’s will use arrangement numbers 
1-6, according to the number of porcelain units in the stack.

Figure 2.7  CCPD Main Nameplate Screen

On the Capacitor screen, enter the nameplate value for each capacitor. Note 
that the bottom-most porcelain unit has two capacitors: C2 (CAR to POT) is 
the lower one and C1-1 (POT to B1) the upper one. The base box may show the 
nameplate value for only C2, and a combined value for C2 and C1-1. In this 
case, you will have to use those two values to calculate C1-1. This combined 
value would be the B1-CAR measurement. For some older CCPD’s, the 
manufacturer may give a single value for the whole column.

NOTE Some CCVT nameplates will be given in microFarads (µF), while DTA 
works with picoFarads (pF). The former will have values like.018, which 
must be multiplied by 106 before inputting to DTA. 0.018 µF becomes 
18,000 pF.
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Figure 2.8  CCPD Capacitor Nameplate Screen

Capacitor Nameplate 
(Live Tank Breakers)

Enter the manufacturer and type, as well as the capacitance in picofarads and 
percent power factor, if available. This information is found on the porcelain 
housing containing the capacitor near the top of the breaker.

Leakage Reactance 
Nameplate

With the Nameplate and Leakage Reactance tabs selected, enter the tap 
positions on which the tests will be made, as well as the base MVA, KV, and 
% Impedance for each pair of windings to be tested, from the nameplate. For 
three winding transformers, where there are three pairs of windings, NP data 
may be entered for all three using the tabs High to Low, or H to X, Low to 
Tertiary, or X to Y, and High to Tertiary, or H to Y.

NOTE You must make entries in the DETC and LTC fields, even if they are 
None or N/A. In addition, you must then click the top Leakage Reactance 
tab which takes you to the Leakage Reactance test screen, and enter 
benchmark percent impedance and reactance before starting a test, as 
shown in Figure 2.9 and Figure 2.10 below.

Figure 2.9  Leakage Reactance Nameplate Screen
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Benchmark test data is entered separately on the Leakage Reactance test 
screen, for both Impedance and Reactance, each on their corresponding tabs. 
Identify the phases, including bushing designations. See ”Leakage Reactance 
Test Screen” on page 2-41.

Figure 2.10  Leakage Reactance Test Screen: Benchmark Data

NOTE The transformer nameplate impedance will be given for a particular base 
voltage. You must determine which tap position(s) this voltage represents 
(as indicated on the nameplate), and perform the test on the same tap(s) if 
you wish to be able to compare field and factory test results. Typically, 
this might be the middle tap of the De-energized Tap Changer, and the 
Neutral tap position of the On-load Tap Changer, if there is one.

Main Nameplate 
(Power 
Transformers)

Figure 2.11  Two Winding Transformer Nameplate Screen

Main nameplate fields include (for transformers):
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Configuration: The winding configuration of the transformer. If it is a single 
phase transformer, select 1-PHASE. If its high voltage winding is a Delta and 
its low voltage winding is a Wye, select D-Y.

Coolant: When Air-Open or Air-Encapsulated are chosen, as with a dry-type 
transformer, the expert system is inactive on the overall test screen.

kV: The field on the left is for the higher rating (H winding), the one on the 
right for the lower one (X winding). A third field would be for the tertiary (Y 
winding). You must fill in at least the left-most kV field.

Special ID: this is an identification sometimes given to apparatus by a 
company for operational or inventory purposes.

CCT Designation: This is short for circuit designation, and can be used if the 
company wishes to include with the other nameplate data the circuit on which 
the apparatus is connected.

MVA/KVA: There are 5 fields here, and at least the first one on the left must 
be filled in, as it represents the OA or base rating of the transformer. The next 
three fields are for increasing values of MVA/KVA at various cooling stages. 
The last field is to assign units to the rating, KVA or MVA.

Class: For transformers, this refers to cooling stages, and the field contains a 
choice list accessed by pressing the down arrow to the right of the field. 
Manual entry is also possible.

App Temp: In the case of a transformer, enter the top oil temperature. For 
other apparatus, this field is either not applicable (N/A) or should be filled in 
with the ambient temperature. You must fill in this field to activate the 
temperature correction function.

Year Of Manufacture: Transformer nameplates do not carry this 
information. Use the year of manufacturer from one of the transformer’s 
bushings. At least an approximate year must be used to activate the 
temperature correction factor function.

Layout: Record with the test data the orientation of the bushings with respect 
to the tap changer mechanisms, as well as the nameplate vector diagram, by 
clicking the Windings button on the Layout window. Access this function from 
the View menu.
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Figure 2.12  Transformer Layout Window

Figure 2.13  Transformer Winding Relationship

Main Nameplate 
(Breakers, 
Instrument 
Transformers, and 
Voltage Regulators)

Main nameplate fields include the following:
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Figure 2.14  Live Tank Breaker Nameplate Screen

Type: The apparatus type in the list of choices may not match your apparatus 
down to the last slash or extension, but it is only necessary to match by type 
and kV, and, preferably, interrupting rating.

kV: It is important to enter the nameplate kV, so that the expert system will be 
able to identify the breaker correctly. If a system kV is used instead, the 
apparatus limit file may not be found.

NOTE Live Tank Breaker forms include room to enter nameplate and test data 
for three free standing CT’s that may be associated with them.

Layout (Live Tank Breakers): Determines the number of interrupters per 
phase in terms of Modules (a Module is a set of 2 interrupters on an insulating 
column). A typical candlestick breaker is layout 7. Must be selected before 
commencing test. View selected Layout from View menu.

Figure 2.15  Layout Window, Live Tank Breakers
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Layout: (Most Breakers): Orients the user as to bushing number and phase 
relative to control cabinet. Select this function from the View menu.

Figure 2.16  Layout Window, Most Breakers

Main Nameplate 
(Miscellaneous)

This form is for testing other apparatus for which there is no electronic form. 
Test Metering Outfits in the PT form, but other items, such as busbars or post 
insulators should be tested in this form, using the Description field to identify 
the apparatus.

Main Nameplate 
(Rotating 
Machinery)

Figure 2.17  Rotating Machinery Nameplate

Config: This sets the overall test screen to conform to your type of machine, 
as defined by the number of terminals available. Typical choice is 3-Phase, 
6-Terminal.

Cooling: This field is found on the NP Detail tab, as is H2 Pressure.

Ins Type: This describes the type of insulation, and the evaluation of the test 
results depends on this selection.
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Global VPI: Distinguishes machines manufactured using this process, the 
vacuum pressure impregnation and curing of the completely wound and 
connected stator winding.

Tight compact construction

Tap Changer 
Nameplate

With the Nameplate and Tap Changer tabs selected, enter the manufacturer. If 
known, enter the Type of tap changer, and the position of the taps during the 
tests.

Nameplate 
Administration

To enter information here, click the Nameplate Administration icon . 
This information includes the type of test set used (especially necessary if 
entering data manually), reason for test, administrative information such as 
work order or purchase order, and manpower issues such as travel time, 
duration of test, and who did the testing.

View Note The note function allows the tester’s comments to be included with the 
nameplate data and test results. The comments are usually included to explain 
an unusual circumstance of the test conditions, such as presence of snow or 
humidity, or the inability to remove attached bus for the test, or to note a 
condition than needs future attention, such as a chipped porcelain or an oil 
leak. It should also be used to record an apparatus type when it can’t be found 
in the DTA’s choice lists. A separate note is available for each line of test data, 
as well as for the overall nameplate data screen. Select this function by 
positioning the cursor on the screen or line of test data with which the note 

should be associated, and click the note icon  or press F4.

The Apparatus Overall Test Screen
This is where the test is performed on the main apparatus. The tests are usually 
already set up, including the circuits, and the user has only to a) make the test 
connections between the test set and the apparatus under test, including a 
ground connection between the test set and apparatus under test, b) enter the 

appropriate test kV, and c) click the  icon or press F2 to start a test. A 
window appears with a choice of single or multiple tests.
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Figure 2.18  Setup Window Appears Prior To Test

You can confirm which row you will start on by clicking the Setup button in 
that window (if the cursor isn’t placed on any row, the tests will begin on the 
first row of tests). There you can also set up your multiple tests, enter test kV, 
and confirm the test circuits which will be used. In some cases where both the 
red and blue low voltage leads are used, DTAF will prompt you to indicate 
where each color lead has been placed. The grayed-out area at the left-hand 
side of the test screen indicates how to connect the cables and/or the circuit 
being used as a default. For transformers, the insulation your are measuring 
shows up in the Measure column.

NOTE If you wish to perform your tests using a different test circuit than the 
default choices, it is here that you can set up the circuits as you wish to 
test. However, not all apparatus support this function.

It is the usual practice to run multiple tests whenever possible, and multiple 
tests will be discussed for each individual apparatus.

Autotransformer 
With Tertiary

1. If the tertiary is accessible, it is treated as a second winding. Both the main 
winding and the tertiary are each short-circuited separately by tying 
together all H and X bushings on the main winding, and, separately, all Y 
bushings on the tertiary. All grounded bushings are disconnected from 
ground.

2. First, the main winding is energized, with the low voltage lead on the 
tertiary. A multiple test is run on rows 1-3.

3. Next, the tertiary winding is energized, with the low voltage lead on the 
main winding. Another multiple test is run on rows 5-7.

Autotransformer 
Without Tertiary

1. The bushings are tied together to short-circuit the winding, Any grounded 
bushings are disconnected from ground.

2. The winding is energized and a GST-Ground circuit is used for the one 
test. No multiple tests are possible.
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Air Magnetic 
Breaker

Air magnetic breakers include an arc chute, a source of contamination greatly 
affecting the test results. It may be necessary in some cases to repeat the tests 
with the arc chutes removed, in order to confirm the source of contamination.

1. With the breaker open, energize bushing 1, with the low voltage lead on 
the opposite bushing 2, using a multiple test for rows 1 and 7.

2. Swap the high voltage and the low voltage leads, and energize bushing 2, 
running a single test for row 2.

3. Energize bushing 3 with the low voltage lead on bushing 4, and run a 
multiple test for rows 3 and 8.

4. Swap the high voltage and low voltage leads, and energize bushing 4, 
running a single test for row 4.

5. Energize bushing 5 with the low voltage lead on bushing 6, and run a 
multiple test for rows 5 and 9.

6. Swap the high voltage and low voltage leads and energize bushing 6, 
running a test for row 6.

Air Blast Breaker 1. With the breaker open, energize each bushing one at a time, running six 
single tests for rows 1-6. No Low Voltage lead is needed.

2. With the breaker closed, energize one phase at a time, running three single 
tests for rows 7-9. No Low Voltage lead is needed.

Cables and 
Terminations

If the cables are shielded, measurements may be made between the conductor 
of each phase and its grounded shield with a GST-Ground test. If the cables 
are unshielded, measurements may be made between the phases with a UST 
circuit.

CCPD CCPD forms are customized for various configurations. Older GE and W units 
had air-filled base boxes with accessible POT and CAR bushings (the POT 
bushing was the bigger of the two). For these, select Cap Arrangements 7-12, 
depending on the number of porcelain units in the stack. Modern CCPD’s 
have oil-filled base boxes without access to the POT terminal. The CAR 
terminal for these units is accessible in the secondary connections box. For 
these, select Cap Arrangements 1-6.
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Figure 2.19  CCPD Test Screen, Oil-Filled Base, Two Porcelain Units

Select the Capacitor Arrangement you are testing on the CCPD Main 
Nameplate screen. The overall test screen appearance depends on what 
selection is made. To test a modern CCPD with oil-filled base and no 
accessible POT terminal:

1. If the stack contains 3 or more porcelain units, leave the line terminal 
connected to the top and ground it for testing. If the stack contains only 1 
or 2, the line terminal must be removed for test.

2. Close the Potential Grounding Switch.

3. To test the C2 capacitor, energize the CAR terminal (after disconnecting it 
from ground) at 2 kV, then replace the CAR lead.

4. To test C1-1 (in the same porcelain unit as C2), energize the top of the 
porcelain unit at 10 kV.

5. To test the capacitor in the second porcelain unit, energize the point 
between the bottom-most and the second porcelain units, place a Low 
Voltage lead on the top of the second porcelain unit, and measure it with a 
UST test (this assumes the top of the second porcelain is not grounded).

6. On the overall test screen, click the Show Test Procedure button for 
details.

Current Transformer 1. Ground one end of each secondary. Energize the CT primary and perform 
one test for row 1. If the test voltage will be greater than 2 kV, perform a 
multiple test for rows 1 and 4.

2. If the CT has a test tap, place a low voltage lead on the tap, and energize 
the primary, running a single test for line 2.

3. To run the C2 test on the tap, connect the high voltage lead to the tap and 
place the low voltage lead on the CT primary.
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4. Energize the tap at no more than its rating (500 volts for CT’s rated up to 
and including 69 kV, and 2 kV for those rated higher than 69 kV. Run a 
single test for line 3.

Dead Tank SF6 
Breaker

Multiple tests may be used on tests 1, 3, and 5 to save time.

NOTE: Since using a multiple test requires that a guard circuit be used instead of 
a ground circuit, the test results will be different from those for a single 
test for tests 1, 3, and 5! It may be more difficult to make comparisons for 
purposes of analysis of results.

If you prefer not to use multiple tests, test as follows:

1. With the breaker open, energize bushing 1, float bushing 2 for row 1.

2. Energize bushing 2, float bushing 1 for row 2.

3. Energize bushing 3 and float bushing 4 for row 3.

4. Energize bushing 4 and float bushing 3 for row 4.

5. Energize bushing 5 and float bushing 6 for row 5.

6. Energize bushing 6 and float bushing 5 for row 6.

7. Energize bushing 1 and place the LV lead on bushing 2 for row 7.

8. Energize bushing 3 and place the LV lead on bushing 4 for row 8.

9. Energize bushing 5 and place the LV lead on bushing 6 for row 9.

To use the multiple tests option:

1. With the breaker open, energize bushing 1, with the low voltage lead on 
the opposite bushing 2, using a multiple test for rows 1 and 7.

2. Swap the high voltage and the low voltage leads, and energize bushing 2, 
running a single test for row 2.

3. Energize bushing 3 with the low voltage lead on bushing 4, and run a 
multiple test for rows 3 and 8.

4. Swap the high voltage and low voltage leads, and energize bushing 4, 
running a single test for row 4.

5. Energize bushing 5 with the low voltage lead on bushing 6, and run a 
multiple test for rows 5 and 9.

6. Swap the high voltage and low voltage leads and energize bushing 6, 
running a test for row 6.

7. If the breaker has more than one interrupter per phase, with a support 
insulator between the two interrupters that you wish to test, first close the 
breaker.
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8. Perform three single tests, energizing one phase at a time, to fill rows 
10-12.

Live Tank Breaker The overall test form depends on the configuration of your circuit breaker and 
the number of interrupters per phase. Multiple tests will be made on each set 
of 1 or 2 interrupters and its corresponding porcelain support column, with 
each interrupter and the column being tested separately. Remember, you can 
test 3 free-standing CT’s associated with this breaker using this same 
apparatus file; see ”Current Transformer” on page 2-24.

1. If you are testing a candlestick breaker, you will run a multiple of 2 tests, 
one for the interrupter (C1) and one for the column (S1). Repeat for each 
phase.

• Place the high voltage cable at the junction between the support 
column and the interrupter.

• Place the low voltage lead at the top of the interrupter.
• In DTA, select layout 7. Perform a multiple test to include C1 and S1. 

Test C1 with a UST circuit and S1 with a GST-Guard. Repeat for each 
phase.

2. If your live tank breaker has more than one break per phase, test in groups 
of two interrupters and their corresponding support column. If your 
breaker has 2 breaks per phase, test C1, C2, and S1 together with a 
multiple test of three. If it has 3 breaks per phase, test C1, C2, and S1 
together in a multiple test of 3, and then test C3 (and S2, if it exists) in 
another single or multiple test. Repeat for each phase. If the breaker has 4 
breaks per phase, test C1, C2, and S1 with a multiple test of 3, and test C3, 
C4, and S2 with another multiple test of 3. Repeat for each phase. For each 
multiple test of 3:

• Select the DTA layout that displays the correct number of interrupters 
per phase on the overall test screen.

• Place the high voltage lead on the metal junction between the two 
horizontal porcelains containing the interrupters.

• Place one low voltage lead each on the opposite ends of the two 
horizontal porcelains.

• Perform a separate UST test on each of the two porcelains (for 
example, UST-R for C1, UST-B for C2), and then GST-Guard both 
low voltage leads to get the column (S1). Do this with a multiple test 
of 3. DTA will select all the circuits for you, as long as you follow the 
on-screen prompts asking where you have placed each Low Voltage 
Lead.

• Repeat for each group of 2 contacts and their support column, and for 
each phase.
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Miscellaneous This form has no test circuits or expert system imbedded in the forms, and 
may be used to preserve other types of test data (such as oil DGA tests or 
contact resistance tests) together with the Doble test data.

Oil Circuit Breaker 1. With the circuit breaker open, energize each of the six bushings, one by 
one, and run a single test for each one, filling rows 1-6. No Low Voltage 
lead is needed.

2. Close the breaker. Energize one phase at a time, running 3 single tests to 
fill rows 7-9. No Low Voltage lead is needed.

NOTE For full analysis of an Oil Circuit Breaker, the user must fill in the 
following bushing nameplate information: Manufacturer, type, kV, and 
power factor.

Potential 
Transformer (and 
Single Phase 
Metering Outfits)

1. For a single phase PT or Metering Outfit, tie the line and neutral (or both 
line) bushings together. If it is a phase to ground PT or MO, make sure the 
neutral is disconnected from ground. Make sure one end of each secondary 
is grounded.

2. Energize the primary at a test voltage not to exceed the rating of the 
neutral bushing, if there is one. Use a single test for row 1 if the test 
voltage is 2 kV. use a multiple test for rows 1 and 6 if a higher test voltage 
will be used for test 1.

3. Remove the jumper between the two bushings.

4. Energize H1 with the low voltage lead on H2, and run a multiple test for 
rows 2 and 7.

5. Swap the high and low voltage leads, and energize H2, running a multiple 
test for lines 3 and 8.

NOTE If multiple tests are run for tests 2 and 7, and tests 3 and 8, the same test 
voltage must be used for both multiple tests, since tests 7 and 8 are 
exciting current tests and cannot be compared if different test voltages 
are used. If you have a line and a neutral bushing, and wish to test the line 
bushing at a higher voltage, consider doing single tests for rows 2 and 7.

Reactor 1. For oil-filled reactors, short-circuit each phase bushing to its neutral 
bushing separately for each phase. Remove all grounded bushings from 
ground.

2. Select the nomenclature you wish to use (A, B, C, 0, 4, 8, etc.) from the 
Ph. Names field. Choose whether phases are separable and will be tested 
separately or not in the Configuration field; the choice in this field 
determines the layout of the Overall test screen.
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3. Place the Red low voltage lead on phase B and Blue on phase C. Start by 
energizing phase A. You will run a multiple test on rows 1-3 (GST-Guard 
B, GST-Guard RB, UST R would be the circuits selected by DTA in this 
case).

4. DTA will ask you which winding has the Red and which the Blue Low 
Voltage Lead attached. Select according to your connections.

5. The Setup window then appears, and the user should select Multiple Tests 
(the Defaults, if available).

6. Click the Setup button to review the test voltages and circuits you are 
about to use. When satisfied, click the Run button to run the multiple tests 
for rows 1-3.

7. Rotate the leads so as to energize phase B, with Red on C and Blue on A, 
running a multiple test on rows 5-7 (GST-Guard B, GST-Guard RB, UST 
R would be the circuits selected by DTA in this case).

8. DTA will ask you which winding has the Red and which the Blue Low 
Voltage Lead attached. Select according to your connections.

9. The Setup window then appears, and the user should select Multiple Tests 
(the Defaults, if available).

10. Click the Setup button to review the test voltages and circuits you are 
about to use. When satisfied, click the Run button to run the multiple tests 
for rows 5-7.

11. Rotate the leads so as to energize phase C, with Red on A and Blue on B, 
and energize the C phase, running a multiple test on rows 9-11 
(GST-Guard B, GST-Guard RB, UST R would be the circuits selected by 
DTA in this case).

12. DTA will ask you which winding has the Red and which the Blue Low 
Voltage Lead attached. Select according to your connections.

13. The Setup window then appears, and the user should select Multiple Tests 
(the Defaults, if available).

14. Click the Setup button to review the test voltages and circuits you are 
about to use. When satisfied, click the Run button to run the multiple tests 
for rows 9-11.

15. For row 13, tie all bushings together, and energize A+B+C. No Low 
Voltage Leads are needed for this test.
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Recloser Figure 2.20  Reactor Test Connections Column At Left

1. With the recloser in the open position, energize one bushing at a time and 
perform six single tests to fill in rows 1-6.

2. Close the recloser and perform three more single tests, one per phase, to 
fill in rows 7-9.

3. Some reclosers, such as the W type PRC, may have an interrupter/resistor 
assembly connected between the lower terminals, making some of the 
tests difficult to analyze. In this case, with the recloser open again, 
energize bushing 1 with the low voltage lead on the opposite bushing of 
the same phase, bushing 2, using a UST circuit. Perform a single test for 
row 10. Move the high voltage lead to bushing 3 and the low voltage lead 
to bushing 4, and perform another single UST test for row 11. Finally, 
move the high voltage lead to bushing 5 and the low voltage lead to 
bushing 6, and perform one last single UST test for row 12. Or, if 
preferred, perform multiple tests for rows 1 and 10, 3 and 11, and 5 and 12, 
by energizing bushing 1 with the LV lead on bushing 2, energize 3 with 
the LV lead on bushing 4, and energize 5 with the LV lead on 6. Tests on 
bushings 2, 4, and 6 would then be single tests with no LV lead involved. 
The tests in rows 10-12 are a measurement of the losses across the 
interrupter/resistor assembly, and power factor is not calculated.

Rotating Machinery The most common configuration encountered is a six terminal machine (3 line 
and 3 neutral terminals. This configuration must first be selected on the 
Nameplate screen.

1. Disconnect the neutral terminals, so that each phase may be tested 
separately.
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2. The following auxiliary apparatus is also grounded to the machine 
frame: stator resistance temperature detectors (RTD) and 
thermocouples (TC), auxiliary stator windings and any other devices 
associated with the stator winding, current transformer secondary 
windings, rotor winding terminals and shaft.

3. Energize a phase, grounding the other two with the low voltage leads (a 
GST-Ground circuit is used). Do each test at several voltages between 2 
kV and the rated line-to-ground voltage rating of the machine (for a 13.8 
kV machine, test at 2, 4, 6, and 8 kV). See the Doble Test Procedures 
manual for more on test voltages.

4. While energizing the same phase, use a UST circuit to measure the end 
turn insulation between the energized phase and the next phase (say, A-B).

5. Repeat for each phase, using the GST-Ground circuit to measure the 
phase-to-ground insulation for each phase, and the UST circuit to measure 
end turn insulation between subsequent phases (say, B-C, C-A).

NOTE When “water” is selected under the “cooling” field on the nameplate 
screen, the Power Factor is not calculated on the overall test screen until 
the DC winding insulation resistance values are entered under the “Ins. 
Res.” tab. DTA then calculates the losses associated with the cooling water 
system, subtracts these losses from the “measured losses” on the Overall 
screen, and inserts the “AC losses” and the resultant Power Factor, which 
is associated with the stator winding only, on the Overall screen.

Spare Bushing The bushing should preferably be placed in the vertical position in a metal 
stand. Do not test a spare bushing in its wooden crate. The flange should be 
grounded for all tests. All tests are single tests. For each test, select the test 
circuit to be used:

1. UST for C1 (energize the center conductor with the low voltage lead on 
the test tap)

2. GST-Guard for C2 (energize the tap, guard the center conductor)

3. GST-Ground for the Overall test (energize the center conductor, no low 
voltage lead used).

4. GST-Ground for the C1+C2 test, with the high voltage lead on the test tap 
and the low voltage lead on the center conductor.

5. UST or GST-Ground for the hot collar test (use one circuit consistently)

6. UST for Inverted UST test, with the high voltage lead on the test tap and 
the low voltage lead on the center conductor.
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NOTE For the C2, C1+C2, and Inverted UST test, be sure not to energize the test 
tap at a voltage higher than 0.5 kV for bushings in the 69 kV class or 
lower, and not higher than 2 kV for bushing rated 92 kV and above.

Surge Arrester 1. Make sure any surge counters at the base of the arrester stack are 
short-circuited or bypassed. For arrester stacks of one or two units, the top 
of the stack must be disconnected from the line and from ground. For 
stacks of three or more arresters, the line terminal at the top of the stack 
may remain connected, but it must be grounded for safety.

2. Enter nameplate and location information as described on page 2-11

3. Test kV will be automatically entered into the form once the catalog 
number has been selected.

4. Test procedure depends on the number of units in a stack:

• For a single arrester unit, energize the top and run a single test using 
the GST-Ground circuit. The top of the arrester stack is ungrounded.

• For a two unit stack, place the low voltage lead at the top of the stack 
and the high voltage lead between the two arrester units. Run a 
multiple test, testing the top arrester unit with a UST test and the 
bottom arrester unit with a GST-Guard test. The top of the arrester 
stack is ungrounded.

• For a three unit stack, place the low voltage lead at the top of the 
second arrester unit (between the top of the second unit and the bottom 
of the third, or top, unit) and place the high voltage lead at the top of 
the first arrester unit (between the top of the bottom unit and the 
bottom of the second unit). Run a multiple test, testing the middle unit 
with a UST circuit and the bottom unit with a GST-Guard circuit.

• Then, swap the high voltage and low voltage leads, and test the top 
unit with a single GST-Guard test (the top unit of a stack with three or 
more units is grounded during this whole procedure).

Three Winding 
Transformer

1. Each of the three windings is short-circuited separately by connecting all 
H bushings, all X bushings, and all Y bushings separately. All grounded 
bushings are disconnected from ground. We will call the X winding the 
Low, and the Y winding the Tertiary.

2. Place the Red low voltage lead on X (Low) and Blue on Y (Tert). Start by 
energizing the high voltage (H) winding. You will run a multiple test on 
rows 1-3 (GST-Guard B, GST-Guard RB, UST R would be the circuits 
selected by DTA in this case).

3. DTA will ask you which winding has the Red and which the Blue Low 
Voltage Lead attached. Select according to your connections.
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4. The Setup window then appears, and the user should select Multiple Tests 
(the Defaults, if available).

5. Click the Setup button to review the test voltages and circuits you are 
about to use. When satisfied, click the Run button to run the multiple tests 
for rows 1-3.

6. Rotate the leads so as to energize the low voltage (X) winding, with Red 
on Y and Blue on H, running a multiple test on rows 5-7 (GST-Guard B, 
GST-Guard RB, UST R would be the circuits selected by DTA in this 
case).

7. DTA will ask you which winding has the Red and which the Blue Low 
Voltage Lead attached. Select according to your connections.

8. The Setup window then appears, and the user should select Multiple Tests 
(the Defaults, if available).

9. Click the Setup button to review the test voltages and circuits you are 
about to use. When satisfied, click the Run button to run the multiple tests 
for rows 5-7.

10. Rotate the leads so as to energize the tertiary (Y) winding, with Red on H 
and Blue on X, and energize the Y winding, running a multiple test on 
rows 9-11 (GST-Guard B, GST-Guard RB, UST R would be the circuits 
selected by DTA in this case).

11. DTA will ask you which winding has the Red and which the Blue Low 
Voltage Lead attached. Select according to your connections.

12. The Setup window then appears, and the user should select Multiple Tests 
(the Defaults, if available).

13. Click the Setup button to review the test voltages and circuits you are 
about to use. When satisfied, click the Run button to run the multiple tests 
for rows 9-11.

14. For row 13, tie all bushings together, and energize H+L+T. No Low 
Voltage Leads are needed for this test.
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Figure 2.21  Test Connections Columns At Left

Two Winding 
Transformer

1. Both the high voltage and low voltage windings are each short-circuited 
separately by tying together all H bushings, and, separately, all the X 
bushings. All grounded bushings are disconnected from ground.

2. First, the high voltage winding is energized, with the low voltage lead on 
the low voltage winding. A multiple test is run on rows 1-3.

3. Next, the low voltage winding is energized, with the low voltage lead on 
the high voltage winding. Another multiple test is run on rows 5-7.

4. On the two winding transformer Overall test form, the last two rows are 
Ch’ and Cl’. After the test for Ch on line 2 is run, DTA checks for bushing 
C1 current, watts, and capacitance and if they exist, it subtracts them from 
the current, watts, and capacitance on line 2. The remainder is entered on 
line 9, and represents the condition of the high voltage winding without 
the effect of the attached bushings. The same is done for line 6 and Cl. The 
current, watts, and capacitance of the low voltage bushings are subtracted, 
and the results are entered on line 10. The program identifies high voltage 
bushings only as those with H designation, and low voltage bushings only 
as those with L or X designations.

5. If the bushing tests have not been run at the time the overall tests are 
finished, Ch’ will be the same as Ch, and Cl’ will be the same as Cl. The 
tester can run the bushing C1 tests, return to the overall test screen, and 
press F9, Recalculate, to obtain the correct values for Ch’ and Cl’.

Vacuum Breaker Multiple tests may be used on tests 1, 3, and 5 to save time.

NOTE: Since using a multiple test requires that a guard circuit be used instead of 
a ground circuit, the test results will be different from those for a single 
test for tests 1, 3, and 5! It may be more difficult to make comparisons for 
purposes of analysis of results.

If you prefer not to use multiple tests, test as follows:
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1. With the breaker open, energize bushing 1, float bushing 2 for row 1.

2. Energize bushing 2, float bushing 1 for row 2.

3. Energize bushing 3 and float bushing 4 for row 3.

4. Energize bushing 4 and float bushing 3 for row 4.

5. Energize bushing 5 and float bushing 6 for row 5.

6. Energize bushing 6 and float bushing 5 for row 6.

7. Energize bushing 1 and place the LV lead on bushing 2 for row 7.

8. Energize bushing 3 and place the LV lead on bushing 4 for row 8.

9. Energize bushing 5 and place the LV lead on bushing 6 for row 9.

To use the multiple tests option:

1. With the breaker open, energize bushing 1, with the low voltage lead on 
the opposite bushing 2, using a multiple test for rows 1 and 7.

2. Swap the high voltage and the low voltage leads, and energize bushing 2, 
running a single test for row 2.

3. Energize bushing 3 with the low voltage lead on bushing 4, and run a 
multiple test for rows 3 and 8.

4. Swap the high voltage and low voltage leads, and energize bushing 4, 
running a single test for row 4.

5. Energize bushing 5 with the low voltage lead on bushing 6, and run a 
multiple test for rows 5 and 9.

6. Swap the high voltage and low voltage leads and energize bushing 6, 
running a test for row 6.

Voltage Regulator For a single phase regulator, tie all bushings together, and energize them, 
running a single test.

Additional Test Screens
Most apparatus have additional test screens, beyond their Overall test screen, 
in order to include additional tests, such as Bushing, Oil, Ratio, Capacitor, and 
Leakage Reactance tests with the Overall test. Following is a description of 
these additional test screens, many of which are found on more than one of the 
apparatus listed above.To start a test, simply position the cursor on the line of 
the test you wish to start with and enter the test kV. Click the Run Test button 

or the  icon to start a test on that row
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Bushing Dimensions 
Screen

This is an informational screen found with both apparatus forms containing 
bushing test screens (on bushing nameplate screen, click Add A Bushing, then 
the Bushing Dimensions button) and the spare bushing form (click the 
Dimensions tab) where bushing electrical and mechanical information can be 
saved to aid in the search for an appropriate spare bushing.

Bushing Test Screen When bushing nameplate data has been entered on the bushing nameplate 
screen, bushings that have taps are identified and an X is placed in the Tap 
column there. On the bushing test screen, only bushings which have been 
entered in the nameplate screen will show on the bushing designation (BH) 
choice lists. Thus, their information must be entered on the nameplate screen 
in order to run tests on them.

This screen has two tabs, one each for C1 and C2 tests. When testing bushings 
mounted in transformers, remember that the winding to which the bushings 
under test are attached must be short-circuited. Once all C1 tests are 
completed, DTAF will subtract the current, watts, and capacitance values from 
those of the winding to which they are attached and the results placed on the 
transformer overall test screen, so as to be able to review the effects of the 
bushings on the transformer overall test.

1. In the BH column, select the bushing you are about to test. You must have 
entered information about this bushing in the Nameplate screen to obtain it 
in this choice list.

2. For the C1 test, energize the center conductor, while connecting the Low 
Voltage Lead to the bushing test tap. Be sure the High Voltage Hook is not 
allowed to drape down the side of the bushing; keep it pulled slightly away 
from the bushing.

3. For the C2 test, energize the tap, using the small red jumper cable supplied 
to connect the High Voltage Hook to the bushing test tap. Connect the Low 
Voltage Lead to the center conductor.

NOTE The C2 test is performed at 2 kV for bushings rated above 92kV, and at 
500 volts (0.5 kV) for bushings in the 69 kV class or lower.

4. To start a test, simply position the cursor on the line of the test you wish to 

start with and enter the test kV. Click the Run Test button or the  
icon to start a test on that row. No multiple tests are possible on this screen.

NOTE When performing C1 or C2 tests on bushings installed in transformers, 
make sure the windings of the transformer are short-circuited during the 
bushing tests.
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Cables And 
Terminations C1 and 
C2 Screen

This screen is meant for terminations with test taps, and the test procedure is 
the same as for a bushing C1 and C2 test.

Capacitor Test 
Screen

This is found in the SF6 dead tank breaker forms, and is used if there are 
capacitors which can be made accessible for testing. To use this screen:

1. Select the capacitor to test from the Cap ID column. For a capacitor to 
appear here, you must have filled in the nameplate data under the 
Nameplate/Capacitor tabs.

2. Enter the phase on which the breaker is located. Tab to the Test kV.

3. Enter the test kV and click the  icon to start the test.

Diagnostic Test 
Screen

This screen is meant to provide a space for making other investigatory tests, 
such as tip-up tests, tests using guard collars, and tests before and after 
cleaning surfaces or changing connections. To use this form:

1. Enter a description of the investigatory test in the Specimen column. Tab to 
the Test kV column.

2. Enter the test kV. Click the  icon to start the test.

No expert system is available for this screen.

Doble Ratio Test 
Screen

There are several ratio screens available, depending on the number of 
windings: Primary-Secondary, Secondary-Tertiary, and Primary-Tertiary. Use 
one screen for the ratio between each pair of windings. This screen is for use 
when measuring transformer ratios with the Doble ratio capacitor. If using a 
TTR, select the Turns Ratio Test screens. To run a test with the Doble 
capacitor:

Figure 2.22  Doble Ratio Screen
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1. Enter the connection setup in the connection fields, being guided by the 
vector diagram on the transformer nameplate. See the Test Procedures 
manual for details. There are three pairs of two H (top row) and X (bottom 
row) fields. The bushing designations available in the choice lists on this 
screen depend on the user-configured designations created on the bushing 
nameplate screen. Each pair describes the connections used for the 
corresponding Ratio column below. For an H-to-X ratio test, the first H 
field represents the bushing terminal energized, and the second represents 
the bushing terminal grounded. The first X field represents the bushing 
terminal on which the Doble capacitor is hung, and the second X field 
represents the bushing terminal grounded.

2. Terminal selection is based on the nameplate vector diagram. For the 
diagram shown below, the connections for B phase would be 
H2-H1/X2-X0. To determine the terminals on the Low Voltage side 
corresponding to those on the high voltage side, simply find the parallel 
lines. To determine the correct polarity relationship, read each parallel line 
in the same direction (i.e. left to right, or right to left).

Figure 2.23  Nameplate Vector Diagram

3. Enter the tap position information for both the high and low voltage 
windings, as well as the nameplate voltage for each tap. Once the 
nameplate voltages are entered for each winding, DTAF will 
automatically calculate the expected ratio in the Cal Ratio column, as well 
as the upper and lower limits (+/- 1/2%) in the Min and Max limit 
columns.

4. In the True Capacitance field, measure the capacitor at 10 kV with a UST 
circuit (energize the hook end of the capacitor).
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5. To start a test, click the  icon. From the popup window, select the 
column (1-3) corresponding to the phase you are testing, based on the 
Connection boxes above. Ratio tests are single phase. The data for a three 
phase transformer is entered in separate columns across a row, and not 
down a column.

Exciting Current Test 
Screen

Figure 2.24  Exciting Current Test Screen

This screen is found only with transformers. A layout function is available, 
which allows the user to select between the standard and alternate method of 
testing (the default is standard), choose a core type (the default is 
three-legged), and choose between two types of winding connections. It is 
usually not necessary to change the defaults. To run an exciting current test:

1. Select the Exciting Current tab and enter the connection setup. There are 
three sets of two connection fields, and each pair refers to the mA, watts, 
and L/C columns below it. The first field of each pair is the bushing 
terminal energized, and the second field is the bushing measured (if this is 
a delta winding, the third bushing is grounded). The bushing designations 
available in the choice lists on this screen depend on the user-configured 
designations created on the bushing nameplate screen. For the first test on 
any transformer, the order of the three pairs is not important. For example, 
in the case of a delta winding, they could read H1-H2, H2-H3, H3-H1, or 
they could read H3-H1, H1-H2, H2-H3. In the first case, you would be 
energizing the three phases in the order B, C, A; in the second case, A, B, 
C. For a wye connected winding, an example of the connection setup 
would be Y1-Y0, Y2-Y0, Y3-Y0.

2. The first terminal in any of the pairs such as those mentioned above is the 
one energized, and the second one is the one measured, with one of the 
Low Voltage Leads. In the case of a Delta configured winding, the third 
terminal is grounded with the other Low Voltage Lead.
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NOTE In order to compare data to previous tests, the tester must enter the test 
data for each phase in the column corresponding to that phase used in the 
previous test for proper comparisons by the DTAF expert system! The 
same goes for the tap position and the test voltage.

3. Enter the tap positions on which tests will be run (DETC is the 
de-energized tap changer; LTC is the on-line tap changer). If there is no 
LTC, ignore this column. Tab to the test kV column.

4. Enter the test kV. The exciting current test draws a relatively high amount 
of current. If the test is stopped and an overcurrent message is displayed, 

the test may have to be repeated at a lower voltage. Click the  icon 
to start a test. A window will pop up.

NOTE Some users prefer to test odd and even tap positions of the on-load tap 
changer at different voltages. In this version of DTA, if you wish to 
perform a multiple tests, you must use the same test voltage for all tap 
positions.

5. Click Setup to choose which phase (column 1-3) you will test, as well as 
the test voltage, if not already entered. The column you start in must 
correspond to the two connection setup fields that reflect the phase you are 
testing. If you are energizing H1 and measuring H2, don’t start the test in 
the column corresponding to the connection fields H2-H3.

6. For a single phase transformer, the winding is tested twice, energizing first 
one end of the winding and then the other (H1-H2, H2-H1), while 
recording each test in its own column.

7. For a three phase transformer, record each phase in the column 
corresponding to it in the connection setup fields.

8. The L/C column tells the user whether the current is Inductive or 
Capacitive. This may be important in explaining the obtained pattern.

9. You can run multiple exciting current tests on a winding with an on-load 
tap changer. For example, you can start on phase A at position 16R and run 
a multiple test to position 16L. Next, reposition the test leads to phase B 
and run another multiple test from 16L to 16R; then to phase C and run 
16R to 16L.

NOTE Exciting Currents for a given tap position are recorded across the screen 
in a single row, not down the screen in a single column.
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Hot Collar Test 
Screen

Before starting a hot collar test, you must:

1. Identify the bushing (H1, X1, etc.) using the down arrow in the BH 
column. You must have filled out bushing nameplate data.

2. Select the test mode from the choice list by clicking the down arrow in the 
test mode field (select Ground or UST). Tab over to the skirt # column.

3. Enter the skirt under which you are placing the rubber collar. Only 
compare tests made under the same skirt. Tab to the test kv column.

4. Enter the test kv. Click the  icon to start the test.

Insulating Fluid Test 
Screen

1. Enter a description of the oil sample in the Sample field. Tab to the Deg. C 
column.

2. Measure the oil temperature of the sample and enter it. Tab to the Test kV 
field.

3. If using the Doble insulating fluids test cup, enter 10 kV. Click the  
icon.

4. You may also enter H2O PPM and temperature here, and DTA will 
calculate % relative saturation.

5. Click the Oil Quality button to enter test results for Color, Specific 
Gravity, Dielectric Strength (both 1816 and 877), % power factor (at 25 
and 100 Deg. C), water content, neutralization number, and interfacial 
tension. Some fields are different for transformers and OCB’s.

6. Click the DGA button to enter Dissolved Gas Analysis test results.

Investigative Tests 
Screen

This screen is found on Air Magnetic breaker tests only. It allows repetition of 
the main overall tests with the arc chutes in a different position (out, if the 
overall test was performed with them in, for example. Follow the instructions 
in the Air Magnetic breaker section.
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Leakage Reactance 
Test Screen

A transformer with two sets of winding terminals will have a single Leakage 
Reactance test screen; this includes two winding transformers and 
autotransformers without tertiary. A transformer with three sets of winding 
terminals will have three Leakage Reactance test screens (Primary-Secondary 
(H-X), Secondary-Tertiary (X-Y), and Primary-Tertiary (H-Y)), one for each 
pair of windings. This includes three winding transformers and 
autotransformers with tertiaries. Whether a three phase equivalent test or a 
per-phase test is run, it will consist of one test per phase per pair of windings 
(3 tests for a 3 phase two winding transformer). To run a test:

Figure 2.25  Leakage Reactance Nameplate Screen

1. Enter the following nameplate data on the Leakage Reactance nameplate 
screen: tap positions (mandatory, even if you must enter NONE or N/A), 
KVA, kV, and % Impedance. Assure that the tap positions (both the 
de-energized tap position and the on-load tap position) for the test are the 
same as those specified for the nameplate impedance data. If they exist on 
the transformer, both DETC and LTC tap positions are required entries. 
Enter the Winding Configuration for each pair of windings (requires prior 
entry on the Main nameplate screen of # of Phases and Configuration).

2. On the Leakage Reactance test screen, select the Test Configuration. If 
this is the first test, perform first a three phase equivalent test, and then a 
per-phase test. If you already have per-phase test data from a previous test, 
perform only a per-phase test. You may select per-phase Delta or 
per-phase Wye, depending on the configuration of the winding being 
energized.
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Figure 2.26  Leakage Reactance 3 Phase Equivalent Test

Figure 2.27  Leakage Reactance Per-Phase Test

3. Enter both the % Impedance and % Reactance benchmarks from the first 
test by selecting the tab of the same name along the bottom of the data 
entry area. If there is no benchmark data, enter the nameplate % 
Impedance in all benchmark fields. Benchmark data is needed for each test 
to be run, whether three phase equivalent or per-phase.

4. Select the tap positions for which the test is to be run (requires prior entry 
of nameplate data for at least one tap on Main nameplate screen).

5. Identify the phase and the bushings involved in the Phase column.

6. If you are doing both a three phase equivalent and a per-phase test, you 
will have to perform steps 2-5 for each of the two tests; selecting the 
different Test Configurations will toggle back and forth between the two 
tests.
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7. Start the test by clicking the  icon. You will be performing three 
tests per line: for example, 1A, 1B, and 1C. A warning screen will appear 
if you have left out any necessary information.

8. You cannot view both the 3 phase equivalent test results and the per-phase 
test results together. You must select the tests you wish to view from the 
Test Configuration choice list.

Miscellaneous Test 
Screen

Enter test data taken from other test instruments manually in these fields. It 
will then be available in your DTA Office System database for review. No 
expert system is available for this screen. Tests depend on the apparatus:

Transformers DC insulation resistance, core ground test, and gas space test.

Insulating 
Fluids-Oil Quality

Color, specific gravity, ASTM D1816 and D877, %PF @ 25 and 100 Deg. C, 
water content, neutralization number, and IFT (for transformers; some 
differences for OCB’s).

Insulating 
Fluids-DGA

Top oil temperature, H2, O2, N2, CH4, CO, C2H6, CO2, C2H4, C2H2, total 
gas, combustible gas, and estimated TSG % of gas space.

SF6 Dead Tank 
Breakers

Insulation Resistance, contact resistance, and SF6 gas tests: pressure, 
moisture, and dew point.

Live Tank 
Breakers

Contact resistance and SF6 gas tests: pressure, moisture, and dew point.

Air Magnetic And 
Air Blast Breakers

Insulation resistance, contact resistance, Hi-Pot test.

Vacuum Breakers Insulation resistance, contact resistance, Hi-Pot test, and ductor test.

Rotating Machinery 
Test Screens

There are a large number of test screens for rotating machinery, which allow 
manual entry of test data recorded with a variety of different test instruments. 
Tests performed with the M4000 are found on the Overall test screen. The 
M4000 can also be used to test individual stator coils (Stator Coil Test screen), 
and the rotor (Rotor Test screen).

Turns Ratio Test 
Screen

This is meant to be used manually with a TTR test set. Follow the general 
instructions for the Doble Ratio Test, but all test data must be entered 
manually, and there is no use of the Doble capacitor.
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3. Running A Test

Automatic Tests
1. Turn on the M4200c Controller or your laptop, and make sure the M4000 

program is running. Then click the DTAF  icon.

Getting Started
• If you are about to test an apparatus for which there are no previous 

tests in your DTAF program, create a new apparatus file. Click the 

New  icon.
• If you are adding a new test to an apparatus with existing tests in your 

DTAF program, you must find that apparatus file and open it, as 
follows:

1. If the path next to the Source button is correct, the list of existing 
apparatus tests will appear in the right-hand pane. Otherwise, use that 
button to select another path if your data is kept elsewhere.

2. Find the apparatus you wish to test today. If the list is very long, it can be 
sorted by Location, Apparatus Type, Serial Number, Special ID, CCT 
Desig., Test Date, Flags, or even file name by clicking on the 
corresponding column header.

3. After finding the apparatus, double-click it to open it.

4. To create a new test date, click the next test date  icon, or select 
Open/Next from the File menu.

Entering Nameplate Information
5. Fill in nameplate information:
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• If this is the first test on an apparatus, fill in the required fields on all 
the nameplate screens. Note that there is only one Nameplate tab along 
the top of the work area, but there may be several sub-Nameplate 
screen tabs along the bottom. Fill in at least the required fields, as 
denoted by an asterisk (*). In the case of Oil Circuit Breakers, bushing 
nameplate information is also needed for full analysis by the expert 
system.

• You can create choice lists for the fields Location, Division, and 
Company by selecting Edit Choice Lists from the Tools menu.

• You can restrict the entry in the Location field to your choice list by 
selecting Tools/Configure, and setting Restrict Location Entries to 
Choice List to Yes.

• If this apparatus has been tested in DTAF before, the nameplate data 
will be carried forward to the new test.

• In either case, review the existing information to make sure it is 
correct.
• You may enter additional data in the Administration window by 

clicking the Administration button, or selecting Admin 
from the View menu.

• Enter any notes containing information pertinent to today’s test 
(such as results of a visual inspection, or weather notes) by click-

ing the notes  icon, or selecting Note from the View menu 
(additional notes may be added for each row of test data on the 
Overall test screens).

• Enter weather information by clicking the Test Conditions  
icon, or by selecting Test Conditions from the View menu. If “prb” 
appears in the Air Temperature field, then the temperature and 
humidity probe is connected and configured. If not, it is not. If 
connected and configured, the probe will automatically enter air 
temperature and humidity, and the user must enter only Apparatus 
Temperature where appropriate. Otherwise, all data must be 
entered by the user. If necessary to configure the probe, this must 
be done in the M4000 program under Tools/Configure/Instrument.
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Select The Test Screen
6. Along the top of the work area, click the tab for your test. The Overall test 

is the main test for any chosen apparatus. Other test tabs refer to additional 
tests that may be run on the same apparatus, such as Bushing tests, 
Leakage Reactance tests, Ratio tests, and so on.

7. Enter the test kV in the row(s) you will include in the first test(s).

8. To run a single test, place the cursor in that row. To run a multiple test, 
place the cursor in the first row of the series of tests. 

9. Select Run Test - M4000 from the Test menu or press F2. You may also 

click the  icon, displaying the Run M4000 Test window. If the test 
process still doesn’t begin upon clicking the icon, or if entry fields for mA, 
Watts, and pF pop up, the icon may be set to Manual. To correct this 
setting:

• Select DTA Field System from the Window menu.

Figure 3.1  Switching Between Screens

• Select Configure from the Tools menu, and change the Data Entry 
Mode from Manual to M4000 and save. Now select your apparatus 
test screen from the Window menu to return to your test.
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Figure 3.2  The Run M4000 Test/Setup Window

10. The Run M4000 Test window appears. If the multiple test mode is 
available, you will be asked to choose between a single or a multiple test. 
Usually a default multiple choice is also offered. If a single test, the line 
selected by the cursor will be used. If a multiple test, the user can accept 
the default selection (recommended), or select the rows to include in the 
test. If you are not sure which line your cursor was on, click the Setup 
button to find out the row and the corresponding test voltage and test 
circuit.

11. Click the Setup button to set test voltages for each of the multiple tests if 
you have not already done so, using the double arrow buttons to page back 
and forth if you are making more than one test. The setup button will also 
display the test circuit that will be used for each row of test data. If you 
wish to use other than the pre-programmed test circuit, change it here at 
this time.

12. If the M4000 temperature/humidity probe is connected and activated (this 
is done in the M4000 software), and the M4000 test set is on, the letters 
“Prb” will appear in the air temperature window, indicating that the air 
temperature and humidity will be entered automatically by the M4000 
during the test. When blank, the “app temp” (Apparatus temperature, or 
top oil temperature, in the case of a transformer) must be filled in. If the 
probe isn’t being used, fill in air temperature and humidity as well. If you 
have already done this from the ID screen, this step will be skipped.

13. In cases where two low voltage leads are used, you will be prompted to 
inform the program where you have placed each of the two leads.
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14. A final warning screen will be presented, displaying the test voltage and 
circuit about to be used. The tester can press the safety switches and run 
the test by clicking Continue, or stop the test procedure with the Abort 
button. If the safety switches are pressed before this screen appears, a 
message may be displayed stating that the safety switches were not 
released between tests. In that case, release the safety switches, restart the 
test (use F2 for a single test, F11 for a multiple test), wait until the warning 
screen returns, press the safety switches, and click the Continue button.

15. The Configure choice on this warning screen allows you to change at the 
last moment the Test Type (line frequency modulation or line sync 
reversal, 50 or 60 Hz), or the display mode (actual values or reference to 
10 kV). If you need to change the test circuit or maximum test voltage at 
this point, abort the test and start over. Change them while in the Setup 
window.

NOTE DTA runs Excitation Current tests using the Line Sync Reversal mode. If 
running this test on a diagnostic screen, which is unprogrammed, select 
the Line Sync Reversal mode from the Configure button on the warning 
screen prior to starting the test. Rotating Machine tests should also be run 
in the Line Sync Reversal mode.

Saving Test Results
16. When the tests are over, Test Done will appear at the bottom left-hand of 

the screen. To enter the results into DTAF, press F5. To discard the test 
data, press F6.

17. Save the test results by clicking the Save  icon.

Using The Expert System
18. Once you have made all the tests you are going to make on a given test 

screen, Recalculate all the data on that screen by selecting Recalculate 
from the Test menu, or by pressing F9. This will cause the expert system 
to review all the data on that screen as a whole, comparing similar tests, 
and making other comparisons involving all the test data on that screen.

19. Check your test results. The expert system assigns a rating (G, B, D, or I) 
to most rows of test data. To read the expert advise associated with a row, 
place the cursor anywhere in that row and select Advise from the View 
menu, or press the F5 key. With the Analysis Results window open, click 
the View Limits button to see the limits that were used for this test, and to 
know if the limits were in percent Power Factor, Current, or Watts.
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NOTE Although capacitance is evaluated, no capacitance limits are shown in the 
Analysis Results; however, DTA uses a 5% change in capacitance as a 
sign of deterioration, and a 10% change as a need to investigate.

20. You can repeat the tests after taking corrective action, if needed, on the 
same rows, and the new test data will overwrite the existing test data. If 
you wish to preserve the existing data for before and after analysis, run the 
“after” tests on the Diagnostic sheet, or on rows labeled Miscellaneous, if 
any, and create a note for those rows describing the event.

21. You can cause DTA’s expert system to ignore a row of data by placing an 
X in the second, or right-hand insulating rating column, and then using the 
recalculate function. This enables you to keep data for reference without 
causing improper analysis.

Manual Tests

The test mode selected when clicking the run test icon  is set by 
selecting Configure from Tools, and choosing Manual for Data Entry Mode 
(this must be done on the main DTA screen). However, to run a manual test 
from the Test menu by selecting Run Test - Manual, this is not necessary. You 
would select the Manual mode for the following reasons:

1. You wish to enter some previous test data not available in DTAF format.

2. You are not using an automatic instrument, the M4000, but are using a 
manual instrument, such as the MEU, MH, or M2H.

To run a manual test:

1. Select the desired test screen.

2. Set the DTA configuration to manual if using the run test icon as shown 
above, or simply select Run Test - Manual from the Test menu.

3. The default data format is that of the ten kV test set. If using an MEU, you 
must select MEU in the Test Set Type field in the Nameplate 

Administration window, accessed by clicking the  icon.

4. On the selected test screen, select the row into which you wish to insert 
test data, and enter the test kV.

5. From the Test menu, select Run Test-Manual (or click the Run Test icon), 
and fill in the mA, Watts, and Capacitance (pF).
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6. Use the final calculated meter readings for each value, and DTA will 
automatically fill in the same number in the reversal fields.

7. DTA may flag data entries that could have been measured using a lower 
multiplier, for more accurate results. It also flags instances where the 
current/capacitance relationship isn’t as expected. Just click OK to 
continue.
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4. Commonly Used Functions

Creating A Test 

If there Are No Previous Tests In DTAF

Click the New icon . From the resulting window, select the desired 
apparatus type. If the desired apparatus is not found, select the Miscellaneous 
test form. If testing a bushing located in an apparatus, select that apparatus. If 
testing a spare bushing, select the spare bushing form. If testing a Single Phase 
Metering Outfit, select the PT form. All transformer forms contain a surge 
arrester form, so if testing an arrester in conjunction with the transformer it is 
protecting, select a transformer form.

You may want to manually enter the earliest test data available for this 
apparatus into DTAF, so DTAF’s expert system will be able to use it for 
comparison when the new test is run. Fill in nameplate data, and begin running 
tests.

If A Previous Test Exists In DTAF
1. Use the Source button to find the path to your apparatus files. Find the test 

in the right-hand pane, and double-click to open it.

2. Click the next test date icon  to create a new test. Most of the 
nameplate data will be carried over from the existing test.

3. If you have set Ask Tested By In New Test to Yes in the Configuration 
window (see ”Tested By Field” on page 4-8), you will be asked to enter 
the tester’s name before proceeding.

4. Fill in missing nameplate data, and begin running a test.
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Entering Test Data 

Manually
Manual test data entry is necessary if a test set other than the M4000 is being 
used, or if previous test data available only in paper form is needed for 
comparison to new test data.

1. Create a new test as described above.

2. Select the test tab corresponding to the test data you are about to enter 
(Overall, Bushing, etc.)

3. Select Run Test-Manual from the Test menu.

4. Enter your meter readings and range selections for current, watts, and 
capacitance, as available. Click OK.

5. To display a form which will accept MEU data, enter MEU in the Test Set 
Type field of the Nameplate Administration window, accessed by clicking 

the  icon.

Automatically
1. Create a new test, as described above.

2. Enter all nameplate data.

3. Click to the screen containing the desired test form.

4. Click the icon or press F2.

Retrieving an apparatus 
1. Once the program is started, the entire list of tested apparatus found in the 

default path will be displayed in the right-hand pane. If your data is in 
another location, use the Source button to find the correct path.

2. Sort the list in the right-hand pane to help find the desired apparatus. If 
you are looking by Location, click the Location column header; if by 
Serial Number, click the Serial Number column header.

3. Select non-contingent items by clicking them while holding down the Ctrl 
key; retrieve contingent items by clicking on the first item, then holding 
down the Shift key and clicking on the last item.
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4. By design, the DTA Field System was not meant to hold all your test data; 
that job belongs to the DTA Office System. Ever so often, all the data in 
DTAF should be added to the DTA Office System and backed up. It may 
then be deleted from the DTA Field System, if desired, in order to keep the 
amount of data in the DTA Field System down to a manageable amount. 
You may select apparatus files and send them to a folder that will be used 
by the DTA Office program to load data into its database with the 
File/Send To/Folder command.

Reviewing Test Data 
All test data should be reviewed by the tester. Each test screen, such as the 
overall test screen or the bushing test screen contains a set of data after the 
testing is completed. During the test, the expert system analyses each line of 
data and rates the results G (good), D (deteriorated), I (investigate), B (bad), or 
Q (not rated, or comment only). However, to get the overall analysis for a 
given test screen, the user should select the Recalculate command from the 
Test menu, or press F9. This will cause DTA to re-analyze all the data on that 
screen as a whole, comparing like tests and tests that are related to each other. 
This may change some D or I ratings to G ratings.

Each row of test data has two rating (Rtg) columns. The left-hand column is 
used by the expert system, and the right-hand column is for use by the tester, in 
case there is disagreement between the tester and the expert system. To see 
what advise the expert system has given for a row of test data, place the cursor 
anywhere in that row and select View/Advice or press F5. A pop-up window 
will appear with the reasons the expert system has rated that row as it has. To 
view the limit file associated with that row, so as to see the limits being used 
by the expert system, click the Limits button.

Should you find test data that you wish to keep for reference, but shouldn’t be 
included in the analysis of the expert system, place an X in the second 
insulation column, and Recalculate the data. The data with the X in the far 
right column will not be considered by the expert system.

Cloning

A Bushing Or Surge Arrester
1. Enter the first instance of the bushing or surge arrester on the appropriate 

nameplate screen.

2. Use the mouse to select that item, and then click the Clone Arrester or 
Clone Bushing button. A window will appear with all the data filled in. 
Change only the data which doesn’t apply to the clone.
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An Apparatus File
On the main screen of DTA, create the first instance of a new apparatus (say, a 
single phase transformer). If you have three more of the same transformer, you 
need not re-enter all the same information four times. Instead, select the 
apparatus you wish to clone, and select Clone from the File menu. A new file 
will be selected with the prefix TMP to its original name.

NOTE Before creating multiple clones, fill in the new Serial Number, Special ID, 
and other nameplate information particular to the cloned item. 
Otherwise, if there is existing cloned dataset of the same record which 
the user has not taken the time to modify serial number/special id, 
there is the possibility of overwriting the cloned record.

Comparing Test Data

To Previous Test Data
Use the History function, found under the Test menu, or press F3.

To Doble Limits
Use the Advice function, found under the View menu. From the pop-up 
window, select the Limits button.

To Similar Tests On The Same Page
Press F9, or select Recalculate from the Test menu.

Printing

The Displayed List Of Apparatus
To print the displayed list of apparatus (contents of the selected directory), 
select File/Print

An Individual Apparatus Test
To print the nameplate and test data for a particular test date and apparatus:

1. Open the apparatus file and select the desired test date.

2. From the File menu, select Print Standard. The nameplate and test data 
will appear in a Windows Explorer window. Print from this window.
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3. If you wish to print the notes, ratings, and advise, select Print Custom. The 
Custom Printing Configuration window will appear as in Figure 4.1. 
Select the items you want to print and click Print.

4. To save the custom print selection, click the Save As button.

5. To recover a saved configuration, click the Open button.

Figure 4.1  Custom Printing Configuration window

Using DTA With Different Doble Test Sets

Test Set Type
When using the M4000, data is entered automatically into the DTAF 
electronic test forms. When using the MH, M2H, or MEU, raw test data, such 
as meter readings and multipliers, must be entered manually, where test results 
are then automatically calculated. Since the data measured by the M2H, MH, 
and MEU are of different forms, the user must tell DTA which test set is being 
used, so DTA will present the correct test data entry form. This is done in the 
Nameplate Administration window, which is selected from View/Admin, or by 

clicking the  icon.
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NOTE A test file must already be open to make this selection.

Automatic Versus Manual
If using the M4000, DTA may only be used in the Automatic (M4000) data 
entry mode. The MH, M2H, and MEU test sets may only be used in the 
Manual data entry mode. This setting may be made in DTA software’s main 
screen by selecting Tools/Configure. For the M4000 test set, choose M4000 
for the data entry mode. For all other test sets and manual entry, choose 
MANUAL. For manual entry of data into DTAF, you may also select Run 
Test-Manual from the Test menu without configuring the software. Configure 

sets what type of test will be run when you click the run test icon .

NOTE The Tools/Configure menu selection for this setting is available only when 
the main screen is active, and not when an individual file is active.

Activating Temperature Correction 
Temperature correction curves created by Doble, various manufacturers, and 
others are contained in the DTA Field System, but selected nameplate 
information is necessary to activate them. If test data was taken at 20 Degrees 
C, the correction factor will be 1.00. It will also be 1.00 if the expert system 
fails to recognize the characteristics of the apparatus needed to make a 
determination of which curves to use. For example, some bushing 
manufacturers have different temperature correction curves depending on 
rated voltage, so that information may be necessary to enable the expert 
system to activate the curves. Information needed to allow the expert system 
to recognize which curves to apply is listed on Table 2.3 on page 2-10.

Transformers
The year of manufacture (or approximate year) is necessary to activate the 
temperature correction factor. If you know the bushings to be the original 
ones, use the year of manufacture from the bushing nameplates.
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Identifying Limit Files
Part of the expert system’s job is to compare current test data to limit files 
found in the DTA Field System. To do that, it must take information in the 
Nameplate ID screen and try to match it to the same information in the limit 
file. Information needed to allow the exert system to find the correct limit file 
is listed on Table 2.4 on page 2-10. Following are some explanations for some 
of the required information.

Oil Circuit Breakers
The bushing type, kV, and manufacturer, and preferably the C1 power factor 
and capacitance, must be entered for DTA to identify the limit file and 
perform a complete analysis.

kV Rating
Some apparatus, such as breakers, CT’s, PT’s, Voltage regulators and 
Reclosers may have separate limit files for different voltage ratings, and the 
ratings are not continuous. That is, there may be a limit file for BZO breakers 
rated up to 125 kV, but the next limit file may begin at 130 kV, so that if the 
breaker ID screen contained a voltage rating of 128 kV, the limit file would 
not be found. Generally the nameplate voltage is the correct one to enter, but 
in some cases where the breaker is applied line-to-ground, that may be the 
voltage required on the ID screen.

Apparatus Type
Apparatus type descriptions may be short or long, depending on how much 
information is appended. It may include such details as the bushing color or 
minor accessories. If you can’t find your exact breaker type in DTA, select the 
nearest match, rather than “Other”, so as to make use of the limit file. For 
example, the limit file for the breaker BZO-121-40-6 is the same as that for 
BZO-121-40-6-C.

Replacing A Bushing Or Surge Arrester
In the even you must replace a bushing or an arrester associated with an 
apparatus (such as a transformer), DTAF will allow you to keep two sets of 
data: that of the older bushing or arrester, and, once you have changed it out, 
that of the replacement. To change out a bushing or arrester:

1. Open the apparatus file and go to the bushing or arrester nameplate screen.

2. Select the item to be replaced, and click the Replace Bushing or Arrester 
button.
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3. A screen with the old bushing or arrester’s data will appear. Replace it 
with data for the new bushing or arrester, and click OK.

4. The row of data for the item to be replaced will lose its designation, and 
will be locked so that it cannot be changed. It will be for viewing only, and 
the new bushing or arrester will appear below.

5. If it is preferred, a row of information can be deleted with the Delete 
button, but only if there is no test data associated with that row.

Updating Bushing Or Surge Arrester Nameplate Data
In the event you wish to correct an item of nameplate data:

1. Open the apparatus file and select the desired nameplate sheet.

2. Select the bushing or surge arrester whose data you wish to modify.

3. Click the Modify button and update the data.

Deleting Bushing Or Surge Arrester Nameplate Data
To delete any bushing or arrester nameplate data:

1. Open the apparatus file and select the desired nameplate sheet.

2. Select the bushing or surge arrester whose data you wish to delete.

3. Click the Delete button. You may not delete a bushing or arrester if there 
is any test data associated with it.

Tested By Field
You can configure DTA to display a pop-up window every time you create a 
new test date in an existing file. The window will have a Tested By field to 
accept the name of the tester. To do this:

1. From the Tools menu, select Configure.

2. From the Configuration window, select Yes for Ask Tested By On New 
Test.
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5. Frequently Asked Questions (FAQ’s)

Technical Support
You can contact your Doble Engineer at 617-393-2900, or by E-mail, or by 
FAX at 617-926~0528. If he or she cannot resolve your problem, other 
technical support staff will be available to help you. Doble also maintains an 
E-mail discussion list for DTA related questions. Contact your Doble engineer 
if you'd like to subscribe to this E-mail discussion list (requires that the user 
have Internet E-mail capability).

General Questions
1. I loaded the software onto my laptop, but I can’t run a test.

• The comport may be incorrectly chosen. Select Configuration from the 
Tools menu, go to the Instrument tab, and select the correct comport 
for your computer (usually Comm1).

• Another program is grabbing your comport. Turn off all other 
programs that might grab your comport upon startup.

2. I loaded the software onto my laptop, but I get strange error messages, 
such as “runtime error.....” or “msado15_dll.bmp”. What’s wrong?

• See #10 under ”Installing The Software” on page 1-2.
3. What is an XML file?

• This is the new file structure replacing the old Compressed Data Set 
(CDS). Each time DTA opens a file with the old file structure, and you 
answer Yes to the dialog box asking you whether to save results or not, 
it will save it in the new XML file structure. If you answer No, it will 
not convert the file. The new files enable the user to name them in a 
way so as to be easily identified when viewed with Windows Explorer.

4. How do I temporarily unapprove a dataset?

• This function is no longer available. All datasets are now “unlocked” 
and accessible. However, if the Checked By field in the Nameplate 
Administration window is filled in, the A flag will be set, indicating 
the test data has been checked and approved.

5. How do l back up my DTA data files (XML)?
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• XML files should be backed up periodically to avoid loss of test data. 
They should be backed up using the DTA Office System. The DTA 
Office System is a relational database program that is be used to create 
a database of all XML’s. This database can be easily backed up, and is 
the central repository from which all CDS should be managed.

6. The apparatus that l 'm testing is not listed in the DTA choice lists. What 
should l do?

• If you are using the DTA system for evaluating the condition of 
apparatus only, then it is not necessary to enter the complete variation 
of the type in the type field. DTA evaluates the condition of the 
apparatus based on generic types only. Additional type information is 
superfluous in the eyes of DTA. For example, the GE breaker types 
FK-115, FK-115-10000, FK-1 15-10000-l, and FK-115-10000-2 are 
all the same in the eyes of DTA, so the user can simply enter FK-115 
as the breaker type.

• If however you are using DTA as an inventory control system, then 
you may wish to enter the entire type designation. If the entire type 
designation is not in the choice list, then select other as the type and 
enter the necessary information into the notepad. Notify your Doble 
Engineer that you have additional information that needs to be added 
to the DTA limit files. When the new limit files have been created, you 
will be sent another diskette with updated limit files.

7. I used to send Doble paper copies of test data for review and storage. How 
do I send Doble copies of electronic test data?

• Diskettes should be sent via postal mail to the attention of your Doble 
engineer. You can also compress and attach data to an E-mail message 
and send it to Doble. From the main screen, select the datasets you 
wish to send. Then, from the File menu, select Send To/Mail 
Recipient. Contact your Doble engineer for instructions about how to 
do this.

8. Does Doble have a web site from which I can download files?

• Yes; our World Wide Web site is http://www.doble.com.
9. I have some test data that causes the DTA expert system to give a bad 

rating. I want to keep this data, but I want the expert system to ignore it. 
Can I do that?

• Yes, simply place an X in the second insulation rating column of the 
row(s) of data you wish DTA to ignore. Recalculate that screen, and 
DTA will ignore the rows marked with X. The existing rating related 
to the marked row(s) will be removed.

10. I need to update the Company, Division, or Location field.
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• Do this by selecting the apparatus you wish to update, and then pick 
File/Update. Type in the new entry and click OK.

11. Each of our testers makes their entries into fields like Location and 
Division a little differently, and we would like to make these entries 
uniform. Furthermore, we would like to create a choice list for Location 
and restrict the user to that list.

• To create choice lists for the above-mentioned fields, use the Edit 
Choice Lists command from the Tools menu. To restrict entry to the 
Location field to the choice list, go to Tools/Configure, and set Restrict 
Location Entries to Choice Lists to Yes.

12. I have a line of test data that I want to remove. How can I do this?

• You must be on a test screen. Position the cursor on the line you wish 
to remove. Choose Clear Line from the Test menu.

Updating Software
1. How can I be sure I have the latest version of DTA?

• Go to the website www.Doble.com, and click Software Downloads. 
Then click DTA Field System. There you can compare the version 
number with the version you are using, as well as obtain the latest limit 
files.

NOTE When you update DTA software, it may be necessary to update the M4000 
software as well.
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Glossary

# of Modules

Found in the live tank breaker test query. A module is a set of two interrupting 
chambers sitting atop an insulated support column.

Cap. Arrangement

Found on the Coupling Capacitor test screen, it is the selected form used to 
test the Coupling Capacitor, depending on the construction (accessible POT 
terminal or not, number of porcelain sections). This field is found in DTA 
Field on the CCPD ID screen.

Capacitor ID

Found on the live tank breaker test screen, it is a list of the sections of tested 
insulation (contacts designated C1…Cx, and support columns designated 
S1…Sx).

CDS

See Compressed Dataset.

Circuit (CCT) Designation

Refers to the circuit on which the apparatus is located, an additional means of 
apparatus identification, if desired.

Compressed Dataset

This is a file containing one or more test dates for an apparatus. Each 
compressed dataset is unique, and contains test results for only one particular 
apparatus. The format of this file is such that it can be read by the Doble DTA 
Field System program. Now being replaced by XML format. DTA can read 
both formats.

Dataset

See Compressed Dataset.

Parent

Refers to the apparatus whose component (such as a bushing or arrester) is 
being tested.

XML File

This is the new DTA file format. Older CDS files will be converted when 
modified or when new tests are added.
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Symbols
# 1-6

A
A flag 2-9
Activate temperature correction 2-9
Administration 2-6, 2-21
Advice 2-6, 4-4
app temp 3-4
Apparatus limit files 2-10
Approved Datset 1-6
Approved Test 2-9
Arrester

Cloning 4-3
Modify 4-8
Nameplate 2-11
Replacing 4-7
Testing 2-31

Arrester Nameplate 2-11
Ask Tested By On New Test 1-9
Automatic Tests 3-1

B
Bushing

Cloning 4-3
Dimensions 2-14
Modify 4-8
Namplate 2-12
Replacing 4-7
Testing 2-35

C
Capacitance Limits 3-6
Capacitor Nameplate (CCPD’s) 2-14
Capacitor Nameplate (Live Tank Breakers) 2-15
CCT Desig 1-6
Ch’ and Cl’ of Two Winding Transformers 2-33
Child apparatus 1-1
Choice List 2-8, 5-3
Clear Line 2-7, 5-3
Cloning

Apparatus 4-3
Arrester 4-3

Bushing 4-3
Company Name 1-9
Configuration 1-9
Creating A Test 4-1

D
Data Entry 2-8
Data Entry Mode 1-9
Delete Data 2-7
Delete Rating From A line 1-6
DGA 2-43
DGA Test Data 2-40
Directories 1-7
Dissolved Gas Analysis test results 2-40
Division.txt 1-3

E
Edit Choice List 1-9
Error Message 1-3
Excitation Current Test KV 2-39
Expert System 1-2
Expert System Ratings 4-3
Expert System, Cause To Ignore A Line 1-6

F
File Names 1-11
Filename 1-9
Find test data 1-5
Flags 1-6
Frequency 1-9

G
Go To

First Test Date 2-5
Last Test Date 2-5

H
History 2-7, 4-4

I
Ignore a row of data 3-6
Installation Error 1-3
Installing The Software 1-2
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L
Layout 2-6, 2-20

 2-17
Leakage Reactance Nameplate 2-15
Limit Files 2-10
Location.txt 1-3

M
Main Nameplate 2-16
Main Screen 1-5
Manual test data entry 4-2
Manual Tests 3-6
Metering Outfits 2-27
MEU Data Entry 2-9
MSADO 1-3
Multiple Test 3-3

N
Nameplate

Arrester 2-11
Bushing 2-12
Capacitor (Breakers) 2-15
Capacitors (CCPD) 2-14
Leakage Reactance 2-15
Main 2-16

Nameplate Administration 2-6, 2-8
Note 2-6, 2-21

O
Oil Quality 2-43
Oil Quality Test Data 2-40
Opening An Apparatus File 2-3
Overall Test Screen 2-21

P
Parent apparatus 1-1
Prb 3-4
Printing 4-4
Purge Deleted Files 1-9

R
Ratings 4-3
Recalculate 2-6

Recover Deleted Files 1-10
Replacing A Bushing Or Surge Arrester 4-7
Restrict Location Entries 1-9
Retest Date 1-6, 2-9
Retrieving an apparatus 4-2
Reviewing Test Data 4-3
Running A Test 3-1

S
Safety Switches 3-5
Save 3-5
Setup Button 3-4
Single Test 3-3
Software Installation 1-2
Sorting tests 1-5

T
T flag 2-9
Technical Support 5-1
Temperature Probe 1-9
Temperature/humidity Probe 3-4
Test

Air Magnetic Breaker 2-23
Autotransformer With Tertiary 2-22
Autotransformer Without Tertiary 2-22
Bushings 2-35
Cables and Terminations 2-23
CCPD 2-23
Current Transformer 2-24
Dead Tank SF6 Breaker 2-25
Diagnostic 2-36
Doble Ratio 2-36
Excitation Current 2-38
Hot Collar 2-40
Insulating Fluid 2-40
Leakage Reactance 2-41
Live Tank Breaker 2-26
Medium Voltage Air Blast Breaker 2-23
Miscelaneous 2-27
Multiple 3-3
Oil Circuit Breaker 2-27
Potential Transformer 2-27
Reactor 2-27
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Recloser 2-29
Rotating Machinery 2-29
Single 3-3
Spare Bushing 2-30
Surge Arrester 2-31
Three Winding Transformer 2-31
Turns Ratio 2-43
Two Winding Transformer 2-33
Vacuum Breaker 2-33
Voltage Regulator 2-34

Test Conditions 2-6
Test Done 3-5
Test KV, Excitation current 2-39
Test Set Type 2-9
Tested By 1-9
Trend Of Test Data 2-7

U
Update 1-9, 5-2
Updating Bushing Or Surge Arrestser 4-8
Use Temp Probe 1-9

W
What’s New 1-10

X
XML format 1-1
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DTA Field Software Version 5.5 Installation from the Doble Web Site 
1. Introduction 
• In order to use this software application, the PC’s operating system must be Windows 98 or 
newer and Microsoft Internet Explorer V5.0 or more recent must be installed. 

• To take advantage of some of the enhancements, Version 3.4 of the M4000 software should be 
installed on the PC used to operate the M4100. 

• The application has been tested on the following operating systems; Windows' 98, NT 4.0, 
2000 and XP. 

• If installing on an M4200C controller, confirm that the default printer driver is M4200 
Thermal.  To do this, open the Start menu and select Control Panel. In the window that appears 
select Printers and Other Hardware. In the Printers and Other Hardware window, open View 
installed printers and fax printers. In the list of printer drivers that appear, the M4200 Thermal 
printer driver should have a black circle with a checkmark in it. If it does not, highlight the 
M4200 Thermal printer icon, open File on the menu and select Set as Default Printer. If the 
M4200 Thermal printer is not listed please contact your Doble principal engineer or local 
representative. 

• All V5 DTA Field applications use an XML format for the limit files. Version 5.2 and later use 
a different set of arrester files for prior versions. In 5.1 and prior versions there were four limit 
files (SA, SAA-BB, SAGE and SAW) in version 5.2 and later there will be six files (SA_1, 
SAA-BB, SACOB, SAGE, SAOB and SAW). The ABB, GE and W arrester limit files are still 
the same, however, the SA limit file has been divided into SA_1, SACOB and SAOB. 
Individuals who manage their own limit files need to be aware of this change. The conversion of 
the affected limit files is performed by DTA Office V4.4. 

• Version 5.5 will overwrite any limit file with an XML extension. If users prefer to use their 
existing limit files instead of those supplied with this release, they must be imported into the 
Office System V4.4. The DTA Office system will handle the conversion; simply load the files 
into the database and then export them as XML files. The XML limit files must then be copied 
into the DTA Field V5 directory after the application is installed. 

• DTA requires MDAC [Microsoft Data Access Components] to utilize the ActiveX Data 
Objects for data storage and retrieval. During software installation, the application will verify the 
version of MDAC on the PC. If the file is missing or outdated, the installation will prompt the 
user of this incompatibility. The executable ‘Mdac_typ.exe’ can be downloaded from Microsoft 
at: www.microsoft.com/downloads and searched on the term MDAC. Version 2.6 or newer 
should be installed. 

2. Installing the software: 

• Extract the installation program from the executable file by double clicking on the self-extract 
file DTAFv55, a window will appear requesting the directory in which to place the files. Note 
the default directory is C:\Doble\Temp\DTAF. 

• To run the installation program select the Run… option on the Start menu. In the window that 
appears, type in the directory path where the installation program resides with \setup appended to 
it; for example <C\DOBLE\TEMP\DTAF\Disk1\setup> 

• The Welcome window will appear next. Read the advisory and if appropriate, select <Next>. 
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• The user will be asked to acknowledge the software license agreement. If acceptable, choose 
<Yes>. 

• A field where the default company name can be entered will appear next. This is the name that 
will be displayed in the Company field when a data set is created. Enter the desired information 
and select <Next>. 

• Choose Destination Folder is the next selection that needs to be made. This is the folder in 
which the application will reside. Note Doble has changed the default directory to C:\Program 
Files\Doble\DTAF. This was done to follow standard Windows protocol. Once a directory is 
identified, select <Next>. 

• The default data directory will have to be specified next. This is the directory that will be 
displayed when the program is launched. Specify the directory and select <Next> 

• If installing over an existing program version 5 of the application, a series of pop up messages 
will appear inquiring if certain users configurable files should be overwritten. These files are 
used to generate the Location and Division choice list within the application. 

• The installation will ask to what Program Folder a program icon should be added. To stay 
consist with the current version, select Doble. Note; the icons will distinguish the two 
applications. Choose a Program Folder and select <Next>. 

• A Message will appear asking if a program icon should be added to the Desktop, select either 
<Yes> or <No> 

• The Set Up Complete screen will be the final screen of the installation. Make the appropriate 
choice and select <Finish>. 

3. Reporting Problems 
• Please submit all bug reports to your Doble principal engineer or local Doble representative. 
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